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ВСТУП 
 
Посібник охоплює матеріал для виконання практичних завдань і ла-

бораторних досліджень. Засвоєння основ цифрових пристроїв (ЦП) здійс-
нюється на базі надвеликих інтегрованих мікросхем програмованої струк-
тури (для стислості позначатимемо їх ПЛІС – програмовані логічні ІС) від-
повідно до останніх досягнень мікроелектроніки. Проте одночасно вивча-
ються також типові ЦП традиційної елементної бази, які зручно запрова-
джувати до ПЛІС у вигляді стандартних структурних компонентів. Крім 
того, метою практикуму є набуття студентами навичок сучасної інженер-
ної праці, коли левова частка розробки і налагодження нової радіоелект-
ронної апаратури (РЕА) та діагностики під час експлуатації діючої РЕА 
має припадати на системи автоматизованого проектування (САПР).  

Через складність ПЛІС (в одному кристалі міститься від тисяч до 
мільйонів еквівалентних вентилів типу двовходових логічних елементів) 
застосовуються нові автоматизовані методи синтезу цифрових структур і 
комплексні засоби проектування РЕА на персональних комп’ютерах. Зок-
рема, для ПЛІС фірми Altera (США), які часто розглядаються як стандарти 
нової елементної бази, впроваджено декілька пакетів САПР, версії яких 
постійно оновлюються. Хоч САПР різних фірм мають відмінності, мето-
дика проектування на їх основі є багато в чому спільною. У цьому посіб-
нику користуватимемося САПР Quartus ІІ, яка підтримує університетську 
освіту і пристосована для нових та розроблених раніше ПЛІС фірми Altera 
і деяких інших фірм. На відміну від попередніх САПР (типу CAD – com-
puter aided design) така система є повноцикловою (типу EDA – electronic 
design automation). Це означає, що вона являє собою закінчене проектне 
середовище для реалізації виробу типу «система на програмованому 
кристалі» (SOPC – system-on-a-programmable-chip), тобто забезпечує всі 
етапи проектування – від введення проекту до моделювання і фізичного 
програмування ПЛІС та тестування результатів. 

У САПР проектом прийнято називати комплект файлів, створених 
користувачем і програмним забезпеченням для досягнення поставленої ме-
ти. Етапи проектування за допомогою САПР можна узагальнити як у 
спрощеному вигляді подано на рис. В1. 

Введення проекту здійснюється інструментальними засобами у 
традиційній для інженера графічній формі (принципова електрична схе-
ма) або в текстовій формі (програма апаратною мовою високого рівня) з 
використанням бібліотеки бази даних – стандартних компонентів САПР 
або створених користувачем і згорнутих до символу блоків. Для побудо-
ви РЕА найдоцільнішою є ієрархічна структура, за якою проект вводить-
ся на рівні блок-схеми в графічному редакторі (проект верхнього рівня), 
а окремі блоки подаються у текстовому або графічному редакторі (прое-
кти нижніх рівнів). Складні проекти, компонентами яких можуть бути 
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мікропроцесори, блоки пам’яті і т. ін., створюються спеціальними засо-
бами САПР на рівні системи. Результатом введення проекту є низка 
сформованих проектних файлів. 

 
Рисунок В.1 – Етапи проектування за допомогою САПР 

 
Другим і найважливішим етапом створення проекту є його компіля-

ція, яка виконується автоматично, в декілька кроків. Після завантаження 
проектних файлів до компілятора здійснюється їх аналіз, щоб сформувати 
рівняння залежності вихідних функцій від вхідних змінних, і синтез, щоб 
реалізувати проект за використання мінімуму з приступного ресурсу ПЛІС 
залежно від її технології (наприклад, на мінімальній кількості логічних еле-
ментів). При цьому виявляються помилки, наприклад, коли відсутнє джере-
ло сигналу на деякому вході, і застереження, наприклад, про невикористову-
ваний деякий компонент (до усунення помилок компіляція зупиняється). 
Наступним кроком є трасування, яке полягає у виборі місцеположення ко-
мірки ПЛІС для реалізації певної функції і маршруту її зв’язків із виводами 
мікросхеми таким чином, аби забезпечити максимальну швидкодію. За ре-
зультатами трасування модуль компілятора асемблер генерує об’єктні файли 
для виготовлення реально працюючого пристрою. Останнім кроком компі-
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ляції є часовий аналіз, який полягає у вимірюванні затримки сигналів різни-
ми шляхами їх поширення, визначенні критичних шляхів і, отже, найгіршої 
швидкодії, тобто придатності проекту для реалізації заданої мети. 

Під час функціонального моделювання з переліку сигналів, що міс-
титься в службових файлах компілятора, формується файл часових діаг-
рам. При цьому вхідні сигнали задаються користувачем, а вихідні – гене-
руються імітатором (програмним модулем Simulator). Залежно від вибра-
ного режиму імітатор може моделювати або лише виконувану пристроєм 
функцію, або функцію і часові затримки. Завдяки цьому функціональне 
моделювання дозволяє випробувати і налагодити пристрій перед втіленням 
його в кристалі, що значно скорочує термін проектування. 

Завершальним етапом є фізичне програмування/конфігурування мік-
росхеми, яке здійснюється з об’єктних файлів програматором, що є моду-
лем САПР. Крім того, залежно від використовуваних апаратних засобів 
програматор може виконувати перевірку функціонування готового виробу 
шляхом подачі на його входи випробувальних сигналів і порівняння вихід-
них сигналів зі сформованими часовими діаграмами.   

*** 
З метою активізації навчання практикум має варіантний характер. 

Для зарахування кожної роботи необхідно: а) засвоїти теоретичний матері-
ал з даної теми, б) виконати практичне завдання згідно зі своїм варіантом,       
в) виконати загальну частину лабораторного завдання ознайомчого харак-
теру, г) створити проекти за індивідуальним завданням з моделюванням 
результатів, д) створити лабораторний макет згідно із заданим варіантом та 
виконати експериментальні дослідження (відомості про лабораторний 
стенд містяться в [2, 8]). Щоб виконати завдання, потрібно засвоїти також 
процедури і елементи програмного забезпечення САПР Quartus II (у 
зв’язку з надзвичайно розгалуженою цією системою рекомендується об-
межитися мінімумом відомостей, достатніх для даної роботи). Методично 
практикум побудовано таким чином, аби практичні і лабораторні завдання 
можна було виконати самостійно, у дистанційному режимі (експеримента-
льні дослідження за п. д виконуються в лабораторії за наявності заздале-
гідь підготовлених файлів на магнітному носії). 

Зміст звіту з виконання завдання  
Назва і мета роботи; результати виконання домашнього завдання; 

зміст кожного пункту лабораторного завдання: бібліотечні файли (частина-
ми або в скороченому вигляді, щоб помітно було деталі), файли зі схемами, 
часовими діаграмами (у разі потреби, застосувати альбомну орієнтацію 
сторінки) та іншими результатами зі стислими поясненнями і висновками; 
результати експериментальних досліджень, які можна подавати скорочено 
у формі таблиць і стислих висновків. 
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1 ЛАБОРАТОРНА РОБОТА №1. ОСНОВНІ ЛОГІЧНІ ФУНКЦІЇ 
 
Мета роботи: дослідження типових логічних елементів; ознайом-

лення з основами пакету Quartus II та керуванням його файлами.  
 

ДОМАШНЄ ЗАВДАННЯ 
! 1) Засвоїти теоретичні відомості щодо основних логічних функ-

цій, співвідношень алгебри логіки, а також арифметичних основ цифрової 
техніки, необхідних для розуміння логічних схем.  

2) Визначити, яку логічну функцію виконують схеми з елементом, 
заданим згідно з варіантом (див. Додатки, варіанти завдання 1). 

 
СТИСЛІ ТЕОРЕТИЧНІ ВІДОМОСТІ 

Алгебра логіки є основою не тільки проектування ЦП, але й розу-
міння принципу їх дії. Вона використовується також за текстового опису 
проектів мовами програмування високого рівня HDL (Hardware Description 
Language – мови опису апаратних засобів), зокрема, мовою AHDL, яка 
пристосована до ІС фірми Altera. Основні логічні функції та зображення їх 
мовою AHDL наведено в табл. 1.1. Пояснення щодо основ алгебри логіки, 
а також арифметичні основи цифрової техніки, необхідні для розуміння 
логічних схем, викладено в [1]. 

Основні співвідношення алгебри логіки (табл. 1.2) розглядаються в 
булевій алгебрі, здебільшого, відносно функцій АБО та І, а справедливість 
тих чи тих формул відносно інших функцій з'ясовується окремо (у табл. 2 
для прикладу наведено також співвідношення для функції Виключне АБО). 

Будь-яка логічна функція зображається в досконалій диз'юнктивній 
нормальній формі (ДДНФ) або в досконалій  кон'юнктивній нормальній 
формі (ДКНФ) єдиним способом, тому ці форми називають стандартними, 
що є вихідними для подальшого аналізу й синтезу. Природно, стандартні 
форми можна зобразити і для інверсного значення функції (табл. 1.3) 

Примітиви є функціональними модулями в САПР, які репрезенту-
ють найпростіші типові елементи ЦП, а також допоміжні компоненти в 
графічних і текстових файлах проекту (термін Primitive охоплює базові ло-
гічні елементи, тригери, порти та ін.).  

Бібліотека всіх функціональних модулів САПР розташована в ката-
лозі c:/quartus/libraries, а примітиви зосереджено в підкаталозі /primitives. 
Відомості про примітиви (рис. 1.1) подано в [2].   
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Таблиця 1.1 – Основні логічні функції 

Назва логічної функції  
(логічного елемента) 

Таблиця  
відповідності Позначення функції Умовне графічне  

позначення 
Звичайна САПР x2 x1 y0 y1 Булеве AHDL ДЕСТУ САПР 

Повторення  
(повторювач, буфер) 
НЕ (елемент НЕ,  
інвертор) 

Buffer 
NOT 

0  
1  

0 1  
1 0  

11

10

xy

xy

=

=
 

y0 = x1 
y1 = !x1 

  

АБО (елемент АБО,  
диз’юнктор)  
АБО-НЕ (елемент 
АБО-НЕ / Пірса) 

OR 
NOR 

0 0 
0 1 
1 0 
1 1 

0  1 
1  0 
1  0 
1  0 211

210

xxy

xxy

+=

+=
 

y0 = x1 # x2 
y1 = x1 !# x2 

  
І (елемент І / збігу, 
 кон’юнктор) 
І-НЕ (елемент 
І-НЕ / Шеффера) 

AND 
NAND 

0 0 
0 1 
1 0 
1 1 

0  1 
0  1 
0  1 
1  0 211

210

xxy

xxy

=

=
 

y0 = x1 & x2 
y1 = x1 !& x2 

  
Виключне АБО  
(елемент  
 нерівнозначності)  
Виключне АБО-НЕ  
(елемент 
рівнозначності)  

XOR 
XNOR 

0 0 
0 1 
1 0 
1 1 

0  1 
1  0 
1  0 
0  1 211

210

xxy

xxy

⊕=

⊕=
 

y0 = x1 $ x2 
y1 = x1 !$ x2 

 

 

 

Заборона 
(елемент НІ) 
Імплікація 
(імплікатор) 

(Inhb) 
(Ninhb) 

0 0 
0 1 
1 0 
1 1 

0  1 
1  0 
0  1 
0  1 211

210 \
xxy

xxy
→=

=
 

y0 = x1 & !x2 
y1 = !x1 # x2 
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Таблиця 1.2 – Основи алгебри логіки 

№ Співвідношення АБО 
а) 

І  
б) 

Виключне АБО  
в) 

Аксіоми: 

1 Подвійне запере-чення xx =   

2 Дозвіл xx =+ 0  xx =⋅1  xx =⊕ 0  

3 Блокування (ін-
вертування) 11 =+x  00 =⋅x  ( xx =⊕1 ) 

4 Повторення xxx =+  xxx =⋅  0=⊕ xx  
5 Доповнення 1=+ xx  0=⋅ xx  1=⊕ xx  
Закони: 
1 Переставний 1221 xxxx +=+  1221 xxxx =  1221 xxxx ⊕=⊕  

2 Сполучний ( )321

321

xxx
xxx
++=

=++  ( )321

321

xxx
xxx

=
=  ( )321

321

xxx
xxx
⊕⊕=

=⊕⊕  

3 Розподільчий 
( )

3121

321

xxxx
xxx

+=
=+  ( ) ( )3121

321

xxxx
xxx

+++=
=+  ( )

3121

321

xxxx
xxx

⊕=
=⊕  

4 Двоїстості (де Морґана) 2121

2121

xxxx

xxxx

=+

=+  
2121

2121

xxxx

xxxx

+=

+=   

Наслідки: 
1 Склеювання 12121 xxxxx =+  ( )( ) 12121 xxxxx =++  12121 xxxxx =⊕  
2 Поглинання 1211 xxxx =+  ( ) 1211 xxxx =+  21211 xxxxx =⊕  
3 Заступлення 21211 xxxxx +=+  ( ) 21211 xxxxx =+  21211 xxxxx +=⊕  

 
Таблиця 1.3 – Стандартні форми логічних функцій 
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Рис. 1.1 – Основні примітиви 

 
КОНТРОЛЬНІ ЗАПИТАННЯ 

1.1. Які системи логічних функцій є функціонально повні? Які з них 
є мінімально повні? Доведіть, що мінімально повну систему утворюють: 1) 
операція заборони і константа одиниці, 2) операція імплікації і константа 
нуля. 

1.2 Логічну функцію y здійснити на заданому елементі з викорис-
танням інверторів (далі наводиться варіант – функція – заданий елемент): 

..)14

;)13

;)12;)11

;)10;.)9

;)8;)7

;)6;)5

;)4;.)3

;)2;)1

54321

54321

5432154321

214321

54321654321

4321

2154321

54321987654321

АБОВиклxxxxxy

НЕАБОxxxxxy

НЕIxxxxxyНЕАБОІxxxxxy

ЗаборонаxxyНЕАБОВиклxxxxy

НЕАБОxxxxxyНЕІxxxxxxy

НЕІxyАБОІxxxxy

ЗаборонаxxyАБОВиклxxxxxy

АБОxxxxxyIxxxxxxxxxy

−⊕⊕⊕⊕=

−−++++=

−−=−−−+++=

−+=−−⊕⊕⊕=

−−=−−+++++=

−−=−−++=

−=−⊕⊕⊕⊕=

−++=−++=

 

.)16

;))(()15

1110987654321

654321

НЕАБОІxxxxxxxxxxxy

НЕАБОІxxxxxxy

−−−+++++++=

−−−++=  

1.3. Який логічний елемент B (рис. 1.2,г) утворюється додаванням інвер-
торів відповідно з рис. 1.2,а,б,в, якщо A є елемент: 1) АБО, 2) І, 3) Виключне 
АБО, 4) Заборони, 5) АБО-НЕ, 6) І-НЕ, 7) Виключне АБО-НЕ, 8) Імплікатор? 

 
Рисунок 1.2 
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ЛАБОРАТОРНЕ ЗАВДАННЯ 
1 Налаштувати основні органи керування вікнами й файлами 

програмного пакету САПР Quartus II. 
F Примітка: Послідовність дій, виконуваних (в основному вікні, діа-

логових вікнах, їх частинах, у списках, що розкриваються) натисканням лівої 
кнопки миші (Button 1), далі найчастіше позначатимемо для стислості знаком 
„>”, а натискання правої кнопки миші (Button 2) – інколи знаком „В2”. 

1.1 Запустити програму Quartus II ярликом на робочому столі 
(або з меню Windows: Пуск > Всі програми > Altera > Quartus II 6.1). 

Якщо є допоміжні вікна (ліворуч і знизу), зачинити їх та ознайомитися з 
елементами головного вікна і списками типових команд меню File, Edit 
(редагування), View (вигляд), Window (вікно) та Help (довідка). 

 
1.2 Налаштувати з мінімуму зручних для роботи піктограм інстру-

ментальну панель головного вікна. 
а) Налаштувати стиль відображення інструментальної панелі голо-

вного вікна. Для цього в меню Tools (інструментальні засоби) > Customize 
(налаштувати) > на вкладці General (загальні), у розділі Look & Feel (стиль 
відображення) ввімкнути Quartus II, у розділі Quick menus (швидкі меню), 
у рядках Quartus II menu та MAX+PLUS II menu прокруткою вибрати Left 
(розташувати ліворуч). 

б) Установити стандартну панель пакету: на вкладці Toolbars (ін-
струментальні панелі) зі списку панелей Toolbars вибрати тільки Standard 
Quartus II, а всі інші вимкнути. Крім того, встановити облямовані кнопки 
великого розміру: зняти прапорець Borderless look (кнопки без облямівок), 
та підняти прапорці Show tooltips (показувати типи інструментів) і  Large 
buttons (великі кнопки). 

в) Сформувати інструментальну панель: на вкладці Commands виб-
рати категорію File, взятися за значок у полі Buttons і перетягнути його до 
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відповідної позиції на панелі та вилучити зайві кнопки перетягуванням їх 
із панелі до робочого поля вікна. Так само встановити кнопки з інших ка-
тегорій, зазначених на ілюстрації, та натиснути кнопку ОК у вікні 
Customize. Налаштовану панель з одного рядка найуживаніших інструмен-
тів показано на ілюстрації внизу. 

 
  

1.3 Налаштувати загальні опції робочого середовища.  
а) Визначити опції зручності роботи з пакетом. Для цього з меню 

Tools > Options розкрити сторінку General (загальні) діалогового вікна оп-
цій (ілюстрацію див. нижче), в якому встановити прапорці таких опцій: 1) 
ввімкнути: повторно відкривати поточні проект і файли під час запуску – 
останній проект і відкриті файли запам’ятовуються і автоматично переза-
вантажуються по ввімкненні програми; 2) вимкнути: показувати недавно 
використовувані файли і проекти в підменю, у віконці Show залишити ма-
ксимальну їх кількість 5 – останні використовувані файли і проекти відо-
бражатимуться безпосередньо в меню File (якщо опцію ввімкнути, до де-
сяти об’єктів відображатимуться в кожному з підменю File > Recent Files 
та File > Recent Projects); 3) ввімкнути: підказ, чи додавати файли до прое-
кту – це запитання з’являтиметься під час збереження файлу, який не був 
включений до складу проекту; 4) кнопкою огляду (…) вибрати місцеполо-
ження файлу за умовчанням – вибраний початковий каталог з’являти-
меться під час відкриття і збереження файлів; 5) вимкнути: показ вступних 
сторінок майстрів – сторінки із загальним описом не показуватимуться під 
час створення нового проекту та активізації інших майстрів (програмних 
модулів); 6) ввімкнути: відображати рядок стану – у звичайному режимі 
цей рядок дає стислий опис функції інструмента панелі або палітри при 
наведенні на нього покажчика, а по запуску компілятора і імітатора відо-
бражає перебіг процесів; 7) ввімкнути: показувати кнопки панелі в меню – 
поруч з командами в меню відображатимуться позначки кнопок відповід-
них інструментів панелей і палітр; 8) ввімкнути: показувати таблички до-
чірніх вікон – відображатиметься рядок відкритих файлів; 9) вимкнути: 
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показувати повний шлях у вікнах файлів – у рядках заголовків файлів ві-
дображатиметься лише частина директорії, відмінна від директорії проек-
ту, що подається в рядку заголовка головного вікна; 10) ввімкнути: обме-
жити одним зразком – якщо буде відкрите друге головне вікно Quartus ІІ, 
один і той самий проект може бути відкритим лише в одному з них;        
11) ввімкнути: автоматично давати ім’я вихідному файлові мегафункції і 
використовувати поточний вихідний формат – під час вставлення зразка 
символу мегафункції автоматично генерується вихідний текстовий файл 
завжди тією мовою, яка встановлена при виборі мегафункції, а її ім’я скла-
датиметься зі стандартного імені функції з додаванням номеру. 

 

 
 
б) Переглянути файл ліцензії програмного забезпечення і, у разі по-

треби, встановити його. Для цього відкрити сторінку License Setup (уста-
новки ліцензії) з такими позначеннями на ілюстрації: 1) файл ліцензії у 
програмному забезпеченні Quartus ІІ, який можна встановити кнопкою 
огляду (…); 2) використовувати змінну файлу ліцензії – якщо цю опцію 
встановлено, поле License file є неприступне для редагування і вибирається 
файл ліцензії license.dat; 3) параметри поточної ліцензії: її тип, термін дії, 
тип та номери ідентифікаторів (пов’язані із системою комп’ютера і типом 
ліцензії); 4) підімкнення до Altera website для поновлення ліцензії; 5) поча-
ток 30-денного використання програмного забезпечення (без можливості 
програмувати/конфігурувати мікросхему) – по кожному запуску в повід-
омленні зазначається, скільки днів залишилось із цього періоду, після яко-
го компіляція і імітація блокуються; 6) системні відомості ПК, які можуть 
знадобитися для одержання ліцензії. Відтак натиснути ОК у вікні Options.     
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2 
Засвоїти основи керування файлами пакету Quartus II. 

2.1 Відкрити потрібний файл, наприклад, 1libr.bdf з директорією 
(повним каталогом) d:\quartus6.1work\1lab\1libr.bdf:  

а) піктограмою панелі інструментів Open (або з меню File > 
Open)  викликати діалогове вікно Open (відкрити існуючий файл пе-

вного типу);  
 б) у діалого-

вому вікні Open 
прокруткою вибрати 
потрібний тип фай-
лів – Graphic Files 
(графічні файли); 

в) у цьому ж 
вікні, у разі потре-
би, за допомогою 
стрілки „на один рі-
вень вгору” та по-

двійним клацанням по відповідних папках послідовно розкрити директо-
рію d:, quartus6.1work, 1lab та відкрити файл 1libr. 

2.2 Переглянути і скопіювати графічний файл:  
а) інструментом Fit in Window (аркуш 

файлу з червоними стрілками в кутах) розташу-
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вати весь файл у розгорнутій частині вікна, аби мати уявлення про його 
розміри, відтак інструментами керування масштабом зображення поверну-
тися до нормального розміру (100%) та розгорнути головне вікно на весь 
екран (інструмент Full Screen у вигляді екрана на вертикальній палітрі); 

F Примітка: Іструмент Zoom Tool (у вигляді лінзи) при натисканні 
лівою кнопкою миші збільшує зображення, а правою кнопкою – зменшує.    

б) виділити потрібну ділянку для копіювання графічного 
файлу: натиснути інструмент вибору (Selection – у вигляді стрілки) і 

протягнути ним по діагоналі ділянки, утримуючи натиснутою ліву кнопку 
миші, по відпусканні якої всі елементи ділянки виділяться синім кольором 
(виділити весь файл зручно командою меню Edit > Select All); 

 в) інструментом верхньої панелі Copy – копіювати (або з 
меню Edit > Copy) скопіювати виділену ділянку в буфер. 
2.3 Створити власний файл потрібного типу, наприклад, 

prim.bdf з директорією d:\RT\2br\prim.bdf:  
a) піктограмою горизонтальної панелі New Block Dia-

gram/Schematic File (або з меню File > New > Device Design Files > 
Block Diagram/Schematic File > OK) створити новий файл у графічному ре-
дакторі (Block & Symbol Editors) – з’явиться вікно з безіменною назвою 
Block N (де N – довільний номер);  

б) у лівому верхньому куту цього вікна курсором клацнути 
місце вставлення копії і натиснути піктограму панелі інструментів 

Paste (або меню File > Paste) – копія зображення позиціонується лівим вер-
хнім кутом у місці клацання; 

в) піктограмою Save (або меню File > Save) викликати діало-
гове вікно Save As (зберегти як), в якому за допомогою стрілки „на 

один рівень вгору” та подвійним клацанням по відповідних папках послі-
довно розкрити директорію d:, у разі потреби, створити вкладені теки 
RT\2br (піктограмою створення нової теки в цьому ж вікні), розкрити 

останню теку 2br, ввести ім’я файлу prim (примітиви) та натиснути 
кнопку збереження – у рядку заголовка файлу відобразиться дирек-

торія і ім’я файлу з розширенням .bdf.  
F Примітки: 
1) Копіювати файли для звіту можна під час виконання відповідних 

пунктів лабораторної роботи. Якщо тека вже існує, немає потреби створю-
вати директорію, достатньо її вибрати та ввести лише ім’я файлу.  

2) Під час змін у файлі після його заголовка з’являється зірочка в 
його вікні і в рядку відкритих файлів, яка зникає по збереженні файлу.  

3) Тут подано швидке виконання операцій з файлами за допомогою 
піктограм інструментів, але їх можна виконати також командами складників 
рядка меню або з контекстного меню, яке викликається кнопкою В2 (вико-
нання операцій сполученням клавіш тут, здебільшого, не розглядається).  

4) Наведені операції з файлами дають змогу створювати власний 
проект, частинами якого можуть бути копії фрагментів інших проектів. 
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Але лише задля документування, як звичайно, достатньо скопіювати файли 
потрібного типу безпосередньо в теці  Мій комп’ютер Windows з лабора-
торної до своєї теки. 

2.4 Скопіювати у власну теку потрібний сигнальний файл (файл 
часових діаграм) або його частину з лабораторної теки: 

а) відкрити сигнальний файл (першою піктограмою), 
наприклад, 1logfun.vwf з директорією d:\quartus6.1work\1lab\ 

1logfun.vwf (виконати п. 2.1, але в п. 2.1,б прокруткою вибрати файли типу 
Waveform/Vector Files), вписати все зображення у вікні (другою піктогра-
мою), виділити потрібні часові діаграми (командою меню Edit > Select >  
All Nodes & Buses, або натиснути рядок першого сигналу в полі заголовків 
і клацнути останній рядок при натиснутій клавіші Shift для виділення всіх 
діаграм, або клацати рядки при натиснутій клавіші Ctrl для виділення діаг-
рам вибірково) і скопіювати їх піктограмою (або з меню Edit > Copy); 

б) зчитати кінець часового інтервалу діаграм та період 
часової сітки відповідно з масштабного віконця горизонтальної 

панелі інструментів і верхнього рядка часових діаграм (або з меню Edit > 
End Time та Edit > Grid Size); 

в) піктограмою New Vector Waveform File – створення 
нового файлу часових діаграм (або з меню File > New > Other 

Files > Vector Waveform File > OK) відкрити вікно нового файлу і клацнути 
піктограму вставлення копії з буфера – у цьому вікні з’явиться копія часо-
вих діаграм; 

г) виставити такі самі часові параметри, як у п. б за допомо-
гою меню Edit > End Time та Edit > Grid Size, відтак для перегляду 

діаграм піктограмою Fit in Window (вписати все зображення у вікно) роз-
ташувати весь часовий інтервал у вікні файлу; 

ґ) надати ім’я, наприклад, 1logfun.vwf безіменному Waveform N 
файлу та зберегти його у власній теці (п. 2.3,в). 

2.5 Ознайомитися з керуванням групою файлів. 
а) Під час роботи над проектами зручно оперувати з низкою файлів, 

заголовки яких розташовуються в рядку відкритих файлів. Для активізації 
потрібного файлу достатньо клацнути його назву в цьому рядку. 

б) Файли можна розташувати з відображенням заголовків також ка-
скадом (командою з меню Window > Cascade) або у вигляді неперетинних 
вікон на екрані (командами з меню Window > The Horizontally або The Ver-
tically), а також згорнути файли, не потрібні в першу чергу, до іконок вни-
зу головного вікна Quartus II клацанням по їх символу згортання.  

в) Для відкриття одного з п’яти недавно використовуваних файлів 
достатньо клацнути його назву з верхнього списку в меню File (нижній 
список містить п’ять недавно використовуваних проектів).   

 
3 Дослідити логічні елементи. 
3.1 Ознайомитися з дібраними елементами бібліотеки примітивів 
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(файл 1libr.bdf): 1) портами, 2) буферами, 3) логічними елементами, 4) логіч-
ними 0 та 1, а також прикладами їх мікросхемного виконання на ІС серії 74.  
Дати тлумачення сенсу кожного позначеного символами примітива. Отрима-
ти інформацію щодо примітивів з довідки: Help > Contents > Primitives > Ім’я 
примітива. У звіті навести елементи 1 … 3 та деякі приклади ІС.  

3.2 Визначити в булевому базисі еквівалентну логічну функцію, ви-
конувану кожною схемою на примітивах (файл 1log_f.bdf ).  

3.3 За ідеалізованими часовими діаграмами без урахування затримок 
(файл 1logfun.vwf) побудувати таблиці відповідності функцій z1… z14 і запи-
сати вирази z1… z14 = f (x1, x2) у булевому базисі. Під час побудови таблиці 
зручно користуватися маркером часу. Для цього слід перетягнути вузол (ква-
дратик вгорі) маркера при натиснутій лівій кнопці в довільне положення на 
першій часовій ділянці діаграм і зчитати в полі рівня (Value) значення сигна-
лів, поданих у полі імені (Name). Відтак перетягнути маркер на другу ділянку 
і так само зчитати рівні і т. д. до заповнення всієї таблиці відповідності. 

 
F Примітки: 
1) Уривистим клацанням по стрілках біля поля часу маркера він пе-

реводиться до стрибка рівнів на діаграмах.  
2) Часові позиції можна відмітити додатковим маркером часу, який 

створюється з меню Edit > Time Bar Organizer > ввести в діалоговому вікні 
Time Bar Organizer, у рядку Time потрібний час положення додаткового 
маркера > Add > OK. Для анулювання цього маркера досить у діалоговому 
вікні Time Bar Organizer виділити його час у рядку  Existing time bars > на-
тиснути Delete > OK.  

3.4 На копії схеми у власному графічному файлі 1log_f.bdf 
навести номери часових діаграм з файлу 1logfun.vwf, що відпові-

дають кожному виходу. Для цього виділити порт і натиснути інструмент па-
літри Properties (або клацнути символ порту інструментом палітри Text Tool) 
та в діалоговому вікні Pin Properties (властивості виводів) > Gene-ral (загаль-
ні) до імені виводу в рядку Pin Name додати через знак рівності функцію з 
часової діаграми, наприклад, y1 = z1 > ОК (аби вийти з текстового режиму, 
слід натиснути інструмент вибору – стрілку).       
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3.5 Спостерігати на виході основних логічних елементів (файл 
1ryz.bdf) виникнення ризиків у вигляді паразитних імпульсів внаслідок не-
безпечних змагань сигналів (файл 1ryzyk.vwf); дані подати фрагментами 
ідеалізованих (без урахування затримок) осцилограм вхідних і вихідних 
сигналів у місцях виникнення ризиків зі стислим поясненням. 

 
4 Дослідити кола формування коротких імпульсів на логічних 

елементах.  
4.1 За схемою і часовими діаграмами (файли 1det.bdf, .vwf) розгля-

нути принцип побудови різницевого елемента (РЕ) на логічному елементі 
І-НЕ і елементі затримки (буфери LCELL) з інверсією (NOT) та застосу-
вання його у колах формування коротких імпульсів – детекторах фронтів 
вхідних імпульсів х: за позитивним (dx1), негативним (dx2n) їх перепадом 
та за обома перепадами (dxn). Переглянути також окремі детектори одного 
фронту (файли 1det1 та 1det2.bdf, .vwf, .bsf). 

F Примітки: 
1) У класичному детекторі фронтів на ІС жорсткої структури для 

затримки та інверсії застосовують ланцюжок з непарної кількості логічних 
елементів з інверсними виходами. Щодо алгебри логіки це не має сенсу, 
тому компілятор за аксіомою подвійного заперечення усуває зі схеми „зай-
ві” ланцюжки елементів, отже, і затримку. Аби запобігти цьому, в ІС про-
грамованої структури застосовано буфери LCELL. 

2) На часових діаграмах 1det.vwf у полі типів контакту наведено три 
типи вузлів: вхідний порт із позначкою I (Input), вихідні порти O (Output) 
та деякі внутрішні вузли С (Combinatorial Node – комбінаційний вузол), не 
сполучені безпосередньо із зовнішніми контактами ІС.  

4.2 Виміряти затримки поширення сигналів та тривалості вихідних 
імпульсів ручним способом. Для цього уривистим клацанням по стрілках 
біля поля часу маркера (див. малюнок до п. 3.3) переводимо останній до 
потрібного перепаду сигналу і відлічуємо час у згаданому полі. 

F Примітки: 
1) Для вимірювань можна користуватися також курсором (інстру-

ментом вибору у вигляді стрілки): індикатори Pointer та Interval відзнача-
ють часове положення стрілки і віддаль між нею і маркером. 

2) Для переведення маркера в довільну позицію незалежно 
від кроку сітки слід відтиснути інструмент палітри або зняти пра-

порець Snap to Grid (прив’язка до сітки) в меню View. 
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2 ЛАБОРАТОРНА РОБОТА №2. 
РЕАЛІЗАЦІЯ ЛОГІЧНИХ ФУНКЦІЙ 

 
Мета роботи: реалізація логічних функцій у поширених базисах; 

створення проекту за його графічного введення; засвоєння методики кори-
стування електронним довідником для добору потрібної ІС серії 74 і мето-
дики настроювання макрофункцій.  

 
ДОМАШНЄ ЗАВДАННЯ 

! 1) Засвоїти теоретичні відомості щодо мінімізації логічних функ-
цій, реалізації їх у поширених базисах та способів спрощення логічних схем.  

2) Для заданої згідно з варіантом (див. Додатки, варіанти завдання 
2) логічної функції y: а) побудувати таблицю відповідності і діаграму тер-
мів (Вайча-Карно); б) навести досконалі (ДДНФ або ДКНФ) та мінімальні 
(МДНФ і МКНФ) форми; в) перетворити мінімальні форми до базисів І-
НЕ, АБО-НЕ та І-АБО-НЕ; г) мінімізувати схему в базисі І-НЕ чи АБО-НЕ, 
який забезпечує меншу складність; ґ)  навести схеми за п. в, г.  

 
СТИСЛІ ТЕОРЕТИЧНІ ВІДОМОСТІ 

Мінімізацію логічних функцій, реалізацію їх у поширених базисах, 
а також питання схемної мінімізації розглянуто в [1]. Відомості про мак-
рофункції логічних елементів (рис. 2.1,а,б) подано в [2].    

 
Рисунок 2.1 

 
Приклад. З використанням макрофункції виконати логічну операцію 

.654321 xxxxxxy ++=  
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На рівні примітивів таку функцію можна здійснити на двох логіч-
них елементах – тривходовому АБО-НЕ та чотиривходовому І: 

.; 654321 xxxayxxxa =++=  
Проте якщо задану функцію перетворити до вигляду 

,654321 xxxxxxy =  
то потрібен один нестандартний елемент І (із шістьма входами, три з яких 
є інверсні), який неважко виконати шляхом настроювання макрофункції 
(рис. 2.1,в). 

 
КОНТРОЛЬНІ ЗАПИТАННЯ 

2.1. Які є відмінні риси зображення логічних функцій, притаманні 
таким формам: мішаній, ДФ, ДНФ, ДДНФ, МДНФ, КФ, КНФ, ДКНФ, 
МКНФ? 

2.2.Спростіть вирази:   
1) ( )( )( )323121 xxxxxx +++ ; 2) 32213121 xxxxxxxx +++ ;  

3) ( )( )( )323121 xxxxxx +++ ; 4) ( )( )( )( )32312121 xxxxxxxx ++++ ;  

5) ( )( )( )( )32312121 xxxxxxxx ++++ ;  6) 4232413121 xxxxxxxxxx ++++ ; 

7) 321213312321 xxxxxxxxxxxx ++++++++ ; 

8) ( )( )( )( )( )( )( )54535251413121 xxxxxxxxxxxxxx +++++++ .  
Вказівка. За необхідністю, скористайтеся діаграмами термів. 
2.3. Виконайте спільну мінімізацію чотирьох вихідних функцій, що 

здійснюють перетворення ДДК 8421 у такі коди: а) 2421, б) 7421, в) 8421+3 
(з надлишком три), г) код Ґрея (перші десять цифр X10 = 0...9 чотирирозря-
дного коду). Вказівки. На заборонених кортежах X10 > 9 вважати функції 
невизначеними. Схему мінімальної складності реалізуйте на довільних ло-
гічних елементах. 
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ЛАБОРАТОРНЕ ЗАВДАННЯ 
 

1 Засвоїти основи графічного введення проекту на рівні примі-
тивів для заданого варіанту ХХ логічної функції (для прикладу див. файл 
..\quartus6.1work\2lab\200.bdf, схема 1).  

1.1 Дати ім’я новому проекту 2ХХ (ХХ – варіант) з директорією 
власної теки, наприклад, ..\RT\2br\202: 

а) піктограмою New Project Wizard (або з меню File > New 
Project Wizard) запустити майстра нового проекту – з’явиться одно-

йменне діалогове вікно;  

 
б) у верхньому рядку, якщо директорія зазначена інша, натиснути 

кнопку огляду (...) – з’явиться діалогове вікно Select Directory;  

 
в) у цьому вікні вибрати потрібну теку (\RT\2br), ввести ім’я файлу 

(202) і натиснути кнопку відкриття – заповниться вся сторінка діалогового 
вікна New Project Wizard: у верхньому рядку з’явиться директорія, у дру-
гому – ім’я проекту (202), яке продублюється в третьому рядку як ім’я 
об’єкту верхнього рівня проекту. Відтак натиснути кнопку Finish – дирек-
торія і ім’я проекту з’являться в рядку заголовка головного вікна.  
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F Примітка: Рядки діалогового вікна New Project Wizard можна за-
повнити або скоригувати також вручну.  

1.2 Створити графічний файл 2ХХ.bdf нового проекту:  
a) піктограмою горизонтальної панелі New Block Diagram / 

Schematic File (або з меню File > New > сторінка Device Design Files 
> Block Diagram/Schematic File) відкрити новий графічний файл – з’явиться 
вікно з безіменною назвою BlockN.bdf (де N – номер);  

б) налаштувати інструментальну палітру графічного редактора 
(розташована вертикально ліворуч): меню Tools (інструментальні засоби) > 
Customize Block Editor (налаштувати графічний редактор) > на сторінці 
Toolbars (інструментальні панелі) встановити облямовані кнопки великого 
розміру: зняти прапорець Borderless look (кнопки без облямівок), та підня-
ти прапорці Show tooltips (показ типів інструментів) і  Large buttons (великі 
кнопки) > на сторінці Commands вибрати категорію Block Editor, взятися за 
значок у полі Buttons і перетягнути його до відповідної позиції на палітрі 
та вилучити зайві кнопки перетягуванням їх із палітри до робочого поля 
файлу; відтак натиснути кнопку ОК у вікні Customize (налаштовану паліт-
ру з одного стовпця найуживаніших інструментів показано в горизонталь-
ному вигляді на ілюстрації внизу); 

 
 

в) налаштувати опції графічного редактора, для чого з меню Tools > 
Options розкрити сторінку Block/Symbol Editor діалогового вікна опцій 
(ілюстрацію див. нижче), в якому ввімкнути прапорці таких опцій: 1) показ 
сітки – для зручності розташування у вікні елементів схеми; 2) в рядку 
Guideline spacing прокруткою встановити крок сітки 1; 3) прив’язка до сіт-
ки (застосовується тільки до символьного редактора, а в графічному редак-
торі об’єкти завжди прив’язано до координатної сітки) – дозволяє позиціо-
нувати елементи символу під час його графічного редагування; 4) подвій-
ним клацанням об’єкту викликáти вікно його властивостей (ця опція діє 
незалежно від прапорця в окремих версіях пакету); 5) показ таблиць вхо-
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дів/виходів блоку – у проектах на рівні блок-схеми відображає всередині 
блоку таблиці його входів і виходів; 6) показ трасувальних таблиць – у 
проектах на рівні блок-схеми відображає зв’язки виводів блоку із сигнала-
ми зовнішніх з’єднань (функції інших опцій, не відмічених на ілюстрації 
цифрами, або оперативно керуються інструментами палітри, або відобра-
жають дані, що містяться в довідці на мікросхему); відтак натиснути кноп-
ку ОК у вікні Options;  

 
г) подвійним клацанням у вільному місці поля графічного 

файлу (або інструментом палітри Symbol Tool, або з меню Edit > 
Insert Symbol) ви-
кликати діалогове 
вікно Symbol;  

ґ) розгортан-
ням бібліотеки у ві-
конці Libraries (на-
тисканням знаку +) 
відчинити primitives 
> pin > input – у пра-
вому вікні з’явиться 
зразок символу вхі-
дного порту (виводу 
ІС); відтак підняти 
прапорець Repeat-
insert mode (режим 
вставлення з повто-

ренням) та натиснути ОК – символ буде прив’язаний до покажчика миші; 
д) клацанням лівою кнопкою миші вставити до графічного файлу 

необхідну кількість вхідних портів, які позиціонуються верхнім лівим ку-
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том у місцях клацання (аби скасувати прив’язку символу до покажчика, 
достатньо натиснути інструмент вибору – стрілку); 

 
е) повторюючи п. г, ґ, д, вставити всі потрібні елементи, наприклад, 

not, nand2, nand3 (категорія logic) та вихідний порт output (категорія pin);   
є) користуючись інструментами палітри, розташувати елементи у вік-

ні  графічного файлу (приблизно як на схемі): клацання інструментом вибору 
всередині елемента виділяє його, а поза елементом – скасовує виділення (ви-
ділити всі елементи можна з меню Edit > Select All); якщо поставити цей ін-
струмент на елемент, то при натиснутій лівій кнопці його можна пересунути 
по екрану (звичайний метод “Drang & Drop”); скопіювати і пересунути копію 
елемента на нове місце можна методом “Drang & Drop” при натиснутій і 
утримуваній клавіші Ctrl (її треба відпускати останньою); виділений елемент 
можна також відобразити по горизонталі (за ДЕСТУ в логічних схемах цього 
робити не можна) або по вертикалі (змінюється позиціонування написів), по-
вернути на кут 90° тощо; крім того, за допомогою горизонтальної панелі ін-

струментів попередньо виділений елемент мож-
на, як звичайно, вирізати (у буфер), скопіювати, 

вставити потрібну кількість разів у місцях клацання (у цьому або іншому 
файлі), скасувати останні дії або відмінити скасування (зігнені стрілки) та 
видалити без збереження в буфері (клавішею Delete); 

F Примітка: З контекстного меню (викликається кнопкою В2) з 
виділеним елементом можна виконати такі самі операції.  

ж) з‘єднати логічні елементи між собою та з портами введен-
ням з‘єднувальних ліній за допомогою інструментів палітри: підвес-

ти курсор інструмента ортогональних ліній (або вибору) до виводу елемен-
та чи порту і, коли він набуде форми хреста, натиснути ліву кнопку та про-
тягнути лінію у вигляді горизонтальних і вертикальних відрізків, які закін-
чуються по відпусканні кнопки (точки з‘єднань утворюються автоматич-
но); для вилучення зайвого відрізка його слід виділити підведенням стріл-
ки і клацанням лівою кнопкою та видалити; якщо під час редагування схе-
ми потрібно пересунути елемент зі збереженням або без збереження 
з’єднувальних ліній, достатньо скористатися інструментом палітри Rubber-
banding (метод гумової нитки); за необхідністю, вставити або вилучити то-
чку з‘єднань можна подвійним клацанням в місці з’єднання будь-яким ін-
струментом з’єднувальних ліній (зображені з точками);   
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з) позначити назви входів і виходів: інструментом введення 

тексту клацнути символ (або виділити символ та натиснути інстру-
мент Properties – властивості, або B2 > вибрати Properties у контекс-
тному меню) і в діалоговому вікні Pin Properties (властивості штир-

ка), на вкладці General (загальні) ввести ім’я, наприклад, х1 та натиснути 
ОК; так само позначити всі інші входи і виходи; 

 
F Примітки: 
1) Таким самим чином можна скоригувати імена портів та інших 

компонентів, змінити їх ідентифікаційні номери (у лівому нижньому куту 
символу), а також ввести коментарі (клацнути інструментом введення тек-
сту у вільному місці). При цьому на вкладці Format можна вибрати колір 
тексту, а для коментарів – також параметри шрифту на вкладці Font. 

2) Фрагменти схеми легко розмножувати: виділити область, як зви-
чайно, прямокутником (протягнути стрілкою по діагоналі при натиснутій 
лівій кнопці), відтак за допомогою інструмента Copies або з меню Edit ско-
піювати і вставити в потрібне місце цього або іншого файлу та, у разі по-
треби, замінити елементи чи внести інші корективи. Копію потрібного 
фрагменту графічного файлу можна вставити в документ Microsoft Word 
безпосередньо або за допомогою клавіші Print Screen через графічний ре-
дактор Paint (в останньому випадку ілюстрацію можна скоригувати). 

и) дати ім’я файлу і зберегти його: піктограмою Save (або з 
меню File > Save) викликати діалогове вікно Save As, в якому підня-

ти прапорець Add file to current project (додати файл до поточного проекту) 
та натиснути кнопку збереження – файлу автоматично надається ім’я про-
екту з розширенням .bdf. 

Приклад: \quartus6.1work\2lab\200.bdf (схема 1). 
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2 Виконати компіляцію  проектованого пристрою: 
а) якщо це не зроблено, відкрити проект: піктограмою Open 

Project (або з меню File > Open Project) викликати діалогове вікно 
Open Project, вибрати в ньому потрібні директорію і ім’я проекту (із си-
ньою емблемою Quartus) та двічі клацнути ім’я або емблему – директорія з 
ім’ям проекту з’являться в рядку заголовка головного вікна Quartus II;   

б) переконатися, що графічний файл включено до проекту: 
піктограмою Settings (або з меню Project > Add/Remove Files in 

Project – додати файли до проекту чи вилучити з проекту) викликати діало-
гове вікно Settings (налаштування) і на сторінці Files, у разі потреби, виб-
рати потрібні файли кнопкою огляду (…), додати їх кнопкою Add, виділи-
ти і вилучити зайві кнопкою Remove та натиснути кнопку ОК; 

в) піктограмою Start Compilation (або з меню Processing > 
Start Compilation) запустити компілятор –  процес і час обробки про-

грамних модулів відображаються в лівому вікні стану та в рядку стану го-
ловного вікна, в правому вікні з’являється частинами звіт про компіляцію 
Compilation Report, а в нижньому – повідомлення з розділу цього звіту 
Analysis & Synthesis > Messages; по завершенні компіляції результати по-

даються в інформаційному віконці, яке слід зачинити натисненням ОК та 
значком закриття зачинити також ліве вікно стану (його можна будь-коли 
відчинити з меню View > Utility Windows > Status); 

F Примітки: 
1) По натисненні кнопки ОК у зазначеному інформаційному віконці 

ліве вікно стану зачинятиметься автоматично, якщо ввімкнути опцію Tools 
> Options > Processing > Automatically close the Status window when 
processing is complete (автоматично зачиняти вікно стану по завершенні 
обробки).  

2) Компіляція відбувається у фоновому режимі, що дозволяє під час 
її виконання працювати з іншими файлами. Проте обробка простих проек-
тів займає небагато часу, тому в нашому випадку немає сенсу переходити 
до інших файлів. 

г) у нижньому вікні повідомлень натиснути закладку Error і за на-
явності помилок виправити їх та знов виконати компіляцію; відтак натис-
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нути закладку Warning і за наявності застережень проаналізувати їх та, за-
лежно від наслідків, або проігнорувати застереження, або скоригувати 
проект (в останньому випадку знов виконати компіляцію) і зачинити ниж-
нє вікно повідомлень; 

F Примітки: 
1) Для локалізації місця помилки в проекті слід двічі клацнути від-

повідне повідомлення – відкриється файл, в якому виділиться це місце. 
2) Аналіз повідомлення про помилку або застереження полегшуєть-

ся за допомогою формалізованої довідки. Для її виклику слід клацнути 
відповідне повідомлення і натиснути клавішу F1 – з’явиться стандартне ві-
кно, в якому подаються розділи CAUSE (причина) та ACTION (дія, якщо 
вона потрібна для усунення цієї причини).      

ґ) ознайомитися в загальних рисах зі звітом про компіляцію 
Compilation Report. У розділі Flow Summary (резюме) ознайомитися 

з використаним ресурсом мікросхеми: макрокомірок (Total macrocells) і 
виводів (Total pins) та значком закриття в рядку меню зачинити вікно звіту 
(його можна будь-коли відчинити піктограмою Compilation Report або з 
меню Processing > Compilation Report).  

 
F Примітка. Для наочного відображення ресурсу у вигляді діаграм 

слід клацнути кнопкою В2 у полі розділу звіту Flow Summary і вибрати в 
контекстному меню Gauge Summary. Тепер, якщо клацнути кнопкою В2 
всередині відповідної діаграми, можна вибрати відображення у величині 
або відсотках. 

 

3 Виконати функціональне моделювання скомпільованого проекту. 
3.1 Створити файл часових діаграм сигналів 2ХХ.vwf:  

а) переконатися, що активізовано потрібний проект (інакше 
піктограмою відкриття проекту або з меню File ввести його дирек-

торію і ім’я до рядка заголовка головного вікна);  
б) піктограмою горизонтальної панелі New Vector Waveform 

File (або з меню File > New > сторінка Other Files > Vector Waveform 
File) відкрити новий файл часових діаграм – з’явиться вікно з безіменною 
назвою WaveformN.vwf (де N – номер); 
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в) дати ім’я файлу і зберегти його: клацнути піктограму збе-
реження, у діалоговому вікні Save As (зберегти як) підняти прапо-

рець Add file to current project (долучити файл до поточного проекту) і на-
тиснути кнопку збереження – у рядку заголовка файлу автоматично 
з’явиться ім’я проекту з розширенням, наприклад, 202.vwf; 

 
г) задати параметри часових діаграм згідно з таблицею відповідно-

сті (сітку моделювання доцільно вибрати кратною десяти, наприклад, Δt =      
= 20 ns, а весь інтервал моделювання – виходячи з кількості наборів вхід-
них змінних, наприклад, при чотирьох змінних Т = 24Δt = 16Δt = 320 ns): 
меню Edit > End Time > ввести 320 ns (прокруткою вибрати одиницю вимі-

рювання) > OK та меню Edit > Grid Size > Period 20 ns > OK, після 
чого піктограмою Fit in Window вписати все зображення у вікні – у 

порожньому файлі відобразиться весь інтервал з часовою сіткою. 
3.2 Ввести тестові вектори (на часових діаграмах позначити ко-

ординати сигналів), створені компілятором: 
а) піктограмою Node Finder (або з меню View > Utility Windows > 

Node Finder) викликати вікно засобу пошуку вузлів, тобто сигналів (ілюст-
рацію див. нижче); 

б) у віконці Filter (вибір типу сигналів) прокруткою встановити 
Pins: all (всі зовнішні виводи ІС) і натиснути кнопку List – у нижньому вік-
ні Nodes Found (знайдені вузли) відобразиться перелік вхідних і вихідних 
сигналів; 

в) у колонці Name виділити потрібні сигнали (клацнути по-
значки вузлів при натиснутій клавіші Shift для виділення всіх сиг-

налів або при натиснутій клавіші Ctrl для вибіркового виділення), взятися 
за будь-який вузол і перетягнути до колонки Name свого файлу, в якому 
після цього відобразяться діаграми сигналів (на входах нульові рівні, а на 
виходах невизначені стани); відтак зачинити вікно Node Finder (повторно 
натиснути піктограму Node Finder або позначку закриття у вікні).    
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 F Примітка: Розташування сигналів на часових діаграмах легко 

змінити: досить виділити рядок (клацнути його в полі заголовків і відпус-
тити кнопку миші), взятися за нього тa перетягнути (з’явиться прямокут-
ник біля покажчика) в потрібну позицію, яка висвічується кольоровою лі-
нією. 

3.3 Відредагувати часові діаграми вхідних сигналів за допомогою 
основних інструментів палітри: 

 
 

а) налаштувати інструментальну палітру редактора часових діаг-
рам (розташована вертикально ліворуч): меню Tools (інструментальні за-
соби) > Customize Waveform Editor (налаштувати редактор часових діаг-
рам) > на сторінці Toolbars (інструментальні панелі) встановити облямова-
ні кнопки великого розміру: зняти прапорець Borderless look (кнопки без 
облямівок), та підняти прапорці Show tooltips (показ типів інструментів) і  
Large buttons (великі кнопки) > на сторінці Commands вибрати категорію 
Waveform Editor, взятися за значок у полі Buttons і перетягнути його до 
відповідної позиції на палітрі та вилучити зайві кнопки перетягуванням їх 
із палітри до робочого поля файлу; відтак натиснути кнопку ОК у вікні 
Customize (налаштовану палітру з одного стовпця найуживаніших інстру-
ментів показано в горизонтальному вигляді на ілюстрації вверху); 



 30 

б) налаштувати опції редактора часових діаграм, для чого з меню 
Tools > Options розкрити сторінку Waveform Editor діалогового вікна оп-
цій, в якому ввімкнути прапорці таких опцій: 1) прив’язка до сітки – під 
час введення діаграми чітко розташовуються відносно координатної сітки і 

маркер часу під час переміщення зупиняється на лініях сітки (опцію слід 
вимкнути, якщо діаграми або маркер потрібно розташувати в довільних 
місцях – оперативно це можна зробити з меню View); 2) прив’язка до пе-
реходів (до стрибків на часових діаграмах) – дозволяє фіксувати між пере-
ходами часові інтервали під час їх виділення і фіксувати маркер на перехо-
дах;      3) продовжити часові діаграми, що утинаються кінцем часового ін-
тервалу, поза межами файлу – після розширення часового інтервалу (з ме-
ню Edit > End Time) діаграми буде автоматично продовжено; 4) з чого про-
довжити часові діаграми після розширення – залишити за умовчанням зна-
чення з попереднього часового інтервалу; 5) створювати новий файл часо-
вих діаграм за умовчанням з таких налаштувань: кінцевий час моделюван-
ня встановити, наприклад, 200 нс, крок сітки 20 нс, сітку починати з 0 нс, 
коефіцієнт заповнення сигналу 50% (тобто шпаруватість імпульсів дорів-
нює 2, що відповідає формі меандру); відтак натиснути кнопку ОК у вікні 
Options; 
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в) інструментом вибору виділити діаграму х1 (клацнути в по-
лі заголовків) і натиснути інструмент циклічного повторення рівнів; 
г) у діалоговому вікні значень параметрів Count Value, на сторінці ви-

бору часу Timing, в рядку Count every ввести крок сітки 20 ns (одиниці вимі-
рювання встановлюються прокруткою), залишити коефіцієнт множення Mul-
tiplied by 1 та натиснути кнопку ОК – у файлі заповниться діаграма х1; 

ґ) повторити п. в, г для всіх інших вхідних сигналів, збільшуючи 
кожний раз удвічі коефіцієнт множення Multiplied by та зберегти результа-
ти редагування. 

F Примітки: 
1) Ввести значення змінних, зокрема, нециклічних, можна також в 

інший спосіб. Для цього слід протягнути інструментом виділення інтерва-
лів або інструментом вибору над віссю змінної на одному кроці або кіль-
кох кроках часової сітки при натиснутій лівій кнопці – виділений інтервал 
заливається кольором. Відтак потрібне значення треба зафіксувати натис-
ненням відповідної кнопки значень палітри (під час протягування інстру-
ментом виділення рівень автоматично змінюється на протилежний). У та-
кий самий спосіб можна зінвертувати сигнал на потрібних ділянках часо-
вих діаграм. Для виправлення помилково введеного рівня слід так само ви-
ділити хибний інтервал і зафіксувати кнопкою потрібний рівень, напри-
клад, замінити лог. 1 на лог. 0. 

2) Командою з меню View > Snap to Grid (прив’язка до часової сітки) 
ділянки часових діаграм виділяються (отже і фіксуються на них рівні) на ін-
тервалах, кратних кроку часової сітки. Для введення значень на довільних ін-
тервалах незалежно від кроку сітки слід вимкнути зазначену команду. 

3) Крок сітки можна змінити (для зручності введення або перегля-
ду) у будь-який час, це не впливає на моделювання. Зображення сітки на 
екрані вмикається та вимикається опцією показу сітки з меню Tools > Op-
tions > Waveform Editor > View > Show time grid. 

3.4 Змоделювати часові діаграми вихідних сигналів: 
а) піктограмою Start Simulation (або з меню Processing > Start 

Simulation) запустити імітатор –  процес і час обробки програмних 
модулів відображаються в лівому вікні стану та в нижньому рядку 

стану головного вікна, в правому вікні з’являється частинами звіт про мо-
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делювання Simulation Report, а в нижньому вікні – повідомлення з розділу 
цього звіту Simulator > Messages; по завершенні компіляції результати по-
даються в інформаційному віконці, яке слід зачинити натисненням ОК та, 
у разі потреби (якщо не ввімкнено опцію згідно з приміткою 1 до п. 2,в), 
значком закриття зачинити також ліве вікно стану (його можна будь-коли 
відчинити з меню View > Utility Windows > Status);  

 
F Примітка: Моделювання відбувається у фоновому режимі, що 

дозволяє під час його виконання працювати з іншими файлами. Проте об-
робка простих проектів займає небагато часу, тому в нашому випадку не-
має сенсу переходити до інших файлів. 

б) у нижньому вікні повідомлень натиснути закладку Error і за на-
явності помилок виправити їх та знов виконати моделювання; відтак нати-
снути закладку Warning і за наявності застережень проаналізувати їх та, 
залежно від наслідків, або проігнорувати застереження, або скоригувати 
часові діаграми (в останньому випадку знов виконати моделювання) і за-
чинити нижнє вікно повідомлень; 

в) розташувати часові діаграми у звітному вікні Simulation 
Waveforms піктограмою Fit in Window (вписати у вікно) для зручно-

го їх перегляду (ознайомитися в загальних рисах з іншими розділами звіту 
про моделювання можна шляхом їх розгортання: клацнути по складнику, 
який з’явиться в правому вікні);  

г) за відкритого вікна Simulation Waveforms клацнути в цьо-
му вікні інструмент вибору інтервалу (або виділити у звітному фай-

лі окремі потрібні сигнали клацанням у полі типу контактів за натиснутої 
клавіші Ctrl, взятися за один з них і почати перетягувати на свій файл) – 
одразу ж з’явиться діалогове вікно його редагування; 

 
ґ) у цьому вікні ввімкнути перший перемикач (дати згоду перенести 

результати моделювання на свій векторний файл), натиснути ОК та дати 
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згоду на запит про внесення змін до файлу – на WVF-файлі заповняться ді-
аграми вихідних сигналів; 

F Примітка: Результати моделювання автоматично переносяться на 
файл часових діаграм проекту, якщо з меню Tools > Options > General > 
Processing на сторінці Proces-sing ввімкнути прапорець Overwrite simulation 
input file with simulation result > OK. Проте така операція не завжди є зруч-
на: втрачається можливість порівняння часових діаграм до і після внесення 
корекцій до проекту. 

д) зачинити вікно звітного файлу; відчинити його для пере-
гляду компонентів звіту можна в будь-який час піктограмою 

Simulation Report (або з меню Processing > Simulation Report).  
F Примітка: Вставити коментарі до файлу часових діаграм 

або відредагувати існуючий текст можна інструментом Text Tool: 
натиснути зазначений інструмент, підвести його до робочого поля і, коли 
покажчик набуде форми хреста з літерою А, клацнути ним діаграму. Від-
так клацнути утворену рамку і, коли вона виділиться темним, ввести до неї 
текст. Цим же інструментом стрілку і текст можна пересунути.  

 

4. Проаналізувати результати проектування пристрою в різних 
елементних базисах примітивів.  

4.1 Перевірити, чи узгоджується вихідна функція реалізованої схе-
ми  з таблицею відповідності на всіх наборах змінних, та вручну виміряти 
затримки поширення сигналів (див. Лаб. робота №1, п. 4.2).   

4.2 В автоматичному режимі визначити швидкодію спроектова-
ного пристрою: 

а) у разі потреби, послідовністю наведених піктограм 
відкрити аналізований проект (переконатися, що його дирек-

торію і назву відображено в рядку заголовка головного вікна) та задля на-
очності відкрити файл верхнього рівня проекту (у нашому випадку це є 
графічний файл); 

б) піктограмою Compilation Report (або з меню Processing > 
Compilation Report) відкрити вікно звіту про компіляцію і розгор-

танням складників звіту Timing Analyzer > tpd розчинити вкладку з часом 
затримки поширення сигналу між контактами мікросхеми tpd (Pin to Pin 
Delays) та ознайомитися із затримками сигналу від входів до виходів; 
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 F Примітка: П. 4.2,б можна виконати запуском часового аналізато-
ра піктограмою Timing Analyzer Tool (або з меню Processing > Timing 
Analyzer Tool), в однойменному вікні перейти на сторінку tpd та, у разі по-
треби, натиснути кнопку Start.  

в) зберегти таблицю результатів часового аналізу в текстовому 
файлі: клацнути правою кнопкою миші будь-де в полі таблиці звіту (або з 
меню File > Save Current Report Section As) і викликати діалогове вікно 
Save Current Report Section As, в якому вибрати тип файлу Timing Analysis 
Output File (.tao) та натиснути кнопку збереження;  

г) продивитися зазначений файл: натиснути піктограму відкриття 
файлу, прокруткою встановити тип файлів Output Files, вибрати зі списку 
потрібний файл та натиснути кнопку відкриття.     

Приклад: quartus6.1work\2lab\200.bdf (схема 1), 200.wvf, 200 
tpd (Pin to Pin Delays).tao.  
4.3 Доповнити той самий графічний файл схемами згідно із домаш-

нім завданням, п. ґ (див. приклад: проект quartus6.1work\2lab\200), скомпі-
лювати та виконати функціональне моделювання, доповнивши часові діаг-
рами вихідними сигналами нових схем, переконатися в правильності    
проектування. 
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3 ЛАБОРАТОРНА РОБОТА №3. ПЕРЕТВОРЮВАЧІ КОДІВ 
 
Мета роботи: дослідження типових перетворювачів коду –  двійко-

вих дешифраторів, дешифраторів 7-сегментного коду, шифраторів, перетво-
рювачів між двійковим кодом і ДДК; побудова ЦКП на дешифраторах; засво-
єння основ створення проекту на макрофункціях та настроювання макрофун-
кцій; засвоєння методики розведення виводів ВІС на друкованій платі, її фі-
зичного програмування та дослідження запрограмованого пристрою. 

 
ДОМАШНЄ ЗАВДАННЯ 

! Для заданого варіанту (див. Додатки, завдання 3): а) спроектува-
ти спеціальний перетворювач двійкового коду до коду семисегментного 
індикатора для відображення заданих знаків на дешифраторах різної роз-
рядності і вибрати оптимальний варіант;  б) розробити схему передачі да-
них заданої розрядності на основі шифратора і дешифратора. 

 

СТИСЛІ ТЕОРЕТИЧНІ ВІДОМОСТІ 
Перетворювачі кодів (ПК) є ЦКП, що здійснюють перетворення  

цифрової інформації з однієї форми зображення до іншої. Прикладом є 
стандартні ІС перетворювачів двійкового коду в ДДК та, навпаки, ДДК у 
двійковий. Окремим випадком ПК є пристрої, для яких вхідним або вихід-
ним є так званий унітарний код “1 із К”, в якому активний рівень може іс-
нувати тільки в одному розряді. Якщо активним є  рівень лог. 1, то код на-
зивають прямим, а якщо лог. 0 – інверсним. Прикладом є унітарний десят-
ковий код “1 з 10” відображення натиснутої цифрової клавіші, якщо нати-
снення більш однієї клавіші заборонено. Якщо ж активний рівень може іс-
нувати в кількох розрядах, код “Х із К” називають пріоритетним, в якому 
старшим за пріоритетом за умовчанням є розряд з більшим номером. Уні-
тарні коди використовуються в перетворювачах, які називаються дешиф-
раторами і шифраторами. Дешифратори 7-сегментного коду, дешифратори 
і шифратори, а також елементи бібліотеки САПР розглянуто в [2], основні 
типи ЦПК наведено в табл. 3.1. 

 
1 Перетворювачі між двійковим кодом і ДДК 
Молодший розряд у двійкового коду і ДДК (див. [1]) збігається, то-

му мікросхеми виконують без його врахування і, отже, таблиці відповідно-
сті мають однаковий вигляд для парних і непарних вхідних слів: 0 і 1, 2 і 3, 
4 і 5 і т. д. У типовій ІС перетворювача двійкового коду в ДДК (рис. 3.1,а) 
із шестирозрядного вхідного двійкового коду на виходах утворюються мо-
лодша тетрада ДДК у3 ... у0 і неповна старша тетрада у6 ... у4.  

З метою збільшення розрядності вдаються до каскадування ІС. Так, 
з’єднанням трьох стандартних ІС утворюється перетворювач 8 розрядів 
двійкового коду в ДДК (на рис. 3.1,б наведено його символ, на принципову 
схему можна вийти з файлу 3libr.bdf), а для перетворення 16-розрядного 
двійкового коду в ДДК потрібно вже 16 таких ІС. 
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Таблиця 3.1 – Основні ЦКП 

 

 
Рисунок 3.1 – Типові ІС 
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Зворотне перетворення від ДДК до двійкового коду здійснюється 
аналогічно. У типовій ІС перетворювача ДДК у двійковий код (рис. 3.1,в) 
із двох тетрад ДДК (молодшої тетради х3 ... х0 і неповної старшої х5х4) на 
виходах утворюється семирозрядний двійковий код. Два старші розряди на 
виходах обох ІС використовуються для перетворення до доповняльних ко-
дів (приклад подано у файлі 3libr.bdf). Докладніше схеми перетворювачів 
до доповняльних кодів і каскадування різної розрядності наводяться в но-
рмативних документах і довідковій літературі на ІС. 

 
2 Проектування ЦКП на дешифраторах 
Вихідні функції повного дешифратора являють собою набір усіх 

можливих мінтермів, тому сполученням виходів дешифратора можна реа-
лізувати будь-яку логічну функцію від його вхідних змінних. На ПЛІС та-
кий прийом використовувати доцільно, якщо він спрощує проектування, а 
на ІС жорсткої структури застосовувати дешифратори для реалізації прос-
тих функцій немає сенсу, крім випадку, коли один з них залишається в ко-
рпусі ІС невикористаним. Застосовування дешифраторів може виявитися 
доцільним для побудови ЦКП з кількома виходами, якщо функція по кож-
ному з них зображається відносно простим сполученням вихідних функцій 
дешифратора. При цьому оптимальність рішення з’ясовується шляхом по-
рівняння варіантів схеми на дешифраторах різної розрядності. 

Приклад. Методику проектування ЦКП на основі дешифратора роз-
глянемо на прикладі побудови перетворювача коду для відображення 
трьох знаків (Z) латиниці. За кількістю потрібних адрес визначаємо розря-
дність стандартного дешифратора 2:4 і складаємо таблицю відповідності 
(рис. 3.2,а), в якій зайва адреса  і = 3 відповідає факультативним значенням 
вихідних функцій перетворювача a…g. Відтак виражаємо ці функції через 
вихідні функції дешифратора: 

,1;;; 201001101 ========== feyaagcyaadbyaaa  

і згідно з виразами 1;;;; 0201 ======= feydygcybya  будуємо схему 
(рис. 3.2,б). 

Якщо сегменти 7-сегментного індикатора ввімкнено за схемою зі 
спільним анодом (на рис. 3.2,в зображено еквівалентну схему, наприклад, 
сегменту а), вони засвічуватимуться рівнем лог. 0, тому вихідні функції 
перетворювача a…g мають бути інверсними відносно наведених у таблиці 
на рис. 3.2,а, тобто .0;;;; 0201 ======= feydygcybya  

Перевагою використання дешифратора з кількістю адресних входів, 
що дорівнює кількості змінних m, є відносна простота вихідних функцій, а 
недоліком – складність такого дешифратора і, головним чином, обмеже-
ність кількості входів, адже при m > 3...4 вже необхідне каскадування де-
шифраторів на ІС жорсткої структури. З огляду на це може виявитися до-
цільним варіант побудови схеми на дешифраторі меншої розрядності.  
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Рисунок 3.2 – Проектування ЦКП на дешифраторі 

 
КОНТРОЛЬНІ ЗАПИТАННЯ 

1. Як слід каскадувати дешифратори з метою збільшення розрядності? 
2. Як зв’язані між собою кількість входів і виходів у повних шифра-

торі та дешифраторі? 
3. Запишіть вирази для вихідних логічних функцій 1) шифратора 8 x 

3, 2) дешифратора 3 x 8, 3) стробованого дешифратора 3 x 8 та побудуйте 
їх схеми. 

4. Спроектуйте на дешифраторах перетворювач коду, варіант якого 
задано числом у табл. 3.2, де в лівій колонці наведено вхідний код, а у верх-
ньому рядку - вихідний. Наприклад, варіанту 8 відповідає перетворювач коду 
8421 → 8421доп. У табл. 2 подано: ДДК 8421, 8421доп, 8421+3, 2421, 7421, ХҐ 
- цифри 0...9 чотирирозрядного коду Ґрея, а також коди для відображення на 
семисегментному індикаторі знаків: Z1 - цифр 0...9, Z2 - літер латиниці A, b, 
C, d, E, F, H, U, O та Z3 - літер кирилиці А, Г, Е, Н, О, П, Р, С, У. 

 
Таблиця 3.2 
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ЛАБОРАТОРНЕ ЗАВДАННЯ 
 
1 Ознайомитися з основними типами перетворювачів коду.  
1.1 За принциповими електричними схемами на логічних елементах  

(файл 3prim.bdf) та осцилограмами сигналів (3prim.vwf) розглянути прин-
цип побудови стробованого дешифратора та шифратора: скласти таб-
лиці відповідності і рівняння вихідних функцій, виміряти затримку вихід-
них імпульсів, навести умовне графічне позначення за ДСТУ та пояснити 
принцип дії таких ЦКП.  

1.2 Ознайомитися зі стандартними дешифраторами, шифрато-
рами та перетворювачами коду серії 74 (макрофункціями): 1) повними 
дешифраторами 2:4, 3:8, 4:16 (перетворювачами двійкового, вісімкового і 
шістнадцяткового коду в унітарний) – файл 3lіbr.bdf, рис.1; 2) неповними 
дешифраторами 4:10 (перетворювачами кодів ДДК, Ґрея та з надлишком 3 
в десятковий унітарний) – рис. 3.2; 3) дешифраторами (перетворювачами 
до) 7-сег-ментного коду – рис. 3.3; 4) пріоритетними шифраторами 8:3 і 
10:4 (перетворювачами унітарного коду у вісімковий і ДДК) – рис. 3.4; 5) 
перетворювачами коду: двійкового до ДДК і ДДК до двійкового та їх за-
стосуванням і каскадуванням (клацнути символ Bin8_BCD правою кноп-
кою > Open Design File). У звіті навести, принаймні, по одній макрофункції 
з кожної категорії і пояснити призначення та особливості входів і виходів. 

F Примітка: Для виклику бібліотечного файлу з принциповою схе-
мою макрофункції слід клацнути її символ правою кнопкою миші і вибра-
ти Open Design File. Інші довідкові дані з таблицею відповідності включно 
є приступні з програмного пакету MAX+PLUS II. 

2 Застосувати дешифратор для реалізації ЦКП за графічного 
опису проекту на прикладі створення заданого варіанту спеціального пе-
ретворювача до 7-сегментного коду. 

2.1 У проекті 3ХХ зібрати на логічних елементах схему дешифра-
тора, потрібного для реалізації перетворювача, виконати компіляцію і фу-
нкціональне моделювання (див. л. р. № 2, п. 2, 3).  

Приклад: неповний дешифратор 2:3, файли 300.bdf, .vwf. 
F Примітка: Аби спростити збирання дешифратора, можна корис-

туватися як шаблонами копіями принципових електричних схем з доступ-
них файлів, серед них принципових електричних схем макрофункцій. 

2.2 Створити символьний файл шляхом згортання схеми дешиф-
ратора до символу:  

а) відкрити файл, який треба згорнути до символу, в меню File вибра-
ти Create / Update > Create Symbol File for Current File (створити символьний 
файл для поточного файлу), натиснути ОК у повідомленні про створення та-
кого файлу; відтак відкрити його піктограмою відкриття файлу і вибором у 
діалоговому вікні типу файлів Graphic Files або Other Source Files (інші фай-
ли) та порівняти цей символ з принциповою електричною схемою; 

Приклад: 300.bsf. 



 40 

б) налаштувати ін-
струментальну палітру 
символьного редактора 
(розташована вертикально 
ліворуч): меню Tools (ін-
струментальні засоби) > 

Customize Symbol Editor (налаштувати символьний редактор) > на сторінці 
Toolbars (інструментальні панелі) встановити облямовані кнопки великого 
розміру: зняти прапорець Borderless look (кнопки без облямівок), та підня-
ти прапорці Show tooltips (показ типів інструментів) і  Large buttons (великі 
кнопки) > на сторінці Commands вибрати категорію Symbol Editor, взятися 
за значок у полі Buttons і перетягнути його до відповідної позиції на паліт-
рі та вилучити зайві кнопки перетягуванням їх із палітри до робочого поля 
файлу; відтак натиснути кнопку ОК у вікні Customize (нижче показано в 
горизонтальному вигляді налаштовану палітру з одного стовпця найужи-
ваніших інструментів, аналогічних інструментам графічного редактора).  

 
F Примітки: 
1) Символ можна відредагувати графічно, користуючись інструмен-

тами палітри: а) задля компактності змінити його розмір (підвести курсор 
до вузлів зовнішнього прямокутника або клацнути сторону для виділення 
внутрішнього прямокутника і підвести курсор до його вузлів та, коли кур-
сор набуде форми подвійної стрілки, протягнути його в потрібному напря-
мку); б) змінити позиції написів і виводів (клацнути елемент і перетягнути 
його до потрібного місця); в) інструментами Text Tool або ліній різного 
типу вставити написи чи інші графічні позначення і інструментом 
Properties відредагувати шрифт, колір, тип ліній, тло (див. малюнок до 
п. 2.2,а). 

2) Зінвертувати порти можна аналогічно п. 2.3,в.      
2.3 Створити графічний проект на макрофункції дешифратора 

для реалізації заданого варіанту перетворювача до 7-сегментного коду: 
а) дати ім’я новому проекту 3ХХ_7seg (ХХ – варіант) з дире-

кторією власної теки, наприклад, \RT\3br\302_7seg;  
б) створити графічний файл 3ХХ_7seg.bdf аналогічно Л. 

р. № 2, п. 1.2, для чого з бібліотеки дібрати потрібну ІС серії 74 
(див. Л. р. № 3, п. 1.2) і вставити її розгортанням \quartus\libraries\others\ 
maxplus2\74N (де N – тип ІС, наприклад, 74139о);   

в) виділити символ вставленої макрофункції і піктограмою 
Properties (або двічі клацнути символ, або В2 > Properties) виклика-

ти діалогове вікно Symbol Properties (властивості символу) та налашту-
вати  її: на вкладці Ports (порти) виділити в списку існуючих портів 
(Existing ports) вивід, якій треба відредагувати, наприклад, А2 і у верхньо-
му віконці Status вибрати Unused (невикористовуваний); так само можна 
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змінити інверсію на вході або виході: перемикач Inversion залишити в по-
ложенні None, якщо інверсія не змінюється або в положенні All, якщо змі-
нюється на протилежну (Pattern використовується для шин); таким чином 
слід налаштувати всі виводи та натиснути ОК (для прикладу на ілюстрації 
вгорі  наведено настроєну макрофункцію 74139); 

F Примітка: Налаштувати параметри вікна графічного редактора 
можна з меню Tools > Options (див. л. р. №2, п. 1.2,в).  

г) доповнити схему іншими потрібними елементами, виконати ком-
піляцію і функціональне моделювання та перевірити правильність функці-
онування пристрою за часовими діаграмами.  

 
Приклад:  файли 300_7seg.bdf (схема 1), .vwf.  
2.5 Засвоїти використання символу в графічному редакторі: зі-

брати схему перетворювача до 7-сегментного коду в тому самому графіч-
ному файлі, користуючись створеним символом дешифратора (вставляєть-
ся до графічного файлу, як звичайно, але зі списку Project > ім’я символу 
діалогового вікна Symbol), виконати компіляцію і функціональне моделю-
вання та перевірити правильність функціонування пристрою за часовими 
діаграмами.  

Приклад:  файли 300_7seg.bdf (схема 2), .vwf. 
 
3 Створити лабораторний макет для експериментального до-

слідження заданого варіанту перетворювачів коду (див. структурну 
схему і рис. Д1 у додатках – файл 300PERETWOR_KODU.bdf).  
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Від ДІП-перемикачів MAX_SW1, SW2 код типу Х із К (активні рівні 

сигналу можуть діяти одночасно в кількох розрядах) надходить на входи 
пріоритетного шифратора, на виходах якого формується двійковий код, що 
відображає адресу (номер) старшого за пріоритетом ключа, а також сигнал 
запиту GSN, який набуває активного рівня за ввімкнення хоча б одного 
ключа (цей сигнал формується або самим шифратором, або поза ним додат-
ковою логікою). Згорнутий з більшої до меншої кількості розрядів код (для 
передачі інформації шиною зв’язку між віддаленими блоками) розгортаєть-
ся на виходах шини в дешифраторі до унітарного коду 1 із К, отже, старший 
за пріоритетом ключ індикується одним зі світлодіодів D1 … D10. Одночас-
но для індикації в цифровому вигляді адреси привілейованого запиту його 
код через дешифратор 7-сегмнтного коду подається на старше (десятки) 
знакомісце 7-сегмнтного індикатора MAX_DIGIT. Сигнал запиту індикуєть-
ся світлодіодом D16, а за відсутності запиту гасяться цей світлодіод і розряд 
цифрового індикатора по входу BIN дешифратора 7-сегмент-ного коду. До-
датково ключами перемикача MAX_SW2 досліджується цей дешифратор по 
входу перевірки світіння сегментів LTN, по входу RBIN і виходу RBON 
(світлодіод D15) послідовного гасіння старших нулів багаторозрядного ін-
дикатора, а також керування світінням десяткової крапки dpd. 

Спроектований ЦКП на основі дешифратора (у прикладі спеціаль-
ний дешифратор 7-сегментного коду для відображення заданих шістнадця-
ткових цифр) досліджується за допомогою ключів 6 ... 8 (у прикладі ключі 
7, 8) перемикача MAX_SW2 і молодшого (одиниці) знакомісця 7-сегмент-
ного індикатора MAX_DIGIT.   

3.1 Дати ім’я новому проекту згідно із заданим варіантом і викона-
ти призначення мікросхеми для  його реалізації.  

а) На першій сторінці діалогового вікна New Project Wizard 
ввести, як звичайно, директорію власної теки і ім’я нового проекту 

3XXPERETWOR_KODU (ХХ – варіант) та натиснути кнопку Next.  
б) У повідомленні, що ця директорія вже містить проект, на пропо-

зицію змінити її дати негативну відповідь. 
в) На другій сторінці кнопкою огляду (…) у діалоговому вікні Select 

File вибрати директорію і ім’я раніше створеного (п. 2.1) файлу дешифра-
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тора 3ХХ.bdf, подвійним клацанням (або натисненням кнопки збереження) 
внести його до рядка File name вікна New Project Wizard і кнопкою Add  
включити до складу проекту – файл буде додано до списку у вікні File 
name. Відтак натиснути кнопку Next. 

г) На третій сторінці (ілюстрацію див. нижче) вибрати: у рядку 
Family – родину ІС, розміщену на платі,  МАХ7000S (залишити ввімкне-
ним перемикач Specific device selected in 'Available devices' list – вибрати 
мікросхему зі списку приступних мікросхем); у розділі Show in 'Available 
devices' list – такі параметри (прокруткою): Package (тип корпусу) PLCC, 
Pin count (кількість виводів) 84, Speed grade (градація швидкодії) Any (до-
вільна); у списку Available devises (приступні ІС) – тип мікросхеми на пла-
ті EPM7128SL84-7 (клацнути рядок) і натиснути кнопку Next. 

 
ґ) Четверту сторінку проминути і натиснути кнопку Next, а на 

п’ятій, останній сторінці продивитися підсумки і натиснути кнопку Finish 
– ім’я нового проекту з’явиться в рядку головного вікна. 

F Примітка: Виконати призначення мікросхеми для реалізації 
проекту можна будь-коли, для чого піктограмою Settings (або з меню 

Assignments > Settings) викликати діалогове вікно Settings, в якому на вкладці 
Category вибрати розділ Device і заповнити цю ж саму сторінку, що і в п. 
3.1,г. Якщо вибір мікросхеми скориговано після компіляції, потрібно переко-
мпілювати проект (якщо не виконувати призначення мікросхеми взагалі, 
компілятором буде призначено за умовчанням довільну мікросхему). 

3.2 Виконати проектування в графічному редакторі. 
а) Створити графічний файл верхнього рівня, дібрати і вставити до 

нього потрібні макрофункції пріоритетного шифратора, дешифратора і 
дешифратора 7-сегмнтного коду та налаштувати їх щодо розрядності і ін-
вертування входів/виходів. Вставити потрібні порти, дати їм імена та ви-
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конати з’єднання компонентів схеми. 
б) Доповнити схему спроектованим за п. 2.5 спеціальним дешифра-

тором 7-сегментного коду для відображення заданих шістнадцяткових 
цифр (скопіювати його з файлу 3ХХ_7seg.bdf, схема 2 та перейменувати 
порти). 

F Примітка: На всі незадіяні сегменти обох знакомісць індикатора і 
незадіяні світлодіоди необхідно подати лог. 1 (VCC) для їх погашення. 

в) Виконати компіляцію і функціональне моделювання проекту.  
Приклад: 300PERETWOR_KODU.bdf, .vwf. 
3.3 Засвоїти використання редактора призначень Assignment 

Editor з метою з’єднання виводів мікросхеми із зовнішніми колами згідно з 
таблицями розведення на друкованій платі (див. файл 
../3lab/ROZWED_MAX). 

1) Якщо це не зроблено, відкрити потрібний проект та, 
задля наочності, файл його верхнього рівня. 

2) Піктограмою Assignment Editor (або з меню Assignments > 
Assignment Editor) викликати діалогове вікно редактора призначень, 

з меню Tools > Customize Assignment Editor > на сторінці Toolbars встано-
вити облямовані кнопки великого розміру (зняти прапорець Borderless look 
та підняти прапорці Show tooltips і Large buttons) > на сторінці Commands 
вибрати категорію Assignment Editor та ознайомитися з основними інстру-
ментами його палітри (у разі потреби, зайві інструменти можна вилучити 
звичайним чином). Палітру стовпця інструментів показано в горизонталь-
ному вигляді на ілюстрації.  

 
3) Інструментом Category Bar (або з меню View > Category 

Bar) ввімкнути розділ Category і вибрати в ньому категорію призна-
чень виводів Pin (прокруткою або розгортанням розділу).  

4) У разі необхідності, інструментом показу імен виводів 
(або з меню View > Show All Known Pin Names) розгорнути список 

портів електронної таблиці. 
5) Покажчиком (який набуває форми хреста) двічі клацнути в комі-

рці електронної таблиці на перетині рядка з потрібним портом та стовпця 
Location (місцеположення) і надрукувати тільки цифри з номером виводу 
мікросхеми (або клацнути цей номер зі списку, що розгортається) – у комі-

рці позначиться номер 
виводу та у стовпці 
General Function – його 
загальна функція І/О (вхід 
/ вихід). Таким чином ви-
конати призначення для 

всіх портів згідно з файлом ../3lab/ROZWED_MAX. 
7) Зберегти файл редактора призначень – таблиці з’єднань відобра-



 45 

зяться біля портів графічного файлу. Відтак повторно виконати компіля-
цію (у термінах САПР – перекомпілювати проект).  

F Примітки: 
1) Таким самим чином можна відредагувати помилки: виділити 

комірку і ввести новий номер. Для редагування імені порту достатньо двічі 
клацнути комірку у стовпці То і надрукувати нове ім’я або вибрати зі спи-
ску, що розгортається. 

 
2) Виконати з’єднання виводів мікросхеми із зовнішніми колами 

можна і в інший спосіб: піктограмою Settings (або з меню Assignments > 
Settings) викликати діалогове вікно Settings, в якому на вкладці Category 
вибрати розділ Assign Pins (призначити виводи) – з’явиться однойменне 
діалогове вікно. У розділі Available Pins & Existing Assignments (приступні 
виводи та існуючі призначення) прокруткою слід вибрати номер виводу 
(стовпець Nu…), клацнути його рядок для виділення, а в розділі Assign-
ment (призначення) до рядка Pin name ввести назву цього виводу та натис-
нути кнопку Add (додати) – у виділеному рядку попереднього розділу до-
дасться це ім’я у стовпці Name. Повторенням цих дій призначити всі виво-
ди та натиснути кнопку ОК. 

3) Таблиці з’єднань можна розташувати в позиціях, зручних для на-
очного відображення зв’язків, звичайним чином: взятися лівою кнопкою 
миші за таблицю і перетягнути її або виділити таблицю і пересунути з кла-
віатури клавішами зі стрілками керування курсором.     
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4) Таблиці з’єднань біля символів портів можна відобразити 
або приховати інструментом панелі Show Location Assignments (або 

з меню View > Show Location Assignments).  
Приклад: 300PERETWOR_KODU.bdf. 
3.4 Сформувати файл програматора. 

а) Відкрити, якщо це не зроблено, належний для реалі-
зації скомпільований проект та (задля наочності) файл верши-

ни ієрархії. 
б) Піктограмою Programmer (або з меню Tools > Programmer) 

відкрити вікно програматора для визначення схеми фізичного про-
грамування – з’явиться файл з розширенням .cdf (Chain Description File – 
файл опису ланцюжка, тобто схеми програмування).   

 
в) У рядку Mode  вибрати стандарт JTAG схеми програмування. 
г) Якщо у верхньому рядку не встановлено апаратний засіб Byte-

Blaster ІІ (зазначено No Hardware або іншій засіб), натиснути кнопку Hard-
ware Setup (установка апаратного засобу) і в однойменному вікні (ілюстра-
цію див. нижче), на сторінці Hardware Settings переконатися, що встанов-
лено конфігураційний пристрій ByteBlaster (якщо на сторінці Hardware 
Settings буде відсутній рядок з пристроєм ByteBlaster, слід вставити його 
кнопкою Add Hardware: в однойменному вікні прокруткою вибрати тип 
пристрою і порту та натиснути кнопку ОК). Відтак у розділі Available 
hardware items  (приступні апаратні засоби) виділити рядок з пристроєм 
ByteBlaster, натиснути кнопку Select Hardware (вибрати апаратний засіб) 
та зачинити   вікно Hardware Setup – у верхньому рядку вікна програма-
тора з невеликою  затримкою в часі встановиться апаратний засіб і в дуж-
ках порт комп’ютера: ByteBlaster ІІ [LPT1].  
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F Примітка: Попередньо інсталювати в комп’ютері, якщо це не 
зроблено, програмний драйвер принтера.    

ґ) У вікні програматора ввімкнути (клацнути прямокутники) функ-
цій Program/Configure, Verify і Blanc-Check (функція Examine є приступ-
ною за використання спеціальних конфігураційних мікросхем), залишити 
вимкненою функцію Security Bit, записати код користувача Usercode та 
зберегти файл.   

3.5 Виконати фізичне програмування мікросхеми. 
а) Переконатися, що на платі UP2 чотири штирьові триконтактні 

перемикачі (джампери) TDI, TDO, DEVICE, BOARD встановлено в режим 
програмування однієї мікросхеми – всі джампери з’єднують два верхні ко-
нтакти С1 і С2 (як на ілюстрації у файлі ../3lab/ROZWED_MAX), інакше 
перемкнути їх.   

б) З’єднати апаратним конфігураційним пристроєм ByteBlaster ІІ 
рознімач JTAG_IN на платі UP2 з портом LPT1 (портом для з’єднання з 
принтером)  персонального комп’ютера.  

в) З’єднати спочатку кабелем DC_IN плату UP2 з джерелом жив-
лення і лише після цього ввімкнути джерело в мережу 220 В. Наявність зо-
внішньої напруги індикується на платі зеленим світлодіодом POWER. 

г) У вікні програматора натиснути кнопку Start. Миготінням світло-
діода ТСК на платі і в рядку Progress CDF-файлу індикується передача да-
них під час програмування, а світінням світлодіода CONF_D – завершення 
цього процесу. 

ґ) Натиснути кнопку ОК у вікні з повідомленням про успішне про-
грамування.  

3.6 Дослідити пристрій на запрограмованій ІС. 
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4 ЛАБОРАТОРНА РОБОТА №4. ЦИФРОВІ КОМУТАТОРИ 
 

Мета роботи: дослідження типових мультиплексорів і демульти-
плексорів, проектування ЦКП на мультиплексорах; групи й шини; мегафу-
нкції, основи їх настроювання, менеджер автоматичного створення різно-
видів мегафункцій, запровадження мегафункцій до графічного файла та за-
стосування їх для побудови цифрових пристроїв; дослідження запрограмо-
ваного пристрою.  

 

ДОМАШНЄ ЗАВДАННЯ 
! Для заданого варіанту (див. Додатки, завдання 4): а) спроектува-

ти ЦКП для реалізації логічної функції на мультиплексорах різної розряд-
ності та вибрати оптимальний варіант; б) розробити схему для досліджен-
ня цифрових комутаторів.   

 

СТИСЛІ ТЕОРЕТИЧНІ ВІДОМОСТІ 
Цифрові комутатори, що здійснюють перемикання сигналів з одно-

го каналу в декілька (демультиплексори) або, навпаки, з кількох каналів в 
один (мультиплексори), розглянуто в [2], де наведено також необхідні для 
розуміння САПР відомості про елементи арифметики, групи й шини та ме-
гафункції (табл. 4.1, 4.2).  

 

Проектування ЦКП на мультиплексорах  
Вихідна функція мультиплексора 

являє собою ДДНФ логічної функції від 
змінних аі, якщо dj є її значення на відпові-
дних наборах (мінтермах) цих змінних. 
Отже, з’єднанням з адресними входами 
мультиплексора змінних, а з інформацій-
ними входами – констант згідно з табли-
цею відповідності можна реалізувати 
будь-яку логічну функцію.  

Утворений пристрій стає, таким 
чином, універсальним логічним модулем 
(УЛМ). УЛМ чотирьох змінних для при-
кладу наведено на рис. 4.1. На адресні 
(селекторні – SEL) входи мультиплексо-
ра 16:1 подаються чотири змінні, тому на 
виході OUT з’являється рівень, що від-
повідає значенням змінних, які діють у 
цей час. Наприклад, коли х4х3х2х1 = 0101, 
тобто і = 5, цим адресним кодом до вихо-

ду підмикається п’ятий вхід, що відповідає значенню у = 1.  
На програмованих ВІС такий прийом використовувати доцільно, 

якщо він спрощує проектування, а на ІС жорсткої структури застосовувати 
мультиплексор для реалізації окремої функції може виявитися доцільним, 
якщо при цьому зменшується складність за критерієм потрібної кількості 

Рисунок 4.1 – УЛМ чотирьох 
змінних 
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корпусів ІС. З метою зменшення складності бажано застосовувати мульти-
плексори щонайменшої розрядності, якщо це надмірно не ускладнює схе-
му на інформаційних входах, а оптимальність рішення з’ясовується шля-
хом порівняння варіантів схеми на мультиплексорах різної розрядності. 

Методику проектування ЦКП на мультиплексорах меншої розряднос-
ті розглянемо на прикладі логічної функції чотирьох змінних (див. рис. 4.1,а).  

1) За діаграмою термів у на рис. 4.2,а мінімізуємо функцію 
4314221 xxxxxxxy ++=  

і визначаємо ступінь її залежності від аргументів: змінні x1, x2, x4 входять 
до виразу у двічі та х3 – один раз. 

2) Вибирає-
мо мультиплексор з 
кількістю адресних 
входів k на одиницю 
менше кількості 
змінних (у прикладі 
k=m–1=3, тобто му-
льтиплексор 8:1). 
До адресних входів 
приєднуємо змінні, 
від яких функція за-
лежить більшою мі-
рою, тобто формує-
мо адресний код j (у 
прикладі j = a2a1a0 =     
= x4x2x1) і розбиває-
мо діаграму функції 
y на 2k піддіаграм. 
Для цього у кожну 
клітинку діаграми j 

(на рис. 4.2,а нижня діаграма) вписуємо десятковий код j = x4x2x1 відповідно 
до рисок цих змінних, не звертаючи уваги на аргумент x2, що не входить до 
адреси. Отже, діаграма виявляється розбитою на 8 піддіаграм (з двох кліти-
нок кожна), які і визначають номери j інформаційних входів мультиплексора, 
що з'єднуються з виходом y. 

3) Визначаємо сигнали dj(х3) на входах мультиплексора як функції 
вільної змінної, не приєднаної до адресних входів. Для цього зміст кліти-
нок часткових діаграм з номерами j зчитуємо з діаграми у: d0=d2=d3=d7= 0, 
d1=d4=d5=1, d6= 3х . 

4) Згідно з функціями dj будуємо ЦКП (рис. 4.2,б). Легко перекона-
тися, що пристрій функціонує відповідно до діаграми термів. Наприклад, 
коли х4х2х1 = 0101, тобто і = 5 маємо у2 = d5 =1. Отже, схема виявляється 
вдвічі простішою відносно рис. 4.1,б – потрібен лише один додатковий ін-
вертор на вході d6. 

Рисунок 4.2 – Методика проектування ЦКП на муль-
типлексорі 
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5) Аналогічно проектуємо ЦКП на мультиплексорі 4:1 меншої роз-
рядності – з двома адресними і чотирма інформаційними входами. До ад-
ресних входів приєднуємо дві змінні, від яких функція залежить більшою 
мірою (у прикладі один з трьох рівноцінних за цим критерієм варіантів), 
тобто формуємо адресний код j = a1a0 = x2x1 і розбиваємо діаграму функції 
y на чотири піддіаграми (рис. 4.3,а). Розглядаючи кожну з піддіаграм як ді-
аграму термів функції двох змінних dj(x3, x4) і мінімізуючи звичайним чи-
ном, визначаємо сигнали: d1 = 1, d3 = 0, d0 = х4, d2 = 43 хх . Шляхом порів-
няння з іншими двома варіантами адресного коду вибираємо перший (рис. 
4.3,б) і, порівнюючи його з ЦПП на рис. 4.2,б, вважаємо кращим, бо він 
потребує простішого мультиплексора без надмірного ускладнення кіл для 
формування вхідних сигналів (потрібно по одному елементу НЕ та І). 

 

 
Рисунок 4.3 – Проектування ЦКП на мультиплексорі 4:1 

 

І, нарешті, так само проектуємо ЦКП на мультиплексорі 2:1 
(рис. 4.4,а), вибираючи варіант адресного входу j = a = x1: 

432021 ; xxxdxd ==  (рис. 4.4,б). З порівняння можна дійти висновку, що 
остання реалізація ЦКП потребує менше ресурсу ІС, ніж попередні. 

 

 
Рисунок 4.4 – Проектування ЦКП на мультиплексорі 2:1 

 

Слід відзначити, що якщо в логічному виразі функції можна винести 
за дужки спільний аргумент хi, то ЦКП спрощується наданням стробовому 
входові значення G = хi при використанні мультиплексора-селектора зі зви-
чайним (без третього стану) виходом. Крім того, якщо логічні функції на 
окремих інформаційних входах мультиплексора виявляються досить склад-
ними, то їх у свою чергу також можна реалізувати на мультиплексорах. По-
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будова ЦКП з кількома виходами зводиться до проектування кількох при-
строїв для кожної функції окремо. Якщо з цією метою скористатися ІС му-
льтиплексорів зі спільними адресними входами, цим входам доцільно нада-
ти ті змінні, які найбільшу кількість разів входять до обох функцій. 

 

Таблиця 4.1 – Мегафункції логічних елементів 
Символ Основні параметри 

enabledt  enabletr Напрямок передачі 
  
Двоспрямовані буфери 

 

0 
0 
1 
1 

0 
1 
0 
1 

tridata[]=Z; result[]=Z  
tridata[] à  result[] 

data[] à  tridata[]  
data[] à  tridata[], 
data[] à  result[]   

Інвертори 

 

lpm_bustri (Buffer), lpm_inv (NOT Gate): 
LPM_WIDTH – розрядність шин і кіль-
кість елементів у кожній з них (буферів з 
трьома станами або інверторів). 

Логічні елементи 

 

lpm_or, lpm_and, lpm_xor: 
LPM_WIDTH – кількість елементів маси-
ву, вхідних шин і розрядність вихідної 
шини; 
LPM_SIZE - кількість входів кожного 
елемента, тобто розрядність вхідних шин. 
Приклад: LPM_SIZE = 2, LPM_WIDTH =3,  
data[LPM_SIZE-1..0][LPM_WIDTH-1..0] = 
=data[1..0][2..0], result[LPM_WIDTH-1..0]= 
result[2..0]. 

 
Таблиця 4.2 – Мегафункції комбінаційних пристроїв 

Символ Основні параметри 
Дешифратор 

   

lpm_decode (Decoder): 
LPM_WIDTH – розрядність двійко-
вого вхідного коду; 
LPM_DECODES – розрядність уні-
тарного вихідного коду; 
для повного дешифратора: 
LPM_DECODES=2^ LPM_WIDTH. 
Приклад: LPM_ WIDTH = 3, деши-
фратор 3:8, data[LPM_WIDTH-1..0] 
= data [2..0], eq[LPM_DECODES-
1..0] = eq[7..0]. 
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Продовження таблиці 4.2 

Мультиплексори 

 

lpm_mux (Multiplexer): 
LPM_WIDTHS – розрядність адре-
сної шини sel[];  
LPM_SIZE ≤ 2^ LPM_WIDTHS – 
кількість вхідних шин і розрядність 
вихідної шини result[];   
LPM_WIDTH – розрядність кожної 
вхідної шини. 
Приклад: LPM_WIDTHS = 3, 
LPM_WIDTH = 4,  LPM_SIZE = 8, 
мультиплексор 8:1,  
sel[LPM_WIDTHS-1..0] = sel[2..0], 
data[LPM_SIZE-1..0][LPM_WIDTH-
1..0]= = data[7..0][3..0], 
result[LPM_WIDTH-1..0] = 
result[3..0]. 

Окремі випадки: 
mux – перемикач ліній, 
busmux – перемикач двох шин.  

 
КОНТРОЛЬНІ ЗАПИТАННЯ 

1. Як слід каскадувати мультиплексори і демультиплексори з метою 
збільшення розрядності?  

2. Як зв’язані між собою кількість адресних і інформаційних входів 
у  мультиплексорі і демультиплексорі? 

3. Запишіть вираз для вихідної логічної функції мультиплексора 8:1 
та побудуйте його схему. 

4. Спроектуйте на мультиплексорах: 1) ЦКП для реалізації логічної 
функції, що задана варіантом завдання 2; 2) шифратор 4:2; 3) пріоритетний 
шифратор 4:2. 
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ЛАБОРАТОРНЕ ЗАВДАННЯ 
 
1 Дослідити типові комутатори цифрових сигналів.  
1.1 За принциповою електричною схемою та осцилограмами сигна-

лів (4prim.bdf, .vwf) мультиплексора і демультиплексора  на логічних 
елементах скласти таблицю відповідності і рівняння вихідних функцій, 
виміряти затримку вихідних імпульсів. У звіті навести схеми, умовні гра-
фічні позначення за ДСТУ, таблиці відповідності, рівняння вихідних фун-
кцій, часові діаграми, затримки, стислі пояснення принципу дії таких ЦКП.   

1.2 Ознайомитися з макрофункціями стандартних мультиплексорів 
серії 74, у тому числі з трьома станами виходу (файл 4lіbr_macro.bdf,        
рис. 4.1...4.4), а також дешифраторів, які можуть виконувати функції де-
мультиплексорів (файл 3lіbr.bdf, рис. 1). У звіті навести символи з різних 
груп, пояснити призначення та особливості входів і виходів. 

1.3 Ознайомитися з дібраними елементами бібліотеки мегафункцій 
(файл 4libr_mega.bdf): 1) буфер, 2) логічні функції, 3) дешифратор, 4) му-
льтиплексори та пояснювальними прикладами 1...10. Розглянути викону-
вані функції в довідці: Help > Megafunctions/LPM > вибрати категорію та 
ім’я мегафункції; дати тлумачення сенсу кожної з чотирьох груп мегафун-
кцій і їх параметрів. У звіті навести принаймні по одному символу з кож-
ної групи, пояснити призначення та особливості входів і виходів та дати 
стисле тлумачення основних параметрів. 

2 Застосувати макрофункції мультиплексорів для реалізації за-
даного варіанту (ХХ=01, 02, …) логічної функції y.  

У графічному файлі проекту 4ХХgr_macro дібрати макрофункції, 
потрібні для реалізації логічної функції на мультиплексорах різної розряд-
ності, настроїти їх, доповнити схеми іншими елементами, виконати компі-
ляцію і функціональне моделювання, переконатися в правильності проек-
тування та вибрати оптимальний варіант схеми на ІС жорсткої логіки.  

Приклад: 400gr_macro.bdf (схеми 1...4), .vwf. 
F Примітки: 

1) У випадку розгалужених шин треба вводити їх імена, 
а також імена з’єднаних з ними ліній: інструментом вибору ви-

ділити лінію, натиснути інструмент Properties (властивості) і в діалоговому 
вікні Node Properties (властивості вузла) ввести текст і натиснути ОК (або 
ввести його у вільному місці і перетягнути інструментом стрілка в потріб-
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ну позицію). При цьому назви розгалужених шин (ліній) мають збігатися з 
назвами з’єднуваних ними вузлів (входів, виходів), інакше узгоджуємо 
імена за допомогою буферів Wire, які ресурсу не потребують, бо реально 
не існують. Приклад: на другій схемі сигнал х3 перейменовано в d6 для уз-
годження його імені в шинах x[] і d[]. 

2) Відмінність застосування груп полягає в тому, що масиви примі-
тивів вводимо у вигляді одного елемента, ім’я якого позначається діапазо-
ном групи, а з’єднувальні шини зображаємо грубими лініями (тип лінії ви-
бирається з лівої палітри інструментів). Приклад: чотири порти x[4..1] при-
єднано до чотирьох дротів однойменної шини. Як видно з VWF-файла, пі-
сля компіляції група набуває скороченої назви х, яка розгортається на ком-
поненти x[4], x[3], x[2], x[1]. 

3) На відміну 
від з’єднувальних 
провідників і шин, 
довільну лінію мо-
жна відредагувати, 
якщо виділити її і 
викликати діалогове 
вікно Line Proper-
ties, в якому вибра-
ти колір та стиль 
рисок і ліній та на-
тиснути ОК. 

4) Компіля-
цію і моделювання доцільно виконувати кроками: спочатку змоделювати 
схему 1, відтак доповнити її схемою 2 і повторити моделювання. 

5) У VWF-файлі дані 
зручно вводити у вигляді групи: 
виділити ділянку часового ін-
тервалу інструментом вибору 
або редагування часових діаг-
рам, натиснути інструмент 
Arbitrary Value (або з меню Edit 
> Value > Arbitrary Value), в од-
нойменному  діалоговому віко-

нці вибрати систему числення (Radix), ввести число (Numeric …) у вибра-
ній системі числення та натиснути кнопку ОК – значення відобразиться на 
цій ділянці часової діаграми групи. Якщо в розділі Time range (часовий ін-
тервал) змінити час початку (Start time) та/або кінця (End time) інтервалу, 
можна змінити також ділянку введення даних.  

3 Засвоїти основи автоматичного створення різновидів мегафу-
нкцій за допомогою майстра MegaWizard Plug-In Manager на прикладі 
синтезу мультиплексора найбільшої  розрядності N, необхідного для реалі-
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зації заданого варіанту функції (задля наочності і порівняння див. файл 
400gr_macro.bdf, схема 1).  

3.1 З меню Tools > MegaWizard Plug-In Manager запустити май-
стра створення різновидів мегафункцій і відповісти на запитання в на-

ступних діалогових вікнах. 
3.2 На сторінці 1 

(page 1) вибрати дію, яку 
треба виконати – створи-
ти (Create …) новий різ-
новид мегафункції, реда-
гувати (Edit …) або ко-
піювати (Copy …) існу-
ючий різновид > Next. 

3.3 На сторінці 2а 
ліворуч зі списку при-

ступних мегафункцій вибрати (натиснути +) категорію (Gates) і функцію 
(LPM_MUX), а праворуч – родину мікросхем (MAX7000S), тип мови для 
створюваного файла (AHDL) і до рядка What name … ввести ім’я файла 
4XXmuxN, але якщо директорія не відповідає потрібній, треба її змінити: 
натиснути кнопку Browse (огляд) і в діалоговому вікні Select file name про-
круткою по черзі встановити потрібні папки, ввести ім’я файла і зберегти 
(у рядку What name … відобразиться директорія з ім’ям). Для продовження 
натиснути кнопку Next. 

 
3.4 На сторінці 3 (ілюстрацію див. нижче) у рядку How many 'data' 

inputs ...? ввести прокруткою або з клавіатури кількість інформаційних 
входів даних (до 256 входів, у прикладі – 16), у рядку How wide should 
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'data' input and 'result' output buses be? –  ширину в бітах кожного з них і ви-
ходу (залишити 1, але для перемикача шин ввести потрібну їх ширину, до 
256 біт кожна). Відтак натиснути вгорі кнопку 3 – Summary (підсумкова 
сторінка), продивитися на сторінці 5 список автоматично створених фай-
лів, серед них файли: текстовий (.tdf) включення (.inc) і символьний (.bsf) 
та вийти з програмного модулю майстра кнопкою Finish.   

 
3.5 Продивитися утворені файли нового різновиду мегафункції із 

заданими конкретними параметрами, зокрема, з категорії Other Source Files 
(інші файли) 4XXmuxN.inc, .bsf (тут N – кількість інформаційних входів).  

Приклад: файли 400mux16.inc, .bsf. 
F Примітки:  
1) Скоригувати введені дані можна будь-коли поверненням на по-

передні сторінки кнопкою Back. 
2) З метою відредагувати існуючий різновид мегафункції так само 

відповідаємо на запитання: на сторінці 2b вибираємо тип файла і імена 
файла та мегафункції, а також, у разі потреби, директорію. Відтак на сто-
рінці 3 коригуємо параметри і завершуємо редагування кнопкою Finish.  

3) Різновид мегафункції можна створити не тільки автоматично, але 
й ручним способом як подано в необов’язкових п. 4.4, 4.5 роботи.  

3.6 Відредагувати символьний файл для зручності користуватися 
ним у графічних проектах виконанням наступних дій. 

а) Створити новий графічний файл 4XXmN.bdf, 
ввести до нього символ створеного різновиду мегафункції 

(зі списку Project діалогового вікна Symbol), вхідні і вихідний порти та 
згрупувати вхідні сигнали в шину. 

б) Командою з меню File > Create / Update > Create Symbol Files for 
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Current File створити символ мегафункції, в якому виводи зображено ком-
пактно, у вигляді шин та відкрити його для перегляду. 

Приклад: файли 400m16.bdf, .bsf. 
 
4 Засвоїти основи настроювання мегафункцій і застосування їх 

у графічному редакторі (на прикладі варіантів п. 2).  
4.1 Реалізувати заданий варіант логічної функції на мультиплексорі 

найбільшої розрядності N (як приклад див. файл 400gr_mega.bdf, схема 1). 
а) Створити новий проект 4XXgr_mega і однойменний графічний 

файл (.bdf), до якого вставити символ 4ХХmN.sym відредагованого різно-
виду мегафункції майстра MegaWizard Plug-In Manager (зі списку Project 
діалогового вікна Symbol). 

б) Настроїти символ: виділити його і піктограмою Properties 
(або В2 по символу > Properties) викликати діалогове вікно Symbol 

Properties (властивості символу) та призначити порти на сторінці Ports так 
само, як і для макрофункцій. Відмінність полягає в тому, що тепер для ін-
вертування окремих розрядів шин застосовуємо числа в одній із систем 
числення (натиснути Pattern у розділі Inversion та ввести до віконця код ін-
вертування). Користуючись, наприклад, еквівалентною схемою 1 на 
кшталт 400rys.bdf, з’ясовуємо, що всі інформаційні входи IN[15..0] муль-
типлексора з метою спрощення можна заземлити, якщо зінвертувати ті з 
них, на які слід подати лог. 1. У вікні редагування бітам, що інвертуються, 
надається значення 1, а тім, що залишаються неінвертованими, – значення 
0, тому код інвертування становитиме у цьому  прикладі d[15..0] =                 
=  В”0011 0111 0010 0010” = Н”3722”, який і вводимо до віконця Pattern в 
одній з чотирьох систем числення, основу якої вибираємо прокруткою. По 
зачиненні (ОК) діалогового вікна результати редагування (див. накладений 
символ) відобразяться бульбашкою інверсії з кодом інвертування (на сим-
волі код подається завжди в шістнадцятковій системі числення).  
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в) Увести інші елементи схеми, потрібні для реалізації заданої фун-
кції, дати імена портам, а також провідникам і шинам у випадку їх розга-
луження та зберегти файл. 

г) Долучити до проекту потрібні складники: піктограмою 
Settings (або з меню Project > Add/Remove Files in Project, або з ме-

ню Assignments > Settings) викликати діалогове вікно Settings (налашту-
вання), вибрати Files зі списку Category,  кнопкою огляду (…) вставити  до 
рядка File name графічний файл проекту 4ХХgr_mega.bdf, текстовий файл 
400muxN.tdf різновиду мегафункції, створений майстром MegaWizard 
Plug-In Manager, та відредагований файл мегафункції 4XXmN.bdf, кноп-
кою Add додати ці файли до списку File name (у разі потреби, виділити у 
списку зайві файли і вилучити їх кнопкою Remove) та натиснути кнопку 
ОК у вікні Settings. 

 
ґ) виконати компіляцію та функціональне моделювання з метою пе-

реконатися в правильності проектування. 
Приклад:  400gr_mega.bdf (схема 1), .vwf. 
4.2 У тому ж графічному файлі виконати п. 4.1 на мультиплексорах 

меншої розрядності.  
Приклад:  400gr_mega.bdf (схеми 2, 3), .vwf. 
F Примітки: 
1) У графічному файлі з’єднувати можна шини тільки однакового 

розміру: наприклад, на схемі 1 чотири порти з’єднано з чотирма адресними 
входами чотирирозрядною шиною. У випадку нерозгалужених шин їх мо-
жна не йменувати, бо за угодою розряди з’єднуються за старшинством, 
отже й номери розрядів не обов’я-зково мають бути однаковими: а3 = х4, 
а2 = х3, а1 = х2, а0 = х1. 

2) У п. 4.2 достатньо виконати один-два варіанти схеми на мульти-
плексорах різної розрядності; п. 4.4, 4.5 є факультативні, не обов’язкові. 

4.3 У тому ж графічному файлі виконати п. 4.1 на мультиплексо-
рі найменшої розрядності (2:1), користуючись його символом, створеним 
безпосередньо менеджером MegaWizard Plug-In Manager (без згортання 
входів у шину за п. 3.6). Для цього подвійним клацанням у файлі (або ін-
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струментом палітри Symbol Tool) викликати діалогове вікно Symbol, нати-
снути в ньому кнопку MegaWizard Plug-In Manager, виконати п. 3.2 … 3.4, 
натиснути кнопку ОК у вікні Symbol та вставити символ мегафункції.  

Приклад: 400gr_mega.bdf (схема 4), .vwf. 
4.4 У тому ж графічному файлі виконати завдання п. 2.1 на мега-

функції мультиплексора mux за ручного її настроювання (достатньо один 
варіант мультиплексора). 

а) Вставити символ мегафункції до файла звичайним чином з 
бібліотеки мегафункцій \quartus\libraries\megafunctions\gates\mux, 

виділити символ і піктограмою (або В2 > Properties) викликати діалогове 
вікно Symbol Properties, в якому для мегафункції приступними є сторінки 
Ports і Parameters. 

 
б) На сторінці Parameters прокруткою вибираємо параметр у рядку 

Name розділу Parameter, вводимо його значення в рядку Setting (прокрут-
кою або з клавіатури) і фіксуємо в графі Value кнопкою Change (кнопкою 
Delete можна очистити значення, а відтак знов його ввести); повторюючи 
цю процедуру, призначаємо всі параметри, приступні в рядку Name (ре-
зультат показано на вкладеному до вікна символі). Порти призначаємо на 
сторінці Ports так само, як і в п. 4.1,б. 

в) Увести інші елементи схеми (за необхідністю, розщепити шини і 
перейменувати порти), виконати компіляцію та функціональне моделю-
вання, переконатися в правильності проектування.    

Приклад. Для реалізації заданої логічної функції на мультиплексорі 
8:1 вставляємо до файла мегафункцію mux (див. файл 400gr_mega.bdf, 
схема 5) і настроюємо її параметри як описано у п. 4.4,б.  

Відтак редагуємо порти в закладці Ports (див. 400rys.bdf, схема 2): 
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вихід result і адресні входи sel[WIDTHS-1..0] залишаємо незмінними (Used 
– використовується, None – без інверсії), а розряди інформаційної шини 
data[WIDTH-1..0]  інвертуємо введенням Pattern > 72 Hex (або код в іншій 
системі числення).  

По закритті діалогового вікна на символі мегафункції відобразяться 
результати редагування. Інші елементи схеми вводимо як у звичайному 
графічному файлі. Аби схема не потребувала надлишкового ресурсу (7 
зайвих виводів pin і кілька комірок логічної матриці, адже немає сенсу де-
які виводи ззовні закорочувати на землю), шину даних da[7..0] з метою 
зменшення на 7 вхідних портів розщеплюємо: лінію da6 відокремлюємо у 
вхідний   порт, а інші її лінії з’єднуємо із землею. Крім того, імена ліній і 
шин узгоджуємо з назвами портів і виводів.  

По компіляції та функціональному моделюванню (файл 400gr_me-
ga.vwf)  переконуємося в правильності проектування: функція y2а узго-
джується з таблицею відповідності. 

F Примітки: 
1) В узагальнених назвах параметра, наприклад, data[WIDTH-1..0] 

або sel[WIDTHS-1..0] цифри 1..0 означають не його величину, а те, що діа-
пазон зазначається стандартно – від старшого розряду до молодшого, на-
приклад, da[7..0], add[2..0] (за суміщення кількох схем в одному файлі ши-
нам кожної схеми слід надавати різні імена).  

2) У мультиплексорах ширина адресної шини WIDTHS за умовчан-
ням становить CEIL(LOG2(WIDTH)), де CEIL (ceiling – стеля) означає 
найближче ціле число, що не менше виразу в дужках, наприклад, 
CEIL(LOG2(7)) = 3, CEIL(LOG2(9)) = 4.  

3) На символі мегафункції параметри позначаються табли-
цею за ввімкненого інструмента палітри Show Parameter 

Assignments (або командою з меню View > Show Parameter Assignments). 
Цю таблицю можна перетягнути у зручну позицію лівою кнопкою миші 
або (після виділення) клавішами зі стрілками керування курсором.  

4.5 У тому ж графічному файлі виконати завдання п. 2.1 на мега-
функції мультиплексора lpm_mux за ручного її настроювання (достатньо 
один варіант мультиплексора) аналогічно п. 4.4. 

Приклад:  400gr_mega.bdf (схема 6), .vwf. 
 

5 Створити проект лабораторного макету для експерименталь-
ного дослідження заданого варіанту цифрових комутаторів (див. нижче 
структурну схему і файл 400KOMUTATORY.bdf на рис. Д2 у додатках).  

Від ДІП-перемикачів MAX_SW1 вхідне слово sw1[] у паралельному 
коді  надходить на інформаційні входи мультиплексора. Формувач адреси 
(лічильник) розгортає адресний код a[] в часі таким чином, що після кож-
ного натискання по черзі двох нефіксованих перемикачів MAX_PB1 і 
MAX_PB2 цей код збільшується на одиницю по колу: 0, 1, ... 7, 0, 1, ..., 
тобто змінюється в прикладі за модулем 8. Отже, у мультиплексорі відбу-
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вається перетворення паралельного коду в послідовний, бо на його виході 
по черзі з’являються біти вхідного слова (для передачі інформації лінією 
зв’язку між віддаленими об’єктами).  

 
З інформаційного входу демультиплексора (який є стробовим вхо-

дом дешифратора) на вихідному боці лінії тим же самим адресним кодом 
біти вхідного слова по черзі спрямовуються до його виходів, що індику-
ється одним зі світлодіодів D1 … D8. Якщо ці біти по черзі записати в роз-
ряди пристрою з пам’яттю (регістра), то послідовний код перетвориться 
знов у паралельний і на виходах можна буде зчитати вхідне слово sw1[] у 
паралельному коді.  

Одночасно для індикації в десятковій системі числення адреси її 
двійковий код через дешифратор 7-сегментного коду подається на старше 
(десятки) знакомісце 7-сегментного індикатора MAX_DIGIT (якщо модуль 
адреси перевищує 10, її код потрібно перетворити у двійково-десятковий і 
індикувати кількома знакомісцями – за кількістю тетрад ДДК).  

Спроектований ЦКП на основі мультиплексора (у прикладі – при-
стрій для реалізації заданої логічної функції) досліджується за допомогою 
ключів 1 ... 4 перемикача MAX_SW2 і світлодіода D9. Вхідний кортеж (на-
бір змінних) відображається шістнадцятковим цифрами (специфічними для 
стандартного дешифратора 7-сегментного коду) за допомогою молодшого 
(одиниці) знакомісця 7-сегментного індикатора MAX_DIGIT. 

Для ілюстрації принципу динамічної індикації введено пристрій ке-
рування, що складається з трьох вузлів. Восьмий ключ ДІП-перемикача 
MAX_SW2 керує адресним входом sel мультиплексорів шин 1 ... 3. При   
sel = 0 мультиплексор 1 з’єднує входи дешифратора 7-сегментного коду з 
адресним кодом a[], який перетворюється в 7-сегментний код на виходах 
y[] і з’єднується мультиплексором 2 зі старшим знакомісцем індикатора. 
При цьому всі сегменти молодшого знакомісця з’єднуються мультиплек-
сором 3 з напругою живлення VCC, отже, цей розряд індикатора гасне. 
Адресою sel = 1, навпаки, мультиплексор 1 з’єднує входи дешифратора 
7-сегментного коду з вхідним кортежем sw2[], який перетворюється в 
7-сегментний код шістнадцяткової цифри на виходах y[] і з’єднується му-
льтиплексором 3 з молодшим знакомісцем індикатора. Тепер всі сегменти 
старшого знакомісця з’єднуються мультиплексором 2 з напругою живлен-
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ня VCC, отже, цей розряд індикатора гасне. Якщо індикатор багаторозряд-
ний, слід застосувати мультиплексор шин типу LPM_MUX і адресу фор-
мувати аналогічно як у нашій лінії передачі даних. Таким чином, у системі 
з динамічною індикацією потрібен лише один дешифратор 7-сегментного 
коду і шляхом сканування адресним кодом кожної миті ввімкнено лише 
одне знакомісце, а інші погашені, що значно заощаджує ресурс мікросхеми 
і споживану потужність. За швидкої зміни адресного коду перемикання 
знакомісць непомітно для ока – здається, що одночасно світяться всі роз-
ряди індикатора.  

У практичних системах з динамічною індикацією з однією шиною 
y[] з’єднують паралельно індикатори всіх знакомісць (при цьому не потрі-
бно застосовувати вихідні мультиплексори шин на кшталт наших вузлів 2, 
3), а перемикання знакомісць здійснюють дешифратором, який по черзі 
з’єднує розряди індикатора із джерелом живлення. 

5.1 Створити проект перетворювачів коду в графічному редакто-
рі згідно із заданим варіантом.  

а) Створити новий проект 4XXKOMUTATORY (ХХ – варіант) з ди-
ректорією власної теки на мікросхемі 7000S (див. Лаб. роботу №3, п. 3.1). 

б) Створити однойменний графічний файл верхнього рівня, створи-
ти різновиди мегафункцій мультиплексора і демультиплексора за допомо-
гою менеджера MegaWizard Plug-In Manager, відредагувати їх символи 
(згрупувати сигнали в шини) та вставити до файла верхнього рівня. 

в) Вставити до файла верхнього рівня і настроїти мегафункції муль-
типлексорів шин і макрофункцію мультиплексора дешифратора 7-
сегментного коду. 

г) Вставити символ формувача адреси (подвійним клацанням у полі 
файлу викликати діалогове вікно Symbol, у рядку Name натиснути кнопку 
огляду і вставити символ ..\quartus6.1work\9lab\9addr).  

ґ) Вставити також допоміжні елементи і потрібні порти та виконати 
з’єднання компонентів схеми. 

д) Доповнити схему спроектованим на основі мультиплексора варі-
антом ЦКП для реалізації логічної функції (скопіювати його з файлу 
4ХХgr_macro.bdf або 4ХХgr_mega.bdf). 

е) Дати назви портам і з’єднувальним лініям у випадку розгалуження 
шин. Імена вхідних і вихідних портів, що з’єднують виводи мікросхеми з 
компонентами плати UP2, взяти точно такими, як у файлі ../4lab/MAX_pin. 
Якщо шинами sw1[], sw2[] приєднуються до мікросхеми не всі перемикачі, 
їх кількість зазначити в діапазоні групи, наприклад, sw2[4..1], а якщо деякі 
перемикачі відокремлено від групи (їх номери не ідуть поспіль з іншими 
номерами перемикачів), їх назви слід позначити двоцифровими номерами, 
наприклад, замість імені sw2[8] слід зазначити sw28.  

Приклад: 400KOMUTATORY.bdf. 
є) Перевірити склад проекту (див. п. 4.1,г) і, у разі потреби, 

долучити до нього потрібні складники (файл верхнього рівня 
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4ХХKOMUTATORY.bdf, різновиди мегафункцій мультиплексора і де-
мультиплексора, створені за допомогою менеджера MegaWizard Plug-In 
Manager та відредаговані їх символи, а також формувач адреси – файли з  
п. 5.1,а,б,г) та вилучити зайві.   

5.2 Імпортувати призначення виводів мікросхеми з іншого фай-
лу, де виконано розведення їх на друкованій платі (файл 
../4lab/MAX_pin.bdf). 

а) З меню Assignments > Import Assignments викликати однойменне 
діалогове вікно, в якому в рядку File name кнопкою огляду (…) у вікні 
Select File вибрати файл ../4lab/MAX_pin.qsf (Quartus II Settings File). Двічі 
клацнути його ім’я (або виділити і натиснути кнопку збереження) – дирек-
торія з ім’ям файлу з’явиться в рядку File name вікна Import Assignments. 
Відтак натиснути кнопку ОК.  

 
F Примітка: Категорії і додаткові налаштування параметрів імпор-

ту призначень (кнопки Categories та Advanced) можна залишити такими, 
що встановлені за умовчанням. Проте під час опрацювання складніших 
проектів ці налаштування можна змінити: за відкритого вікна Assignment 
Categories або Advanced Import Settings натиснути клавішу F1, ознайомити-
ся в довідці з функціями призначень та вибрати потрібні. 

б) Скоригувати імпортовані призначення виводів відпо-
відно до портів проекту. Для цього піктограмою Assignment 

Editor (або з меню Assignments > Assignment Editor) відкрити файл 
редактора призначень (до компіляції порти буде репрезентовано зі 

знаком запитання), залишити в ньому категорію All, натиснути кнопку ре-
дагування Edit Bar інструментальної палітри та вилучити зайві виводи і 
скоригувати імена існуючих портів. Наприклад, у файлі зразка 
400KOMUTATORY.bdf вилучаємо зайвий вивід Clock (потрібно клацнути 
будь-де в його рядку електронної таблиці покажчиком у формі хреста і на-
тиснути інструмент палітри Delete) і так само виводи sw2[5] … sw2[7] (де-
кілька виводів виділяються, як звичайно, за натиснутої клавіші Shift). Для 
виправлення імені порту слід клацнути його ім’я, яке з’явиться в рядку 
Edit, та внести корективи в цьому рядку з клавіатури звичайним чином, 
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наприклад, виправити sw2[8] на sw28 – з рядка Edit корекція одразу пере-
носиться до таблиці. На завершення слід зберегти зміни у файлі As-
signment Editor. 

F Примітка: Якщо клацнути комірку електронної таблиці і 
натиснути кнопку Information Bar інструментальної палітри, то в 

розділі Information з’явиться інформація щодо елемента таблиці або реко-
мендації, в який спосіб виконувати певні дії. 

5.3 Виконати компіляцію проекту – імпортовані призначення 
з’являться у формі таблиць біля портів. У разі потреби, як звичайно, усу-
нути помилки та опрацювати застереження.            

Приклад: проект 400KOMUTATORY. 
F Примітка: Призначення біля портів позначаються табли-

цями за ввімкненого інструменту палітри Show Location Assignments 
(або командою з меню View > Show Location Assignments). Цю таблицю 
можна перетягнути до зручної позиції лівою кнопкою миші або (після ви-
ділення) клавішами зі стрілками керування курсором.   

5.4 Виконати функціональне моделювання, переконатися в прави-
льності проектування.  

Приклад: 400KOMUTATORY.bdf, .vwf. 
5.5 Сформувати файл програматора (див. Лаб. роботу №3, п. 3.5). 
Приклад: 400KOMUTATORY.сdf. 
5.6 Виконати фізичне програмування мікросхеми (див. Лаб. робо-

ту №3, п. 3.6). 
5.7 Дослідити пристрій на запрограмованій ІС. 
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5 ЛАБОРАТОРНА РОБОТА №5. 
СТВОРЕННЯ ТЕКСТОВИХ ПРОЕКТІВ 

 
Мета роботи: основи створення проекту за його текстового вве-

дення, запровадження до текстового файлу макрофункцій, символів та ме-
гафункцій; дослідження запрограмованого пристрою.  

 
ДОМАШНЄ ЗАВДАННЯ 

! Для заданого варіанту (див. Додатки, завдання 5): а) записати 
апаратною мовою AHDL логічну функцію завдання 2; б) для наочності 
підготувати графічні файли – аналоги текстових файлів.   

 
СТИСЛІ ТЕОРЕТИЧНІ ВІДОМОСТІ 

1 Основи проектування в текстовому редакторі 
1.1 Основні складники проекту 
Мови опису апаратних засобів HDL (Hardware Description Language) 

типу Verilog HDL та VHDL є універсальними для різних повноциклових 
САПР. Програмні пакети MAX+PLUS II і Quartus II підтримують також 
мову високого рівня AHDL (Altera Hardware Description Language), присто-
совану для мікросхем фірми Altera (тут розглядатимемо проектування на 
основі цієї мови). Пристрій, створений у текстовому редакторі, можна зго-
рнути до символу і ввести до графічного файлу. З іншого боку, графічні 
об’єкти, наприклад, макрофункції і мегафункції можна як готові модулі 
вводити до текстових файлів. Текстовий опис, вислідом якого є проектний 
файл з розширенням .tdf (Text Design File), містить розгалужену систему 
засобів, таких як логічні рівняння, таблиці відповідності та інші оператори. 

Структурно проект (Design) складається із секцій (Section), опера-
торів або підсекції (Statement); секція змінних (Variable Section) і логічна 
секція (Logic Section), у свою чергу, складаються з окремих операторів. З 
понад  трьох десятків таких складників розглядатимемо лише біля полови-
ни, які можна вважати основними. У рекомендованій структурі проекту 
вони розташовуються в такій послідовності.   
Title Statement 
Include Statement 
Function Prototype Statement 
Subdesign Section 
Variable Section 

Instance Declaration 
Node Declaration 
Register Declaration 

State Machine Declaration 

Logic Section 
Boolean Equations 
Case Statement 
If Then Statement 

Truth Table Statement 

Обов’язковими для кожного TDF-файлу є секція підпроекту (Sub-
design Section) і логічна секція (Logic Section), а застосування інших склад-
ників визначається, здебільшого, типом використовуваної елементної бази 
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та вибраними засобами проектування. Кожний такий структурний блок має 
суворо відповідати правилам свого синтаксису. Аби пришвидшити скла-
дання текстового файлу (TDF-файлу) і, головним чином, уникнути чи зме-
ншити кількість синтаксичних помилок, введення здійснюється за допомо-
гою шаблонів (Template) для певної мови, зокрема, мови AHDL (AHDL-
Template). У шаблоні позначено комірки для введення тексту і, що є важ-
ливим, містяться необхідні за синтаксисом розділові знаки. Помилки вияв-
ляються під час компіляції і локалізуються процесором повідомлень 
(Message Processor).  

Наведемо тут лише короткий опис основних проектних блоків (опе-
ратори Register Declaration та State Machine Declaration подаються під час 
вивчення послідовнісних пристроїв), а докладно питання процедури вве-
дення і синтаксису з конкретними прикладами розглядаються безпосеред-
ньо в лабораторному завданні. 

1.2 Заголовок (Title Statement) 
Необов’язковий оператор заголовка є зручний для документування. 

Він використовується також компілятором у коментарях файлу повідом-
лення (.rpt – від Report). Оператор може застосовуватися у файлі лише 
один раз і має бути приміщений поза іншими секціями. 

1.3 Оператор включення (Include Statement) 
Структурні компоненти, для яких існує файл включення (з розширен-

ням .inc), зокрема, мегафункції зручно запроваджувати до проекту за допо-
могою оператора включення. Оператор містить лише назву файлу включен-
ня, яка надається об’єкту під час його створення або існує в бібліотеці ком-
плекту. Для стандартних мегафункцій файл включення компілятор сам виби-
рає з бібліотеки, достатньо лише вказати її назву і доповнити розширення 
.inc. Для різновидів мегафункцій менеджер автоматично створює одночасно 
сам різновид у текстовому файлі (.tdf) і файл включення (.inc). 

Синтаксис оператора не дозволяє вказувати директорію компонен-
та, тому якщо його різновид створено менеджером в іншій теці, файл 
включення слід перенести до проекту. Оператор має бути приміщений поза 
інших секцій, може вводитися до файлу довільну кількість разів і не може 
бути вкладеним. 

1.4 Оператор прототипу функцій (Function Prototype Statement) 
До графічного файлу можна вставляти не тільки елементи, але й гото-

ві структурні компоненти, наприклад, макрофункції, які є в бібліотеці про-
грами, або блоки, створені користувачем в інших файлах і згорнуті до симво-
лу. Для цього використовуються символи цих модулів з позначеними імена-
ми входів і виходів. У текстовому файлі роль символу відіграє прототип фун-
кції у вигляді її назви і тими ж самими іменами входів і виходів. Слід заува-
жити, що оператор прототипу функцій має розташовуватися у файлі поза се-
кцією підпроекту, але перед секцією, в якій ці функції використовуються. 

1.5 Секція підпроекту (Subdesign Section) 
Секція призначена для оголошення вхідних та вихідних  портів і 
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тому є обов’язковою. Вона містить назву проекту, таку саму, що й ім’я 
TDF-файлу (без розширення), та списки зовнішніх сигналів – вхідних і ви-
хідних портів. 

1.6 Секція змінних (Variable Section) 
Секція складається з низки підсекцій для оголошення змінних різ-

ного типу і є необов’язковою. Змінна мовою програмування високого рівня 
може означати як просто сигнал, так і деякий внутрішній щодо програмно-
го забезпечення логічний модуль, наприклад, макрофункцію, мегафункцію 
або символ, створений користувачем.  

1.7 Оператор оголошення вузла (Node Declaration)  
Якщо є сигнали, не оголошені в секції підпроекту або в інших опе-

раторах секції змінних, їх можна ввести оператором оголошення вузла цієї 
секції. Оператор дозволяє оголосити проміжні сигнали, які зручно застосу-
вати в логічних рівняннях з метою їх спрощення, особливо якщо такі сиг-
нали використовуються в Булевих рівняннях неодноразово. 

1.8 Оператор оголошення модуля (Instance Declaration)  
Під час використання в графічному файлі деякого функціонального 

модуля, наприклад, примітива, макрофункції або мегафункції, його конк-
ретному екземплярові надається ідентифікаційний номер (позначається в 
лівому нижньому куту). У текстовому файлі, аби розрізнити окремі екзем-
пляри функціональних модулів, кожному з них у секції змінних (Variable 
Section) надається символічне власне ім’я зразка, наприклад, двом дешиф-
раторам можна дати символічні імена dc1 та dc2.  

Синтаксис оператора містить символічне ім’я зразка і після двокрап-
ки ім’я функціонального модуля, попередньо визначене операторами прото-
типу функцій Function Prototype Statement або включення Include Statement. 
Подібний синтаксис, наприклад, для транзисторів означав би їх ідентифіка-
ційні номери в схемі і тип на кшталт VT1 : КТ315; VT2 : КТ315 тощо. 

1.9 Логічна секція (Logic Section) 
Логічна секція є обов’язковою в TDF-файлі, бо саме вона визначає 

залежність вихідних сигналів від вхідних з використанням інших змінних, 
оголошених у файлі. До цієї секції вставляються оператори, основні з яких 
розглядаються нижче. 

1.10 Булеві рівняння (Boolean Equation) 
За допомогою логічних рівнянь здійснюється зв’язок між вихідни-

ми і вхідними сигналами через всі примітиви, макрофункції, мегафункції 
та інші складники проекту. Ліва сторона рівняння містить сигнали, що ви-
значаються логічним виразом правої сторони (який у найпростішому випа-
дку може бути змінною).  

1.11 Оператор таблиці відповідності (Truth Table Statement)  
Як і в звичайній таблиці відповідності, таблиця мовою AHDL міс-

тить комбінації вхідних змінних і значення вихідних функцій. Для частко-
во визначених функцій частина вхідних наборів може подаватися за допо-
могою невизначених станів Х (через це символ х без індексу не можна за-
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стосовувати в текстових файлах для позначення змінної).   
1.12 Умовний оператор (If Then Statement )  
Оператор логічної секції If Then Statement (якщо, тоді) містить умо-

ву для подальшого розгалуження алгоритму роботи пристрою. За виконан-
ня цієї умови активізуються одні інструкції у вигляді списків логічних ви-
разів, а за її невиконання – інші інструкції.  

1.13 Оператор вибору (Case Statement) 
Оператор вибору (Case – випадок) містить булів вираз (у найпрос-

тішому випадку групу змінних), від значень якого залежить дія пристрою. 
У тілі оператора наводяться постійні значення цього виразу і інструкції 
(булеві рівняння, інші оператори, наприклад, таблиця відповідності), які 
діють за наведених значень. За невиконання жодного з цих значень можуть 
подаватися альтернативні інструкції.  

Оператори If Then і Case подібні і в багатьох випадках може вико-
ристовуватися будь-який з них. Проте в операторі If Then діють вирази, а в 
операторі Case – константи, які порівнюються з єдиним виразом умови. 

 

2 Логічні оператори 
Операнди логічних рівнянь з’єднуються логічними операторами, 

черговість виконання яких визначається пріоритетом (табл. 1). 
У найпростішому випадку операнди є однорозрядними змінними, а 

константи в логічних виразах (на відміну від цифр арифметичних виразів) 
мають позначатися як GND (лог. 0) та VCC (лог. 1).  

Приклад: 
[ ] [ ])()()()( 2414124311 cbxaxxxxxxxxy ++=⊕++++= , 

де .;; 4141431 xxcxxbxxxa ⊕==++=  
 

Таблиця 1 
Операція Приклад 

Знак Назва 
Пріоритет 

Булів вираз Вираз AHDL 

! (оклику) НЕ (NOT) 1 1x  !x1 

& (амперсанд) І (AND) 2 21xx  x1 & x2 

!& І-НЕ (NAND) 2 21xx  x1 !& x2 

$ (долар) 
Виключне АБО 

 (XOR) 
3 21 xx ⊕  x1 $ x2 

!$ 
 

Виключне АБО- 
НЕ (XNOR) 

3 21 xx ⊕  x1 !$ x2 

# (фунт) АБО (OR) 4 21 xx +  x1 # x2 

!# АБО-НЕ (NOR) 4 21 xx +  x1 !# x2 
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У складних випадках вираз доцільно поділити на частини, завдяки 
чому спрощується запис мовою AHDL:  

y1 = a !& (x2 # (b !# c)) = (x1 # x3 # !x4) !& (x2 # (x1&x4 !# x1$x4)). 
Останній вираз зв’язує безпосередньо вихідний порт (функцію) y1 з 

вхідними портами (змінними) x1... x4, які є зовнішніми виводами мікро-
схеми і оголошуються в секції підпроекту (Subdesign Sektion). Проте з ме-
тою уникнути помилок і забезпечити легкість для читання складні вирази 
можна вводити до логічної секції (Logic Sektion) частинами 

a = x1 # x3 # !x4;  b = x1 & x4;  c = x1 $ x4; y1 = a !& (x2 # (b !# c)) 
за умови, що проміжні вузли a, b, c було попередньо оголошено операто-
ром Node Declaration секції змінних Variable Section.   

Змінити порядок виконання операцій можна, як звичайно, за допо-
могою дужок. Припускається також ліву частину зображати в інверсному 
вигляді, наприклад, 

!y1 = a & (x2 # (b !# c)). 
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ЛАБОРАТОРНЕ ЗАВДАННЯ 
 
1 Засвоїти основи створення проекту за його текстового вве-

дення апаратною мовою АHDL.  
1.1 Засвоїти синтез із використанням основних секцій і опера-

тора оголошення вузлів на прикладі виконання завдання 5.1 (як зразок 
див. файл 500node.tdf).  

а) Дати ім’я новому проекту: 5XXnode у власній теці. 
б) Створити текстовий файл піктограмою New Text File 

текстового редактора (або з меню File > New > Device Design Files > 
AHDL File > OK) і надати ім‘я з розширенням .tdf безіменному (AhdlN.tdf) 
файлу: піктограмою збереження файлу (або з меню File > Save) викликати 
діалогове вікно збереження, в якому встановити тип файлу AHDL File 
(*.tdf), ввести ім’я файлу 5XXnode і натиснути кнопку збереження. У рядку 
заголовка файлу відобразиться назва 5XXnode.tdf.  

в) Ознайомитися з інструментальною палітрою текстового редакто-
ра (на ілюстрації показано основні інструменти), з меню Tools > Customize 
Text Editor встановити облямовані кнопки великого розміру (зайві інстру-
менти можна вилучити звичайним чином). 

 
г) Налаштувати опції текстового редактора: меню Tools > Options > 

вибрати категорію Text Editor і на однойменній сторінці ввімкнути пере-
микач Quartus II Text Editor та в розділі Quartus II Text Editor options підня-
ти прапорці всіх опцій (показувати номери рядків, маркери розмежування 
сторінок, маркери продовження рядка за кадром у вигляді косої риски пра-
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воруч, автоматично вирівнювати відступ нових рядків такий самий, як у 
попередніх рядках), а також вибрати розмір табуляції – зсув рядків, напри-
клад, на 4 знаки. Відтак вибрати категорію Text Editor > Fonts і на сторінці 
Fonts встановити шрифт, наприклад, Courier New і розмір 14 та натиснути 
кнопку ОК у вікні Options.   

ґ) Рекомендується (але не обов’язково) ввести заголовок ло-
гічного блоку: інструментом вставлення шаблону Insert Template 

(або з меню Edit > Insert Template, або кнопкою В2 > Insert Template) ви-
кликати діалогове вікно Insert Template (далі ці дії стисло позначатимемо: 
ІT), в якому на лівій вкладці залишити синтаксис AHDL, а на правій 
Template section (секції шаблону) двічі клацнути Title Statement (або виді-
лити і натиснути OK). Поставити курсор на початку після лапок, ввести 
довільну назву (до 255 символів), у кінці залишити лапки і крапку з комою, 
а все інше стерти, наприклад: 

T I T L E  "Логічна функція"; 
відтак курсор слід перевести на початок нового рядка. 

д) Ввести обов’язкову секцію Subdesign (підпроект) для оголошен-
ня вхідних змінних і вихідних функцій (відповідають портам – зовнішнім 
виводам мікросхеми): ІT > Subdesign Section > OK та заповнити цей розділ: 

– після ключового слова Subdesign ввести назву проекту (до 32 сим-
волів) – ту саму, що в заголовку файлу без розширення (5XXnode), а інше 
стерти, наприклад: 

SUBDESIGN 500node  
– до блока в дужках ввести через кому перелік вхідних змінних і 

вихідних функцій, залишити двокрапку, ключове слово типу виводів та 
крапку з комою (після знаку рівності для входів зазначають, у разі потреби, 
рівні, які слід подати на незадіяні виводи мікросхеми, що становлять за 
умовчанням GND чи VCC  для функцій АБО та І відповідно), наприклад: 

( 
 x4, x3, x2, x1  : INPUT ; 
 y1                                    : OUTPUT; 
) 

відтак все зайве слід стерти, а курсор  перевести на початок нового рядка 
після дужки. 

F Примітки:  
1) Імена змінних і вихідної функції мають точно відповідати файлу       

../2lab/2XX.bdf з метою подальшого аналізу правильності проектування.  
2) Підпроект Subdesign може правити або за самостійний проект, 

або за складову частину деякого проекту, який у свою чергу може бути 
підпроектом складнішого суперпроекту і так далі за ієрархією. 

е) У разі необхідності, оголосити внутрішні вузли (відповідають 
проміжним змінним, не пов’язаним із зовнішніми виводами мікросхеми) 
вводять необов’язкову секцію змінних: ІT > Variable Section > OK (відтак у 
наступному рядку курсор перевести з відступом Tab) та підсекцію оголо-
шення вузлів: ІT > Node Declaration > OK, в яку вставляють через кому 
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імена зазначених змінних, залишають двокрапку, ключове слово та крапку 
з комою ( відтак все зайве слід стерти, а курсор  перевести на початок но-
вого рядка), наприклад (варіант 00): 

VARIABLE 
a, b, c : NODE; 
є) Ввести обов’язковий логічний блок (у даному випадку – мініма-

льної конфігурації) з метою пов’язати вихідні функції з вхідними (та, якщо 
є, проміжними) змінними: ІT > Logic Section > OK. Відтак між ключовими 
словами (BEGIN та  END;) розташувати курсор (з відступом Tab), ввести 
підсекцію Булевих рівнянь: ІT > Boolean Equation > OK та вставити в 
утворений таким чином шаблон мовою AHDL через крапку з комою логіч-
ні рівняння, можна в декілька рядків (порожні рядки, у разі їх утворення, 
доцільно вилучити), наприклад: 

BEGIN 
       y1= a !& (x2 # (b !# c)); a = x1 # x3 # !x4; b = x1 & x4; c = x1 $ x4; 
END;  
Приклад: 500node.tdf. 
F Примітки: 
1) Ім’я в секції Subdesign обов’язково має збігатися з ім’ям проекту.  
2) Необов’язкові прогалини між складниками у форматуванні фор-

мул, відступи і інтервали не мають значення, вони лише покращують 
стиль, легкий для читання та перевірки. Проте оператори мають точно від-
повідати синтаксису мови AHDL (інакше під час компіляції видається по-
відомлення про помилки та їх локалізацію – зазначаються номери рядків 
тексту і що в них є помилкове). 

3) У TDF-файлі ключові слова виділяються синім кольором, дані для 
компілятора (у тому числі розділові знаки) та інформація, взята в лапки, – чо-
рним, а довільна інформація (у тому числі коментарі, оточені з обох боків 
знаками „%” або відокремлені на початку рядка подвійним тире, які компіля-
тор не сприймає) – зеленим. Якщо знаки набувають іншого забарвлення, це 
свідчить про те, що файл не включений до проекту або про синтаксичні (у 
сенсі мови AHDL) помилки, наприклад, пропущений розділовий знак (крапка 
з комою) між операторами. Змінити для певного файлу призначені за умов-
чанням кольори можна з меню Tools > Options > Text Editor > Colors.  

ж) Зберегти файл, перевірити його на синтаксичні по-
милки (у разі потреби) та виконати компіляцію проекту, нати-

снути  OK в інформаційних віконцях за відсутності помилок (іна-кше ви-
правити) та зачинити вікна компілятора. 

з) Виконати функціональне моделювання за допомогою редактора 
часових діаграм  Waveform Editor.  

Приклад: 500node.vwf. 
и) Виконати автоматичне порівняння часових діаграм з 

метою проаналізувати результати проектування: відкрити вікно од-
ного з порівнюваних файлів (2ХХ.vwf з Лаб. роботи №2, діаграми якого 
вважатимуться початковими) > натиснути інструмент порівняння (або ко-
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манду з меню View > Compare...) > у діалоговому вікні двічі клацнути дру-
гий з порівнюваних VWF-файл (5ХХnode.vwf).  

Відтак однойменні діаграми другого файлу автоматично наклада-
ються на діаграми початкового файлу і набувають червоного кольору на 
ділянках, де вони збігаються; діаграми початкового файлу, відсутні в дру-
гому файлі, залишаються чорними, а діаграми другого файлу, відсутні в 
початковому, не відображаються. При цьому в полі Value рівні сигналів 
другого файлу зазначаються в дужках. Зняти накладання діаграм, у разі 
потреби, можна командою з меню View > End File Comparison. 

 
1.2 Виконати синтез із використанням оператора таблиці від-

повідності Truth Table Statement на прикладі завдання 5.2, для чого дати 
ім’я новому проекту 5XXtab, створити однойменний текстовий файл і збе-
регти його із включенням до проекту. Відтак виконати такі дії.   

а) Ввести заголовок (Title Statement), вхідні і вихідні вектори 
(Subdesign Section) та логічну секцію (Logic Section) – ці дії докладно опи-
сано у п. 1.1,ґ,д,є, приклад див. нижче.  

б) Між ключовими словами (BEGIN та END;) розташувати курсор 
(з відступом Tab) і ввести підсекцію таблиці відповідності: ІT > Truth 
Table Statement та вставити в утворений таким чином шаблон мовою 
AHDL: 1) заголовок таблиці (змінні у вигляді масиву або їх перелік через 
кому, потім, після відокремлювальної стрілки шаблона, так само функції у 
вигляді масиву або їх перелік через кому і в кінці залишити крапку з ко-
мою та 2) тіло таблиці в тому ж форматі, що й заголовок (кожний рядок ві-
дображає або значення змінних і функцій у вигляді кодів певної системи 
числення, або перелік логічних значень через кому – нагадує звичайну 
таблицю) і завершується крапкою з комою; у підсумку текстовий файл на-
буває вигляду як у наведеному нижче прикладі.  

в) Виконати компіляцію, функціональне моделювання та автомати-
чне порівняння утворених таким чином часових діаграм з файлом 3ХХ.vwf 

(Лаб. робота №3). 
г) Створити символьний файл: за відкритого фай-

лу 5ХХtab.tdf в меню File вибрати Create / Update > 
Create Symbol File for Current File (створити символьний 
файл для поточного файлу), натиснути ОК у повідом-

ленні про створення такого файлу; відтак відкрити символьний файл пікто-
грамою відкриття файлу і вибором у діалоговому вікні типу файлів Graphic 
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Files або Other Source Files (інші файли); у разі потреби, відредагувати графі-
чний символ та порівняти його з принциповою електричною схемою. 

Приклад:  500tab.tdf, .vwf, .bsf.   
TITLE "Дешифратор 2:3 (таблиця)";   
SUBDESIGN 500tab                               
(                                                                
 a[1..0] : INPUT;                       
 y[3..0]   : OUTPUT;                   
) 
BEGIN                               %     Logic Section                 % 
 TABLE                      %     Truth Table Statement    % 
  a[] => y[];     
  0   =>  1;        
  1   =>  2;        
           2   =>  4;        
           3   =>  Х;        
 END TABLE; 
END; 
1.3 Виконати синтез із використанням умовного оператора If 

Then (якщо, тоді) у проекті 5XXif_then (на прикладі завдання 5.3) шляхом 
створення текстового файлу (.tdf)  і аналізу результатів так само, як у п. 1.2 
за винятком п. 1.2,б, в якому ввести умовний оператор If Then: ІT > If Then 
Statement та вставити в утворений таким чином шаблон мовою AHDL: 

а) між ключовими словами IF та THEN – умову (вираз або змінну), 
за істинності якої (тобто коли вона набуває значення лог. 1) є дійсними ін-
струкції (функції у вигляді логічних значень або рівнянь через крапку з 
комою чи таблиці відповідності), що йдуть після слова THEN;    

б) після ключового слова ELSE – інструкції, що є дійсними за неви-
конання зазначеної умови (тобто коли вона набуває значення лог. 0), а все 
інше слід стерти; 

в) виконати так само компіляцію, функціональне моделювання та 
автоматичне порівняння утворених часових діаграм з файлом 4prim.vwf. 

Приклад:  500if_then.tdf, .vwf. 
TITLE "Демультиплексор (умовний оператор)";  
SUBDESIGN 500if_then 
( 
 a[1..0], G  : INPUT = VCC; 
 y[3..0]                : OUTPUT; 
)  
BEGIN 
  IF G THEN                                                                           
         y0 = !a1&!a0; y1 = !a1&a0; y2 = a1&!a0; y3 = a1&a0;  
  ELSE                                                                           
      y[] = GND;                                                           
  END IF; 
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END;  
F Примітки: 
1) Необов’язкова частина оператора ELSIF THEN (якщо ще, тоді) 

заповнюється так само, як і основна: між цими ключовими словами встав-
ляється додаткова умова, а після – інструкції, які є дійсні за її виконання. 

2) Текстові файли легко модернізувати: скопіювати (все або части-
ну), непотрібне вилучити, а додаткове вставити, як звичайно, за допомогою 
шаблонів AHDL, не забуваючи привести у відповідність назву підпроекту. 

1.4 Виконати синтез із використанням оператора вибору Case 
(випадок) у проекті 5XXcase (на прикладі завдання 5.4 – для наочності див. 
файл 4prim.bdf з Лаб. роботи №4 за відсутності входу d3) шляхом створен-
ня текстового файлу (.tdf)  і аналізу результатів так само, як у п. 1.2 за ви-
нятком п. 1.2,б, в якому ввести оператор вибору Case: ІT > Case Statement 
та вставити в утворений таким чином шаблон мовою AHDL:       

а) між ключовими словами CASE та IS – вираз (зокрема, код чи на-
бір змінних), від значення якого залежать вихідні функції; 

б) після ключового слова WHEN  перед стрілкою „=>” – конкретне 
значення виразу, а після неї – значення функції (як у таблиці відповіднос-
ті), відтак залишити крапку з комою; цей ланцюжок може повторюватися 
довільну кількість разів; 

в) у необов’язковій частині WHEN OTHERS (коли інше) після стрі-
лки – значення функцій за інших значень виразу (не перелічених у п. б); 

г) виконати так само компіляцію, функціональне моделювання та 
автоматичне порівняння утворених часових діаграм; 

Приклад: 500case.tdf, .vwf. 
TITLE  "Мультиплексор 3:1 (оператор вибору)"; 
SUBDESIGN 500case   
( 
 a[1..0], d[2..0] : INPUT; 
 y                       : OUTPUT; 
) 
BEGIN  
      CASE a[] IS  

WHEN 0 => y=d[0];  
     WHEN 1 => y=d[1];  

WHEN 2 => y=d[2];         
WHEN OTHERS => y=X;  

END CASE; 
END;  
 

2 Засвоїти запровадження макрофункцій, символів та мегафун-
кцій до проекту за його текстового введення.  

2.1 Засвоїти включення до проекту макрофункції (на прикладі вико-
нання завдання 5.5): створити новий проект 5XXmacro і однойменний текс-
товий файл (.tdf) із включенням його до проекту, відтак виконати такі дії (для 
наочності див. графічний файл 3ХХ_7seg.bdf, схема 1 з Лаб. роботи №3).  
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1) Ввести заголовок Title Statement (нижче пунктів подається при-
клад). 

TITLE "Спец. дешифратор 7-сегментного коду на макрофункції"; 
2) До шаблону секції Function Prototype Statement вставити прото-

тип макрофункції двійкового дешифратора (описати використовувані вхо-
ди і виходи згідно із синтаксисом мови безпосередньо за графічним симво-
лом або повністю скопіювати з довідки Help пакету MAX+PLUS II). 

FUNCTION 74139о (g1n, b1, a1) 
 RETURNS (y10n, y11n, y12n, y13n); 
3) У секції Subdesign Section повторити ім’я проекту 5XXmacro та 

оголосити вхідні і вихідні порти. 
SUBDESIGN 500macro                        
( 
 a1, a0                    : INPUT; 
 a, b, c, d, e, f, g, dp        : OUTPUT; 
) 
4) Ввести секцію змінних Variable Section. 
VARIABLE 
5) Вставити підсекцію оголошення зразка Instance Declaration і на-

дати ім’я зразку (для наочності у прикладі 300_7seg.bdf позначено: dc – 
ім’я зразка дешифратора) та через двокрапку ввести ім’я макрофункції 
(74139о). 

 dc  :    74139о; 
6) Ввести логічний блок Logic Section, між ключовими словами 

(BEGIN та END;) розташувати курсор (з відступом Tab), вставити підсек-
цію Boolean Equation та з'єднати рівняннями зразок функції з оголошеними 
портами INPUT і OUTPUT. 

BEGIN 
 dc.a1 = a0; dc.b1 = a1; a=!dc.y11n; b=!dc.y11n # !dc.y12n;  
 c=!dc.y12n; d=!dc.y10n; e=GND; f=GND; g=!dc.y12n; dp=VCC; 
END; 
F Примітки: 
1) Логічні зв’язки між виходами та входами макрофункції містяться 

в її прототипі (п. 2.1.2), тому в булевих рівняннях достатньо лише з'єднати 
входи і виходи зразка, що репрезентує макрофункцію в проектованому 
пристрої, з вхідними і вихідними портами пристрою. Входи і виходи зраз-
ка мають такі самі назви, як у макрофункції, але позначаються через крап-
ку після імені зразка. У лівій частині рівнянь ставляться невідомі величи-
ни, а в правій – відомі, задані вхідними портами INPUT або визначені у 
прототипі (у нас – yі). У разі потреби, додаткові з'єднання виконуються че-
рез зовнішні відносно макрофункції логічні операції, наприклад, інвертор 
на виході: a = !dc.y11n.  

2) Імена макрофункції та її параметрів мають суворо відповідати 
формату: FUNCTION <ім’я функції> (вхідні порти через кому) RETURNS 
(вихідні порти через кому) <крапка з комою>, про який можна дізнатися з 
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прототипу функції в довідці пакету MAX+PLUS II (Help > Old-Style 
Macrofunctions > Категорія > Iм'я макрофункції > AHDL Function 
Prototype) або з графічного файлу в тому ж пакеті (В2 по символу > Edit 
Ports/Parameters > Help on “Iм'я макрофункції” > AHDL Function Prototype). 

7) Виконати компіляцію, функціональне моделювання і перекона-
тися в правильності проектування.  

Приклад: файли 500macro.tdf, .vwf. 
2.2 Засвоїти включення до проекту символу (на прикладі виконання 

завдання 5.6): створити новий проект 5XXsymb і однойменний текстовий 
файл (.tdf), включити до проекту цей файл і текстовий файл символу 
5ХХtab.tdf  та виконати такі самі дії, як і в п. 2.1  (для наочності див. графіч-
ний файл 3ХХ_7seg.bdf, схема 2 з Лаб. роботи №3) із такими відмінностями:  

а) у п. 2.1.2 до шаблону секції Function Prototype Statement ввести із 
заздалегідь створеного текстового файлу символу 5ХХtab.tdf  (п. 1.3) назву 
і параметри із секції підпроекту; наприклад, із файлу 500tab.tdf 

SUBDESIGN 500tab   
( 
 a[1..0]  : INPUT; 
 y[2..0]    : OUTPUT; 
) 
вводимо до нашого файлу, дотримуючись шаблона дані: 
FUNCTION 500tab(a[1..0]) 
 RETURNS (y [2..0]); 
     б) у секції змінних так само оголошуємо зразок з іменем симво-

лу, наприклад: 
VARIABLE 
 dc  :  500tab; 
в) до логічної секції вставляємо рівняння, дотримуючись імен вхо-

дів і виходів символу, наприклад: 
BEGIN 

dc.a[1..0]=a[1..0]; a2=dc.y[1]; b2=dc.y[1]#dc.y[2]; c2=dc.y[2];   
d2=dc.y[0]; e2=GND; f2=GND; g2=dc.y[2]; dp2=VCC; 

END; 
Приклад: файли 500symb.tdf, .vwf. 
2.3 Засвоїти включення до проекту мегафункцій (на прикладі вико-

нання завдання 5.7; задля наочності див. файл 400gr_mega.bdf): створити но-
вий проект 5XXmega і однойменний текстовий файл (.tdf), зберегти із вклю-
ченням до проекту цей файл, ввести заголовок (Title Statement) та виконати 
такі дії (під кожним пунктом наводяться фрагменти файлу 500mega.tdf). 

TITLE "у на основі мегафункцій "; 
1) Включити до складу проекту принаймні один різновид мегафун-

кції мультиплексора певної розрядності (за власним вибором), створений 
менеджером MegaWizard Plug-In Manager у Лаб. роботі №4, наприклад, 
4XXmux8.inc, для чого:  

а) вставити шаблон оператора включення Include Statement і в лап-
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ках ввести після двох крапок частину директорії, відмінну від директорії 
проекту ../4lab, та через косу риску ім’я різновиду мегафункції (з розши-
ренням .inc) /4XXmux8.inc, надане під час його створення, наприклад: 

INCLUDE "../4lab/400mux8.inc"; 
б) піктограмою Settings (або з меню Project > Add/Remove 

Files in Project) викликати діалогове вікно Settings, відкрити сторінку 
Files і кнопкою огляду (…) ввести до складу проекту файл включення (.inc) 
і текстовий файл (.tdf) зазначеного різновиду мегафункції (з Лаб. роботи 
№4, тип файлів Other Source Files). Низку файлів з діалогового вікна Select 
File можна перенести до проекту одним заходом: виділити їх за натиснутої 
клавіші Ctrl та натиснути кнопку збереження. 

F Примітка: Альтернативою використання готового різновиду ме-
гафункції є створення за допомогою менеджера MegaWizard Plug-In 
Manager нового її різновиду з директорією теки проекту.  

2) Включити до складу проекту принаймні один із типів мегафунк-
цій мультиплексора (за власним вибором), що є в бібліотеці програмного 
пакету, наприклад, mux оператором включення Include Statement. 

INCLUDE "mux.inc";  
F Примітка: Стандартні мегафункції компілятор бере безпосеред-

ньо з бібліотеки за назвою, тому й немає потреби вводити директорію.  
3) Ввести вхідні і вихідні порти в секції підпроекту (Subdesign 

Section), використовуючи замість x[] інші імена змінних (бо літера х заре-
зервована для невизначеного стану), наприклад, in[]. 

SUBDESIGN 500mega 
( 
        in[4..1]     : INPUT; 
        y2, y2a     : OUTPUT; 
) 
4) Вставити секцію змінних Variable Section. 
VARIABLE 
5) Надати імена компонентам схеми, для яких створено різновиди 

мегафункцій за допомогою менеджера, для чого  викликати підсекцію ого-
лошення непараметризованого зразка Instance Declaration (non-parame-
tererized) і ввести в її шаблон ім’я зразка функції, через двокрапку –  ім’я  
мегафункції та залишити крапку з комою.   

 mx2   :  400mux8; 
6) Надати імена компонентам схеми, в яких використовуються ста-

ндартні мегафункції, для чого  викликати підсекцію оголошення парамет-
ризованого зразка Instance Declaration (parametererized) і ввести в її ша-
блон ім’я зразка функції, через двокрапку –  ім’я  мегафункції, після клю-
чового слова WITH – її параметри (кількість входів даних WIDTH і розря-
дність адресної шини WIDTHS) та залишити крапку з комою.   

mx2a  : mux 
   WITH (WIDTH = 8, WIDTHS = 3); 
F Примітка: Під час створення різновиду мегафункції за допомо-
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гою менеджера його параметри вже містяться у файлі, наприклад, 
400mux8.tdf, тому достатньо оголосити зразок без зазначення параметрів 
(непараметризований зразок). Проте за використання стандартної мегафу-
нкції, наприклад, mux параметри зразка потрібно визначити в підсекції 
оголошення параметризованого зразка (на кшталт налаштування мегафун-
кції в графічному редакторі). 

7) Ввести логічний блок Logic Section. 
BEGIN 
END; 
8) Між ключовими словами (BEGIN та END;) ввести оператор бу-

левих рівнянь Boolean Equation та вставити в утворений таким чином шаб-
лон рівняння через крапку з комою, якими з’єднати входи мегафункції з 
вхідними портами та вихідний порт – з виходом мегафункції.  

BEGIN 
mx2.sel[2..0] = (in4, in[2..1]); mx2.data6 = !in3; 

      mx2.(data7, data[5..0]) = H"32";  y2 = mx2.result; 
      mx2a.sel[2..0] = (in4, in[2..1]); mx2a.data6 = !in3;  
      mx2a.(data7, data[5..0]) = H"32"; y2a = mx2a.result; 
END; 
9) Виконати компіляцію і функціональне моделювання та перекона-

тися в правильності проектування (для наочності див. файли 
400gr_mega.bdf, 400gr_mega.vwf).    

Приклад:  500mega.tdf, .vwf. 
 

3 Створити в текстовому редакторі проект лабораторного маке-
ту для експериментального дослідження ЦКП на мультиплексорі згід-
но з варіантом 5.7 (див. структурну схему і задля наочності графічний ана-
лог проекту 500gr_СКР.bdf на рис. Д3 у додатках).  

Дешифратор
7-сегм. коду MAX_DIGITКлючі

ЦКП на  основі мультиплексорів 1, 2

Перетворювач
двійкового  коду в  ДДК

Двійковий код

ДДК

Індикатори D1, D2 виходу функції

 
Від ДІП-перемикачів MAX_SW1 вхідні змінні надходять на входи 

мультиплексорів, з виходів яких реалізована функція в інверсному вигляді 
індукується світлодіодами. Набори вхідних змінних через перетворювач 
двійкового коду в двійково-десятковий подаються на дешифратори 7-
сегментного коду для подальшої індикації двома знакомісцями цифрового 
індикатора в десятковій системі. У прикладі за чотирьох змінних потрібно ві-
добразити числа 0…15, тобто індикатор старшого розряду має або бути по-
гашений, або індикувати цифру 1. Для цього потрібно молодшу тетраду ДДК 
подати на входи дешифратора 7-сегментного коду безпосередньо, а зі стар-
шої тетради ДДК скористатися лише молодшим розрядом для гасіння або за-
свічування сегментів b та c (усі інші сегменти мають бути погашені). 

3.1 Засвоїти сумісне включення до текстового проекту мегафункцій 
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і макрофункцій, для чого створити новий проект 5XXCKP і однойменний 
текстовий файл (.tdf), зберегти із включенням до проекту цей файл та ви-
конати такі дії (див. файл 500CKP.tdf). 

а) Вставити до текстового файлу мегафункції аналогічно п. 2.3. Для 
цього можна скопіювати текстовий файл 5XXmega.tdf, залишити в ньому 
частину для реалізації пристрою на одній-двох мегафункціях, а інше вида-
лити та виправити заголовок (Title Statement) і ім’я проекту (Subdesign 
Section). Відтак аналогічно п. 2.3.1,б ввести до складу проекту файли 
включення (.inc) і текстовий (.tdf) різновиду мегафункції, створеного мене-
джером (з Лаб. роботи №4, тип файлів Other Source Files). 

б) Аналогічно п. 2.1 вставити до текстового файлу макрофункції 
перетворювача двійкового коду у двійково-десятковий і дешифратора 7-
сег-ментного коду.  

в) Доповнити файл портами (Subdesign Section), оголошенням зраз-
ків (Variable Section) та необхідними з’єднаннями компонентів (Boolean 
Equation). Виконати компіляцію і функціональне моделювання проекту. 

F Примітка. Імена портів використовувати відповідно до файлу 
розведення їх на друкованій платі ../4lab/MAX_pin.   

3.2 Імпортувати призначення виводів мікросхеми (див. Лаб. роботу 
№4, п. 5.2) з файлу ../4lab/MAX_pin. 

3.3 Виконати компіляцію і функціональне моделювання проекту та 
переконатися в правильності проектування.  

Приклад: 500CKP.tdf, .vwf. 
3.4 Сформувати файл програматора і виконати фізичне програму-

вання мікросхеми (див. Лаб. роботу №3, п. 3.5, 3.6).  
Приклад: 500СКР.сdf. 
3.5 Розробити методику та виконати необхідні експериментальні 

дослідження. Порівняти їх результати з даними проектних файлів, зробити 
висновки. 
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6 ЛАБОРАТОРНА РОБОТА №6. АРИФМЕТИЧНІ ПРИСТРОЇ 
 
Мета роботи: дослідження типових арифметичних пристроїв – 

суматорів, арифметико-логічних пристроїв, помножувачів, подільників і 
компараторів; побудова ЦКП на суматорах і компараторах; засвоєння ос-
нов створення ієрархічного проекту на рівні блок-схеми. 

 
ДОМАШНЄ ЗАВДАННЯ 

! Спроектувати заданий згідно з варіантом (див. Додатки) порого-
вий елемент на суматорах і компараторах.  

 
СТИСЛІ ТЕОРЕТИЧНІ ВІДОМОСТІ 

Арифметичні пристрої: двійкові суматори, комбінаційні помножу-
вачі, арифметико-логічні пристрої, цифрові компаратори розглянуто в [2]. 
Основні з них подано в табл. 6.1, 6.2.  

Застосування арифметичних пристроїв для побудови ЦКП 
Арифметичні пристрої можуть використовуватись не тільки для ви-

конання арифметичних операцій, але й для побудови пристроїв, пов’язаних 
із порівнянням кодів, визначенням кількості вхідних сигналів, що набува-
ють значення лог. 1 тощо. До таких ЦП належать, зокрема, порогові елеме-
нти – ЦКП, на виході яких встановлюється рівень лог. 1, якщо не менш, 
ніж на k із довільної кількості m входів сигнали набувають рівня лог. 1. 
Окремим випадком порогових пристроїв є мажоритарний елемент – 
ЦКП, на виході якого виникає рівень лог. 1, якщо на більшості з його не-
парної кількості m входів діють рівні лог. 1.  

Приклад. Для прикладу розглянемо принцип побудови мажоритар-
ного елемента на m = 7 входів, тобто пристрою з порогом k = 4. Потрібна 
для цього кількість елементів І-НЕ різко зростає зі збільшенням m і стає 
неприйнятною. Ідея використання суматорів полягає в тому, що спочатку 
підраховуємо кількість логічних одиниць на входах, а потім встановлюємо, 
чи не перевищує вона потрібний поріг k. 

Нагадаємо попередньо, що індекси i на вхідному і вихідному  полях 
умовного графічного позначення суматора (див. рис. 6.1,є) вказують на ва-
гу його розрядів 2i. З огляду на це підраховуємо кількість одиниць на вхо-
дах х1...х7 за допомогою двох однорозрядних та одного дворозрядного су-
маторів (рис. 1,а), виконуючи  з’єднання з урахуванням ваги розрядів. Під-
сумок зчитуємо з виходів останнього суматора як S = с222 + s121 + s020, 
тобто у вигляді двійкового числа с2s1s0. Перенесення ум = с2 і є виходом 
мажоритарного  елемента “4 з 7", бо S ≥ 4 при с2 = 1. 

Аналогічно проектуємо й пороговий елемент, наприклад, при m = 7,     
k = 5. Згідно з таблицею (рис. 6.1,б) мінімізуємо його функцію (рис. 6.1,в)       
yп = (s0 + s1) с2 та реалізуємо її на основі тієї ж схеми (див. рис. 6.1,а). 
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Отже, на виході yм встановлюється рівень лог. 1 за виникнення одиниць не 
менш, ніж на 4 входах, а на виході уп – не менш, ніж на 5 входах із 7. 

 
а) 

 
б) 

 
в) 

Рисунок 6.1 
 

Таблиця 6.1 – Макрофункції арифметичних пристроїв 
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Таблиця 6.2 – Мегафункції арифметичних пристроїв 
Символ Основні параметри 

 

lpm_add_sub (Adder/Subtractor): 
LPM_WIDTH – розрядність вхідних 
і вихідної шин; 
LPM_REPRESENTATION –  зобра-
ження даних: зі знаком ("SIGNED"), 
без знаку ("UNSIGNED"); 
LPM_DIRECTION – тип операції: 
додавання ("ADD"), віднімання 
("SUB"); 
сin (Carry-in), cout (Carry-out) –  вхі-
дний і вихідний переноси. 

 

lpm_compare (Comparator): 
LPM_WIDTH – розрядність вхідних 
шин dataa[] = А та datab[] = В. 
Входи        Функція 
А < B         alb      
А = B         aeb              
А > B         agb 
А ≥ B         ageb 
А ≠ B         aneb 
А ≤ B           aleb 

 

lpm_mult (Multiplier): 
LPM_WIDTHA – розрядність мно-
женого dataa[]; 
LPM_WIDTHB – розрядність множ-
ника datab[]; 
LPM_WIDTHP = LPM_WIDTHA +  
+ LPM_WIDTHB – розрядність до-
бутку result[]. 

 

lpm_divide (Divider): 
LPM_WIDTHN – розрядність діле-
ного numer[] і частки quotient[]; 
LPM_WIDTHD – розрядність діль-
ника denom[] і залишку remain[]. 
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КОНТРОЛЬНІ ЗАПИТАННЯ 
1. Як слід каскадувати з метою збільшення розрядності 1) суматори, 

2) АЛП, 3) компаратори? 
2. Реалізуйте на основі заданих в дужках пристроїв і, за необхідніс-

тю, додаткових логічних елементів таку арифметичну операцію та підра-
хуйте швидкодію її виконання:  

1) a0 + b0 + c0 (І-НЕ),  
2) a0 + b0 + c0 (АБО-НЕ),       
3) a1a0 + b1b0 (виключне АБО),  
4) a1a0 + b1b0 (дешифратор),  
5) a2a1a0 + b2b1b0  (півсуматори),  
6) a2a1a0 + b2b1b0  (повні однорозрядні суматори), 
7) a2a1a0 – b2b1b0  (повні однорозрядні суматори),  
8) a2a1a0 –  b2b1b0  (чотирирозрядний суматор).  
3. Спроектуйте на основі суматорів:  
а) мажорритарні елементи: 1) на 5 входів, 2) на 9 входів;  
б) порогові елементи: 3) 2 з 5, 4) 3 з 6, 5) 3 з 7, 6) 4 з 5,  7) 4 з 6, 8) 4 

з 8, 9) 4 з 9, 10) 5 з 7, 11) 5 з 8, 12) 6 з 9.  
Підрахуйте, скільки потрібно було б елементів І-НЕ для побудови 

такої схеми. 
4. Спроектуйте на основі мультиплексорів:  
1) мажоритарний елемент на 3 входи,  
2) пороговий елемент 2 з 5,  
3) компаратор рівності трирозрядних кодів,  
4) півсуматор,  
5) суматор,  
6) компаратор дворозрядних чисел з функціями “рівно” та “більше”. 
5. Реалізуйте цифровий компаратор  
а) 4-розрядних чисел на: 1) логічних елементах для двох основних 

функцій порівняння, 2) дешифраторі та мультиплексорі для функції рівно-
сті, 3) мультиплексорах для двох функцій порівняння, 4) АЛП для всіх фу-
нкцій порівняння, 5) суматорах для всіх функцій порівняння,  

б) 12-розрядних чисел для трьох функцій порівняння на основі: 6) 
4-розрядних компараторів, 7) 4-розрядних суматорів, 8) 4-розрядних АЛП. 
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ЛАБОРАТОРНЕ ЗАВДАННЯ 
 
1 Дослідити типові арифметичні пристрої.   
1.1 Дослідити суматори: за принциповими електричними схемами 

(файл 6sum.bdf) та осцилограмами сигналів (6sum.vwf) півсуматора (схе-
ма 1) і однорозрядного повного суматора (схема 2) на логічних елементах 
І-АБО-НЕ скласти таблиці відповідності і рівняння вихідних функцій, ви-
міряти затримку вихідних імпульсів. У звіті навести також умовне графіч-
не позначення за ДСТУ таких ЦКП зі стислим поясненням принципу їх дії. 
Розглянути особливості побудови і перемикання типового багаторозряд-
ного суматора (макрофункції за схемою 3) та суматора на мегафункції 
(схема 4). 

1.2 Дослідити типовий арифметико-логічний пристрій (АЛП) на 
макрофункції серії 74 (схема 5) у режимах виконання арифметичної опера-
ції додавання (при М=0) та логічної операції кон’юнкції (при М=1). 

1.3 Дослідити компаратори: за принциповими електричними схе-
мами (файл 6comp.bdf) та осцилограмами сигналів (6 comp.vwf) однороз-
рядного компаратора (схема 1) на логічних елементах та типового бага-
торозрядного компаратора (макрофункції за схемою 2) скласти таблиці 
відповідності і рівняння вихідних функцій, виміряти затримку вихідних 
імпульсів. Розглянути особливості побудови і перемикання компаратора  
на мегафункції (схема 3) та виконання функцій компаратора на основі ба-
гаторозрядного суматора (схема 4). 

1.4 Ознайомитися зі стандартними арифметичними пристроя-
ми серії 74 (макрофункціями) та параметризованими мегафункціями (файл 
6lіbr.bdf): суматорів і суматора-віднімача (Adder Macrofunctions, Parame-
terized Adder/Subtractor Megafunction); АЛП (Arithmetic Logic Unit Macro-
functions); помножувачів і подільника (Multiplier Macrofunctions, Parame-
terized Multiplier Megafunction, Parameterized Divider Megafunction) та ком-
параторів (Comparator Macrofunctions, Parameterized Comparator Mega-
function). Розглянути функціональні прототипи, параметри, таблиці вико-
нуваних функцій різновидів арифметичних пристроїв (достатньо по одно-
му з кожної групи), пояснити призначення та особливості входів і виходів. 

 
2 У текстовому редакторі створити проект нижнього рівня іє-

рархії як блоку для проекту верхнього рівня ієрархії  
2.1 Задля наочності створити проект у графічному редакторі блоку 

суматора, призначеного для підсумовування кількості сигналів одиничного 
рівня на входах заданого варіанту порогового елемента.   

а) Визначити ім’я проекту 6XXgr_sum і створити одно-
йменний графічний файл блоку із включенням його до складу 

цього проекту.   
б) Зібрати пристрій для підсумовування кількості N одинич-

них рівнів вхідних сигналів. Перший ступінь скласти на макрофунк-
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ціях повних суматорів дібраного типу (з бібліотеки 6libr.bdf або з пакету 
MAX+ PLUS II > Old Style Macrofunctions). У другому ступені за допомо-
гою вбудованого майстра MegaWizard Plug-In Manager вставити  мегафун-
кцію багаторозрядного суматора з іменем зразка, наприклад, sum2 (з кате-
горії arithmetic > LPM_ADD_SUB, режим операції Addition only – тільки 
додавання, якщо потрібно, встановити прапорці Create a carry input та 
Create a carry output для створення вхідного cin і вихідного cout переносів). 
Відтак вставити до файлу вхідний і вихідний порти, виконати з’єднання 
компонентів схеми та дати імена портам і лініям у місцях розщеплення 
шин або об’єднання до шин. На завершення зберегти зміни у файлі.  

F Примітки: 
1) Входи суматорів можна з’єднувати з розрядами чисел лише відпо-

відної ваги (яка не завжди відображається на символах у назвах входів і ви-
ходів). 

2) У прикладі введено додатковий нульовий старший розряд 
dataa[3] = 0 для зручності з’єднання виходів суматора dataa[3..0]  з вхідною 
тетрадою дешифратора семисегментного коду (якщо його вхід D вилучити, 
то згідно з довідкою MAX+PLUS II за умовчанням він з’єднується з логіч-

ною одиницею VCC).    
в) Скомпілювати проект, створити файл часових 

діаграм, виконати функціональне моделювання та переко-
натися в правильності проектування пристрою.  

Приклад: 600gr_sum.bdf, .vwf. 
F Примітки: 
1) Результати моделювання автоматично переносяться на файл ча-

сових діаграм проекту, якщо з меню Tools > Options > General > Processing 
на вкладці Processing ввімкнути прапорець Overwrite simulation input file 
with simulation result та натиснути кнопку OK. Проте повторне моделюван-
ня після внесення змін у вхідних сигналах може виявитися зручнішім без 
цієї опції: можна порівняти діаграми у звітному файлі після моделювання з 
діаграмами до внесення змін. 

2) Вхідний і вихідний коди зручно зображати в шістнадцят-
ковій і десятковій системі числення відповідно. Для зміни системи 

слід виділити діаграму групи і піктограмою Properties  (або B2 > Properties) 
викликати діалогове вікно Node Properties (властивості вузла) та в рядку 
Radix (система числення) прокруткою ввести Hexadecimal (шістнадцяткова 
система) або Unsigned Decimal (десяткова система числення без знаку).  

2.2 Користуючись графічним файлом 6XXgr_sum як зразком, ство-
рити проект блоку суматора у текстовому редакторі. 

а) Створити новий проект з ім’ям 6XXsum, яке має точно 
збігатися з іменем цього блоку в проекті верхнього рівня, та вклю-

чити до складу проекту файл sum2 суматора другого ступеня з проекту 
6XXgr_sum (вставити його кнопками огляду та Add на другій сторінці вік-
на New Project Wizard).  
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б) Створити новий текстовий файл 6XXsum.tdf і включити 
його до проекту 6XXsum: натиснути піктограму збереження файлу, 
у діалоговому вікні встановити директорію своєї теки, вибрати тип 

файлу AHDL File (*.tdf), ввести ім’я 6XXsum,  підняти прапорець Add file 
to current project та натиснути кнопку збереження.  

в) Ввести заголовок Title Statement (під кожним пунктом на-
водиться приклад зразка 600sum.tdf). 
TITLE "Блок суматора для файлу блок-схеми";     
г) У секції Include Statement включити до проекту автоматично 

створений різновид мегафункції другого ступеня суматора sum2.  
INCLUDE  "sum2.inc";          
ґ) У секції Function Prototype Statement (non-parameterized) ввести 

прототипи макрофункцій суматорів першого ступеня (записати дані із си-
мволу або скопіювати з довідки Help пакету MAX+PLUS II). 

FUNCTION 74183 (1cn0, 1a, 1b, 2cn0, 2a, 2b)  
 RETURNS (1sum, 1cn1, 2sum, 2cn1); 
F Примітка: Прототип макрофункції певного типу вставляється 

тільки один раз, навіть якщо зразок цієї макрофункції використовується в 
проекті неодноразово. Якщо вставляється декілька різних макрофункцій, їх 
прототипи вводяться по черзі    повністю: FUNCTION <ім’я 1> (…) 
RETURNS (…); FUNCTION <ім’я 2> (…) RETURNS (…); і т. д.  

д) У секції Subdesign Section повторити ім’я проекту 6XXsum та 
оголосити вхідні і вихідні порти. 

SUBDESIGN 600sum                              
( 
 sw1[7..1] :  INPUT; 
 dataa[3..0] :  OUTPUT; 
) 
F Примітка: Порти sw1[7..1] є зовнішніми виводами мікросхеми, 

тому названі стандартно, як у файлі розведення ../4lab/MAX_pin.    
е) Ввести секцію змінних Variable Section. 
VARIABLE                                    
є) Вставити підсекцію Instance Declaration (non-parameterized) і вве-

сти імена зразків та (через двокрапку) типи оголошених у п. 2.2, г, ґ макро- 
і мегафункцій (для наочності у файлі 600gr_sum.bdf імена зразків позначе-
но для суматорів першого і другого ступеня). 

 sm1 :  74183;  sm2 :  sum2;  
ж) Викликати логічну секцію Logic Section; 
BEGIN 
END;                
з) Вставити до неї підсекцію Boolean Equation і рівняннями з'єднати 

зразки функцій між собою та з оголошеними портами INPUT і OUTPUT. 
BEGIN                                       

sm1.1cn0=sw1[2]; sm1.1a=sw1[3]; sm1.1b=sw1[4]; 
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sm1.2cn0=sw1[5];    sm1.2a=sw1[6]; sm1.2b=sw1[7]; sm2.cin=sw1[1]; 
sm2.dataa[]=(sm1.1cn1, sm1.1sum); sm2.datab[]=(sm1.2cn1, sm1.2sum); 

    dataa[]=(GND, sm2.cout, sm2.result[]); 
END; 
и) Виконати компіляцію і моделювання та переконатися в правиль-

ності функціонування пристрою за часовими діаграмами 6XXsum.vwf.  
Приклад: 600sum.tdf, .vwf. 

і) Відкрити (якщо це не зроблено) файл вершини текстового 
проекту 6ХХsum.tdf і створити символьний файл блоку суматора: 

меню File > Create/Update > Create Symbol Files for Current File > OK в ін-
формаційному віконці про успішне генерування символьного файлу. Від-
так відчинити вікно символьного файлу (з типу файлів Graphic Files або 
Other Source Files) та, у разі потреби, зменшити розмір символу: клацнути 
сторону внутрішнього прямокутника, скоригувати його розмір, клацнути 
для виділення написи, перетягнути їх ближче до центру та скоригувати 
розмір зовнішнього прямокутника і зберегти файл.  

Приклад: 600sum.bsf.  
 
3 Засвоїти основи створення ієрархічного проекту на рівні блок-

схеми для побудови порогового елемента, заданого згідно з варіантом ХХ.  

Суматор Дешифратор 7-seg Індикатор суми

Компаратор Індикатор порогу

Структурна схема
b=const

a[ ]

a>=bsw1[ ]

sw2[1]
 

Від перемикача MAX_SW1 (див. файл ../6lab/600POR_EL.bdf на       
рис. Д1) сигнали sw1[] надходять на входи суматора, на виходах якого фо-
рмується код dataa[], що відображає кількість одиничних рівнів на входах. 
Для індикації цієї кількості сума через дешифратор 7-сегмнтного коду по-
дається на 7-сегментний індикатора MAX_DIGIT (якщо сума перевищує 9, 
її двійковий код попередньо необхідно перетворити в ДДК на кшталт 
..5lab/500gr_CKP). У компараторі сума dataa[] порівнюється з пороговою 
величиною b і коли досягає її, на виході компаратора утворюється рівень 
лог. 1, що індикується світлодіодом D1. Дозвіл на індикацію порогу зада-
ється перемикачем MAX_SW2.       

3.1 Визначити ім’я проекту та створити файл блок-схеми 
(файл верхнього рівня ієрархії проекту). 

F Примітка. Для виконання наступних дій доцільно користуватися 
зразком блок-схеми у файлі ../6lab/600POR_EL.bdf (рис. Д1).  

а) Створити новий проект 6ХХPOR_EL, на другій сторінці 
майстра New Project Wizard включити до складу проекту заздале-

гідь створені текстові файли блоку суматора 6ХХsum.tdf (п. 2.2) та 



 89 

sum2.tdf    (п. 2.1,б), на четвертій – вибрати родину мікросхем MAX7000S, 
на п’ятій – тип корпусу PLCC, кількість виводів 84, швидкодію Any (будь-
яка) та мікросхему зі списку приступних типів EPM7128SL84-7. 

б) Створити новий графічний файл з безіменною назвою 
BlockN.bdf (N – довільний номер). 
3.2 Вставити до блок-схеми функціональний блок. 

а) Інструментом палітри вставлення блоку 
Block Tool натиснути в полі файлу лівою кнопкою 

миші і, утримуючи її, протягнути по діагоналі для утво-
рення прямокутної області приблизно потрібного розмі-
ру. По відпусканні кнопки з’явиться виділений безімен-
ний блок з порожньою мапою його зовнішніх вхо-
дів/виходів (І/О). 

б) Виділити, якщо це не зро-
блено, блок і натиснути інструмент 

Properties (властивості) для виклику діало-
гового вікна Block Properties (або В2 > Block 
Properties). На вкладці General (загальні) у 
полі Name ввести ім’я блоку суматора 
6ХХsum, таке саме, що й у текстовому фай-
лі, в якому створено цей блок (п. 2.2).  

в) Перейти на вкладку 
I/Os (входи/виходи), у полі 
Name ввести ім’я групи входів, 
наприклад, sw1[7..1], у полі Type 
вибрати INPUT і натиснути кно-
пку Add (додати) – у списку іс-
нуючих входів/виходів блоку 
з’явиться рядок групи входів. 
Відтак повторити ці дії для гру-
пи виходів: dataa[3..0] > 
OUTPUT > Add. По натисненні 
кнопки OK зроблені призначен-

ня переносяться на мапу всередині блоку. 
г) Ha блоці натиснути праву кнопку миші B2 і в 

контекстному меню вибрати команду AutoFit (або ви-
ділити блок і в меню Edit вибрати AutoFit) – блок ав-
томатично набирає такого розміру, щоб до нього добре 
вписалась мапа входів/виходів. 

 ґ) Таким самим чином (п. a ... г) вставити інші блоки, якщо 
вони є. Відтак натиснути піктограму збереження файлу Save, у діа-

логовому вікні підняти прапорець Add file to current project для включення 
файлу до проекту та натиснути кнопку збереження – файлові автоматично 
надається назва верхнього рівня проекту і в ньому зберігаються зміни. 
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F Примітка: Процедура вставлення блоку за п. 3.2 є універсальною: 
файл блоку можна створити як до, так і після створення файлу блок-схеми. 
Проте у випадку, коли файл блоку і його символ створено заздалегідь (як у 
нашому прикладі – у п. 2.2), блок можна вставити як символ: двічі клацнути в 
полі файлу (або натиснути інструмент вставлення символу) і в діалоговому 
вікні Symbol вибрати Project > 6XXsum > Insert symbol as block > OK.  

3.3 Створити і вставити до блок-схеми примірник мегафункції. 
а) Двічі клацнути в полі файлу (або натиснути інструмент 

вставлення символу) і в діалоговому вікні Symbol натиснути кнопку 
MegaWizard Plug-In Manager. На першій сторінці вибрати створення ново-
го зразка мегафункції (Create …). 

б) На другій сторінці зі списку мегафункцій ліворуч вибрати 
Installed  Plug-Ins (установки майстра) > категорію Arithmetic > тип 
LPM_CO-MPARE. У верхніх рядках праворуч залишити раніше встанов-
лену родину ІС MAX7000S (інакше вибрати її прокруткою) та тип вихідно-
го файлу AHDL. У наступному рядку до встановленої директорії теки (ін-
акше вибрати її кнопкою огляду Browse) ввести без прогалини ім’я вихід-
ного файлу, наприклад, cmp.  

в) На третій сторінці у верхньому віконці прокруткою вибрати роз-
рядність у бітах порівнюваних слів на входах компаратора ‘dataa’ та 
‘datab’. Виходячи з максимально можливого числа (7) на виході суматора, 
яке подаватимемо на вхід‘dataa’ компаратора, вибираємо у нашому при-
кладі розрядність 3 біта. Відтак вибрати вихідну функцію компаратора 
встановленням прапорця a > = b (greater than or equal – більше або дорів-
нює), а інші прапорці мають бути зняті.  

г) На четвертій сторінці у верхній закладці на питання, чи має бути 
на вхідній шині ‘datab’ константа, дати ствердну відповідь (Yes) і ввести 
десяткове значення константи, наприклад, для порогового елемента “5 з 7” 
вводимо число 5. На питання про тип порівнюваних чисел слід залишити 
Unsigned (без знаку).  

ґ) П’яту і шосту сторінки слід проминути (Next), на сьомій, остан-
ній сторінці продивитися список сформованих файлів та натиснути кнопку 
Finish – у вікні Symbol з’явиться символ налаштованого різновиду мегафу-
нкції компаратора (скоригувати свої дії можна поверненням на попередні 
сторінки кнопкою Back).  

д) У вікні Symbol встановити прапорець Insert 
symbol as block (вставити символ як блок) та натисну-
ти кнопку ОК – це вікно зачиниться, а символ мега-
функції буде прив’язаний до покажчика миші. Для 
вставлення його до файлу блок-схеми клацнути в полі 

файлу (у разі потреби, натиснути інструмент вибору – стрілку, щоб звіль-
нити покажчик від символу) та піктограмою зберегти файл (зникне зірочка 
в рядку його заголовка).  

F Примітка: На символі зразка мегафункції відображено основні 
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параметри, тому команда Show Parameter Assignments (показати призна-
чення параметрів) і відповідний інструмент палітри для такого символу не 
діють. Продивитися параметри можна в текстовому файлі cmp.tdf.  

е) Відкрити і продивитися текстовий файл cmp.tdf створеного при-
мірника мегафункції та включити його до складу проекту: меню Project > 
Add Current File to Project.  

3.4 Вставити до блок-схеми макрофункцію. 
а) З метою індикації кількості одиничних сигналів, визначених су-

матором, вибрати з файлу ../3lab/3libr.bdf макрофункцію дешифратора се-
мисегментного коду з інверсними виходами і вставити його до файлу блок-

схеми. Для цього двічі клацнути в полі файлу (або натиснути ін-
струмент вставлення символу) і в діалоговому вікні Symbol розгор-

танням каталогу бібліотеки Libraries вибрати c:/quartus/libraries > others > 
maxplus2 > ім’я макрофункції, наприклад, 74246. Відтак встановити прапо-
рець Insert symbol as block (вставити символ як блок) та натиснути кнопку 
ОК – це вікно зачиниться, а символ макрофункції буде прив’язаний до по-
кажчика миші. Для вставлення його до файлу блок-схеми клацнути в полі 
файлу, та зберегти файл (зникне зірочка в рядку його заголовка).  

б) Настроїти пара-
метри макрофункції, для 

чого виділити (у разі потреби) її сим-
вол і натиснути інструмент Properties 
(властивості) для виклику діалогового 
вікна Block Properties (або В2 > Block 
Properties). З огляду на те, що в при-
кладі не використовуватимемо вхід га-
сіння BIN та входи і вихід керування 
RBIN, LTN, RBON, їх слід вилучити з 
блоку. Для цього на вкладці I/Os (вхо-
ди/виходи), у розділі Existing block 
I/Os (існуючі входи/виходи блоку) ви-
ділити рядок BIN і натиснути кнопку 
Delete (видалити). Так само вилучаємо 

інші зазначені виводи та натискаємо кнопку ОК – зміни переносяться на 
символ файлу блок-схеми. Кнопкою B2 > AutoFit нормалізуємо розмір 
блоку. У разі потреби, так само вставити до файлу блок-схеми інші макро-
функції повторенням п. 3.4.  

3.5 Вставити до блок-схеми примітиви і ввести імена портів. 
а) Вставити звичайним чином до файлу блок-схеми логічний 

елемент І-НЕ (c:/quartus/libraries > primitives > logic > nand2) та вхід-
ні і вихідні порти (c:/quartus/libraries > 
primitives > pin > input або output).  

б) Дати імена входам і виходам, 
для чого викликати діалогове вікно Pin 
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Properties (властивості виводу): двічі клацнути символ порту (або виділити 
символ і натиснути інструмент Properties, або клацнути В2 по символу > 
Properties). Відтак на вкладці General (загальні) до рядка Pin name(s) ввести 
ім’я сигналу, наприклад, sw1[7..1] та натиснути кнопку ОК. Повторенням 
цих дій дати імена всім виводам ІС. 

VCC
sw1[7. .1] IN PU T

VCC
sw2[1] IN PU T

y o[7..0]OU TPU T

VD[2..16]OU TPU T

VD[1]OU TPU T
NAN D2

inst2

74246

inst5

B INPUT
A INPUT
C INPUT
D INPUT
OD OUTPUT
OC OUTPUT
OB OUTPUT
OE OUTPUT
OF OUTPUT
OA OUTPUT
OG OUTPUT

I/O Type

cmp

inst1

dataa[2..0] INPUT
ageb OUTPUT

I/O Type

600sum

inst

sw 1[7..1] INPUT
dataa[3..0] OUTPUT

I/O Type

Дешифратор 7-сегм. коду
Суматор

Компаратор (мегафункція)

(макрофункція)

Лог. елемент
(примітив)

(блок  або символ)

y d[7..0]OU TPU T

 
 

3.6 Виконати з’єднання компонентів блок-схеми. 
а) Інструментом ортогональних шин (Orthogonal Bus Tool) 

провести шини між групою вхідних портів sw1[7..1], блоками 
600sum та 74246 і групою вихідних портів yd[7..0]. Крім того, вивести ши-
ну зі входів компаратора cmp для подальшого з’єднання з блоком 600sum, 
а також для погашення невикористовуваних свтлодіодів і знакомісця інди-
катора з’єднати порти VD[2..16] та yо[7..0] з примітивами VCC  (див. ілюс-
трацію нижче).   

 б) Інструментом ортогональних ліній (Orthogonal Node Tool) 
з’єднати входи елемента І-НЕ з виходом компаратора cmp і портом 
sw2[1], а його вихід – з портом VD[1] та зберегти файл.   
F Примітки: 
1) Для зручності виконання з’єднань доцільно нанести сітку з меню 

View > Show guidelines (позиціонування елементів у графічному редакторі 
завжди є прив’язане до сітки, а в символьному редакторі це можна зробити 
з меню Tools > Options > Block / Symbol Editor > Snap to grid > OK).  

2) Більшість з’єднань можна виконати інструментом вибору і 
гнучкого рисування Selection and Smart Drawing Tool (стрілка), який 

автоматично перемикається на рисування необхідних ліній при підведенні 
його до компонентів, блоків або виконаних з’єднань. 

3) Під час з’єднання лінії з блоком на його облямівці з’являється 
символ трасувальника (Mapper). 
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VCC
sw1[7. .1] INPUT

VCC
s w2[1] INPUT

y o[7..0]OUTPUT

VD [2..16]OUTPUT

y d[7..0]OUTPUT

VD [1]OUTPUT

NAND2

inst2

VCC

VCC

VC
C

74246

ins t5

B INPUT
A INPUT
C INPUT
D INPUT
OD OUTPUT
OC OUTPUT
OB OUTPUT
OE OUTPUT
OF OUTPUT
OA OUTPUT
OG OUTPUT

I/O Type

c mp

inst1

dataa[2..0] INPUT
ageb OUTPUT

I/O Type

600sum

ins t

sw 1[7..1] INPUT
dataa[3..0] OUTPUT

I/O Type

Дешифратор 7-сегм. коду
Суматор

Компаратор (мегафункція)

(макрофункція)

Лог . елемент
(примітив)

(блок або символ)

 
 

3.7 Виконати розведення сигналів між блоками. 
а) Якщо з’єднувальна лінія має таку саму назву, що й вхід або вихід 

блоку (подані  на мапі всередині блоку), то вона приєднується до цього ви-
воду (Connection by name – з’єднання іменами). Щоб з’єднати іменами вхі-

дні сигнали sw1[7..1] зі входами 
блоку 600sum, необхідно двічі 
клацнути шину (або клацнути 
кнопкою В2 і в контекстному 
меню вибрати Properties, або 
виділити шину і натиснути на 
панелі інструмент Properties). У 

діалоговому вікні Bus Properties (властивості шини) на вкладці General (за-
гальні), у віконці Name (ім’я) ввести назву шини sw1[7..1] та натиснути 
ОК. Так само з’єднати іменами вихід блоку 600sum із шиною dataa[3..0], 
вихід компаратора cmp зі входом елемента І-НЕ введенням у діалоговому 
вікні Node Properties (властивості лінії) ім’я лінії ageb. Інший вхід елемента 
І та його вихід з’єднано з портами безпосередньо лініями, які не потребу-
ють введення імен (див. рис. Д4 у додатках). 

б) Якщо імена двох ліній збігаються, то вони з’єднуються автомати-
чно (Smart), без рисування з’єднань. Такий тип з’єднання можна створити 
між виходами блоку 600sum і входами блоку cmp наданням відповідним ши-
нам однакової назви. У прикладі шина dataa[2..0] автоматично з’єднується з 
однойменними розрядами шини dataa[3..0] (див. рис. Д4 у додатках). 

в) Якщо імена входів/виходів на мапі блоку і з’єднувальних ліній рі-
зні, то розведення сигналів виконують за допомогою трасувальників 
(Mappers). Для з’єднання розрядів шини dataa[3..0] зі входами блоку 74246 
слід підвести інструмент вибору об’єктів до трасувальника в місці з’єднання 
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шини із цим блоком і, коли біля 
стрілки з’явиться символ таб-
лиці, двічі клацнути трасуваль-
ник (або B2 > Mapper 
Properties). У діалоговому вікні 
Mapper Properties (властивості 
трасувальника) на вкладці 
General (загальні) вибрати тип 
виводу стосовно даного блоку 
INPUT (вхід). На вкладці 
Mappings (трасування сигналів) 
у рядку I/O on block (вхід/вихід 
блоку) прокруткою вибрати 
вхід А, а в рядку Signals in bus 

(сигнали в шині) – dataa[3..0] виправити на dataa[0] та натиснути кнопку 
Add (додати). У віконці Existing mappings (існуючі трасування) відобразить-
ся з’єднання входу А з молодшим бітом шини. Так само з’єднати входи В, 
С, D з розрядами шини dataa[1], dataa[2], dataa[3] та натиснути кнопку ОК – 
результати відобразяться в трасувальній таблиці, прив’язаній до трасуваль-
ника. Аналогічним чином розвести сигнали на виходах блоку дешифратора 
74246 та зберегти зміни у файлі (див. рис. Д4 у додатках).  

F Примітки: 
1) Для погашення десяткової крапки на лінію yd[7] її сегменту інди-

катора подано лог. 1 (VCC).  
2) Під час утворення трасувальних таблиць символи трасувальника 

на входах і виходах набувають різного вигляду за напрямком стрілки і ко-
льором. 

3) Таблиці трасувань біля символів трасувальників відображаються 
або приховуються командою меню View > Show Mapper Tables. Трасувальні 
таблиці можна перетягнути в зручну позицію звичайним чином лівою кноп-
кою миші (або виділити і пересунути з клавіатури клавішами керування кур-
сором зі стрілками). Командою меню View >  Show Block I/O Tables можна 
відобразити або приховати мапи входів/виходів всередині блоків.  

4) Зображення лінії і тло блоку можна виділити кольором піктогра-
мою Properties на вкладці Format відповідного діалогового вікна. 

 
3.8 Імпортувати призначення виводів мікросхеми (див. Лаб. 

роботу №4, п. 5.2) з файлу ../4lab/MAX_pin. 
 
3.9 Виконати компіляцію і функціональне моделювання проекту 

та переконатися в правильності проектування.  
Приклад: 600POR_EL.bdf, .vwf. 
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3.10 Продивитися складники проекту: піктограмою 
Project Navigator (або з меню View > Utility Windows > Project 

Navigator) відкрити вікно навігатора і кнопкою Hierarchy внизу цього вікна 
перейти на вкладку ієрархії. Розгортанням (+) та згортанням (-) гілок ієрар-
хічного дерева спостерігати компоненти проекту. Подвійним клацанням по 
значках або іменах файлів розкрити їх і ознайомитися в загальних рисах зі 
змістом. Кнопкою Files внизу вікна перейти на однойменну вкладку і озна-
йомитися зі списком файлів, які відкриваються так само. Кнопкою Design 

Units внизу вікна 
перейти на вклад-
ку модулів проек-
ту, які відкрива-
ються так само, 
подвійним кла-
цанням. Відтак 
піктограмою наві-
гатора (або знач-
ком „х”) зачинити 
його вікно. 

 
3.11 Сформувати файл програматора і виконати фізичне про-

грамування мікросхеми (див. Лаб. роботу №3, п. 3.5, 3.6).  
Приклад: 600POR_EL.сdf. 
3.12 Розробити методику та виконати необхідні експеримента-

льні дослідження. Порівняти їх результати з даними проектних файлів, 
зробити висновки. 
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7 ЛАБОРАТОРНА РОБОТА №7. ТРИГЕРИ 
 

Мета роботи: дослідження основних типів тригерів і поширених 
радіотехнічних кіл на тригерах; засвоєння основ застосування тригерів у 
проектах, створення ієрархічного проекту на рівні блок-схеми з викори-
станням тригерів.  

 
ДОМАШНЄ ЗАВДАННЯ 

! Для заданого варіанту (див. Додатки, завдання 7) розробити 
лінію передачі даних із фіксацією вихідного коду на тригерах.  

 
СТИСЛІ ТЕОРЕТИЧНІ ВІДОМОСТІ 

Означення, класифікацію та схемну реалізація тригерів розглянуто 
в [2]. Основні типи асинхронних тригерів і синхронних тригерів зі статич-
ним керуванням (Latches) подано в табл. 1, а тригерів з динамічним керу-
ванням (Flipflops) – у табл. 2. Перетворення тригерів з динамічним керу-
ванням наведено на рис. 7.1. 

 

Таблиця 7.1 –Асинхронні і синхронні тригери зі статичним керу-
ванням 

Позначення Таблиця Тип ДЕСТУ САПР перемикальна переходів 

 
  

  

R S 
  

  

D 
    

(G = 1) 

RSG 
 

– 

 
 

(G = 1) 
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Таблиця 7.2 –Синхронні тригери з динамічним керуванням  
Позначення Таблиця Тип ДЕСТУ САПР перемикальна переходів 

D 
  

 
 

(C = ↑) 

DE 
    

(E = 1, C = ↑) 

JK 
  

 
 

(C = ↑) 
 

JKE 

  
 

 

 
(E = 1, C = ↑) 

T 
   

 

TE 
    

(C = ↑) 
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Рисунок 7.1 

 
КОНТРОЛЬНІ ЗАПИТАННЯ 

1. Наведіть а) перемикальну таблицю, б) таблицю переходів, в) ха-
рактеристичні рівняння в МДНФ та МКНФ відносно прямого та інверсно-
го виходів, г) логічні функції збудження для тригерів типу: 1) R, 2) S, 3) Е, 
4) RSC, 5) RC, 6) SC, 7) ЕС, 8) DС, 9) DCЕ, 10) ТЕ, 11) TЕ, 12) JKC, 13) 
JKC , 14) JKЕ, 15) асинхронний JK. 

2. Побудуйте граф перемикань та за допомогою позицій станів на 
схемі і часових діаграм схарактеризуйте швидкодію і вимоги щодо трива-
лості вхідних імпульсів і інтервалів часу, на яких заборонено змінювати 
вхідну інформацію для тригерів такого типу (через риску зазначено еле-
менти або схема, за якими складено тригер):  

а) асинхронних: 1) RS –  І-НЕ, 2) RS –  АБО-НЕ;  
б) синхронних, керованих рівнем: 3) RSC – І-НЕ, 4) RSC – АБО-НЕ, 

5) CSR  –І-АБО-НЕ, 6) RSC – І-АБО-НЕ, 7) DC – АБО-НЕ, 8) DC  –  І-
АБО-НЕ та НЕ, 9) DC –І-АБО-НЕ, 10) DC – І-НЕ, 11) DC  – АБО-НЕ, 12) 
D C  – АБО-НЕ;  

в) за схемою МS: 13) RSC - з інвертором,   14) JKC - із заборонени-
ми зв’язками,  15) Т - з різнополярним керуванням на синхронних RS-
тригерах, 16) D - з різнополярним керуванням на однофазних D-тригерах;  

г) за схемою трьох тригерів: 17) DC, 18) JK, 19) Т, 20) ТЕ;  
д) з імпульсно-потенціальним керуванням: 21) JKC, 22) DC, 23) ТЕ. 
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ЛАБОРАТОРНЕ ЗАВДАННЯ 
 
1 Дослідити основні типи тригерів.  
1.1 Дослідити асинхронний RS-тригер з інверсними входами (/RS-

тригер) на елементах І-НЕ: за принциповою електричною схемою та осци-
лограмами сигналів (файли 7asyn.bdf, .vwf) скласти таблиці відповідності 
(перемикальну) і переходів, мінімізовані рівняння вихідних функцій, 
виміряти затримку вихідних імпульсів; розглянути особливості побудови і 
перемикання макрофункції цього тригера та принципової схеми і макро-
функції асинхронного RS-тригера з прямими входами (RS-тригер). У звіті 
навести також умовне графічне позначення за ДСТУ таких тригерів зі 
стислим поясненням принципу їх дії та осцилограм сигналів.  

1.2 Дослідити синхронний D-тригер зі статичним керуванням 
(примітив Latch – тригер-зáскочка) на елементах І-НЕ за п. 1.1 (файли 
7stat.bdf, .vwf) та розглянути особливості побудови і перемикання макро-
функції    D-тригера та схеми синхронного RS-тригера (RSC-тригер). 

1.3 Дослідити синхронний JK-тригер з динамічним керуванням 
структури MS (схема 1) за п. 1.1 (файли 7dyn.bdf, .vwf); розглянути особ-
ливості побудови і перемикання базових примітивів JKFF, TFF i DFF (2, 3, 
4),       Т-тригера на основі D-тригера (5), макрофункції D-тригера expdff 
(6) та   Т-тригера на основі типової макрофункції JK-тригера (7).  

1.4 Ознайомитися з різновидами тригерів бібліотеки бази даних 
(файл 7lіbr.bdf): примітивами та макрофункціями (у тому числі вибраними 
ІС серії 74). У звіті навести також умовне графічне позначення за ДСТУ 
таких тригерів, пояснити призначення та особливості входів і виходів. 

2 Розглянути приклади застосування тригерів. 
2.1 Дослідити вимірювальний перетворювач на основі RS-тригера і 

детекторів фронтів (файли 7vymir.bdf, .vwf). У звіті навести схему, часові 
діаграми та пояснити спосіб перетворення різниці фаз між вхідними сигна-
лами в пачку імпульсів квантування.  

2.2 Дослідити антидеренчливий пристрій на основі RS-тригера 
(файли 7ander.bdf, .vwf). У звіті навести схему, часові діаграми та пояснити 
спосіб усунення деренчання фронтів вихідного сигналу Q2 внаслідок 
тремтіння контактів під час перемикання механічних перемикачів (на ви-
ході Q3 спостерігається деренчання фронтів).  

2.3 Дослідити селектор імпульсів на основі тригерів з динамічним 
керуванням (файли 7select.bdf, .vwf). У звіті навести схему, часові діаграми 
та пояснити спосіб виокремлення одиничного синхроімпульсу, першого з 
їх послідовності після натиснення нефіксованого ключа.  

2.4 Дослідити імпульсний фільтр на асинхронних тригерах і типовій 
макрофункції серії 74 (файли 7if.bdf, .vwf). У звіті навести схему, часові ді-
аграми та пояснити спосіб виокремлення інформаційного імпульсу х від 
коротких імпульсних завад за допомогою двох послідовностей імпульсів a, 
b тривалістю не нижче тривалості імпульсів завад.  
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3 Створити згідно із заданим варіантом на основі DE-тригерів 
фіксатор у паралельному коді вхідного слова, біти якого надходять до 
входів тригерів послідовно в часі.  

3.1 За допомогою програмного майстра 
New Project Wizard створити новий проект 

7ХХfixator на ІС родини MAX7000S (тип та інші параметри ІС можна не 
визначати), зібрати в графічному файлі фіксатор потрібної розрядності на 
примітивах DE-тригерів (директорія 
c:/quartus/libraries/primitives/storage/dffe), створити і вставити до файла зра-
зок мегафункції дешифратора адреси, виходи якого з’єднати зі входами 
дозволу тригерів, скомпілювати проект, створити файл часових діаграм, 
виконати функціональне моделювання та переконатися в правильності ро-
боти пристрою. 

Приклад: 700fixator.bdf, .vwf. 
3.2  Командою з меню File > Create / Update > Create Symbol Files for 

Current File створити символьний файл та відкрити його для перегляду (з 
типу файлів Graphic Files або Other Source Files). 

Приклад: 700fixator.bsf. 
4 Створити ієрархічний проект лабораторного макету на рівні 

блок-схеми для експериментального дослідження лінії передачі даних 
(ЛПД) з фіксацією вихідного коду на тригерах згідно з варіантом за-
вдання 7 (див. структурну схему і як взірець файл 700LPD.bdf – рис. Д5 у 
додатках).  

 
Від ДІП-перемикачів MAX_SW1 вхідне слово sw1[] у паралельному 

коді  надходить на інформаційні входи мультиплексора. Формувач адреси 
(лічильник) розгортає адресний код a[] в часі таким чином, що після кож-
ного натискання по черзі двох нефіксованих перемикачів MAX_PB1 і 
MAX_PB2 цей код збільшується на одиницю по колу: 0, 1, ... 7, 0, 1, ..., 
тобто змінюється в прикладі за модулем 8. Отже, у мультиплексорі відбу-
вається перетворення паралельного коду в послідовний, бо на його виході 
по черзі з’являються біти вхідного слова (для передачі інформації лінією 
зв’язку між віддаленими об’єктами). З інформаційного входу демультип-
лексора (який є стробовим входом дешифратора) на вихідному боці лінії 
тим же самим адресним кодом біти вхідного слова по черзі спрямовуються 
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до інформаційних входів тригерів у блоці фіксатора. Послідовно в часі, біт 
за бітом слово записується в розрядні тригери синхроімпульсами Clk, що 
надходять з формувача адреси.  

У такий спосіб послідовний код перетворюється в паралельний, от-
же, після n тактів (n – кількість розрядів коду) на виходах фіксатора вхідне 
слово sw1[] зчитується в паралельному коді. У разі потреби, тригери мож-
на обнулити натисненням і відтисненням ключа на вході очищення CLRN. 
Для індикації слова sw1[] в десятковій системі його двійковий код попе-
редньо перетворюється в тетради ДДК за допомогою перетворювача 
двійкового коду у двійково-десятковий. Кожна тетрада надходить на свій 
дешифратор 7-сегментного коду і подається на відповідне знакомісце 7-
сегмент-ного індикатора MAX_DIGIT. Якщо значення коду перевищує 99, 
для індикації потребується більше двох знакомісць (за кількістю тетрад 
ДДК), але в прикладі наявність сотні індикується світлодіодом D1 
(кількість сотень більше однієї можна індикувати у двійковій системі кіль-
кома світлодіодами).  

4.1 Визначити ім’я проекту 7ХХLPD, вибрати родину 
мікросхем MAX7000S та тип EPM7128SL84-7.  
4.2 Ввести до проекту мегафункції. 

а) Створити графічний файл для мультиплексора, дати 
йому ім’я, наприклад, mx із включенням до проекту (у вікні 
збереження підняти прапорець Add file to current project). За 

допомогою програмного майстра MegaWizard Plug-In Manager створити 
потрібний різновид мегафункції, наприклад, mux7_1 і вставити його до 
файла, ввести вхідні і вихідний порти, об’єднати входи до шини, дати пор-
там імена та зберегти зміни у файлі із включенням його до проекту.  

б) Командою з меню File > Create / Update > Create Symbol Files for 
Current File створити символьний файл та відкрити його для перегляду (з 
типу файлів Graphic Files або Other Source Files). 

Приклад: mx.bdf, .bsf, mux7_1.tdf. 
в) Аналогічним чином створити і ввести до складу проекту по-

трібний різновид мегафункції демультиплексора. 
Приклад: dmx.bdf, .bsf, dmx1_7.tdf. 

4.3 Створити файл блок-схеми і вставити до нього у ви-
гляді блоків символи мультиплексора і демультиплексора за 

п.4.2, фіксатора 7ХХfixator.bsf за п. 3, формувача адреси з файла D:/quar-
tus6.1work/9lab/9addr.bdf (у разі необхідності змінити розрядність адресно-
го коду слід у файлі-зразку 700LPD клацнути символ 9addr кнопкою В2 > 
Open Design File, перенести його схему до свого нового файла, внести 
зміни і зберегти із включенням до проекту та створити символ), а також 
перетворювача двійкового коду у двійково-десятковий (у вікні Symbol на-
тиснути кнопку огляду та вибрати символ ../3lab/Bin8_BCD). Відтак вста-
вити у вигляді блоків символи макрофункцій дешифратора 7-сегментного 
коду (до нового графічного файла вставити макрофункцію та вхідний і ви-
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хідний порти, згорнути сигнали до шин, зберегти файл із включенням до 
проекту та створити символ), а також ввести вхідні і вихідні порти та, у ра-
зі потреби, додаткові елементи.  

4.4 З’єднати компоненти блок-схеми і розвести 
сигнали між блоками (див. Лаб. роботу №6, п. 3.6, 3.7). 

4.5 Імпортувати призначення виводів мікросхеми (див. Лаб. 
роботу №4, п. 5.2) з файлу ../4lab/MAX_pin та скоригувати їх. 
Приклад: 700LPD.bdf. 

4.6 Переконатися, що в проекті блок-схеми описано всі 
його складники (інакше відсутні додати, а зайві вилучити), ви-

конати компіляцію проекту і налагодити його в разі виявлення помилок, 
переглянути застереження у вікні повідомлень та врахувати або знехтувати 
їх залежно від наслідків.  

4.7 Виконати функціональне моделювання та перекона-
тися в правильності проектування пристрою. 

Приклад: 700LPD.vwf. 
 4.8 Відкрити вікно програматора, визначити режим програ-

мування, зберегти CDF-файл та виконати фізичне програмування 
мікросхеми. 

4.9 Розробити методику і виконати необхідні експериментальні 
дослідження. Порівняти результати досліджень з даними проектних фай-
лів, зробити висновки.  
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8 ЛАБОРАТОРНА РОБОТА №8. РЕГІСТРИ 
 

Мета роботи: дослідження типових регістрів; побудова ЦПП на 
основі регістрів; засвоєння основ застосування регістрів у проектах, вико-
ристання шаблону оголошення регістрів (Register Declaration); визначення 
швидкодії за допомогою регістрового дисплея; засвоєння основ побудови 
послідовнісного пристрою як скінченного автомата.  

ДОМАШНЄ ЗАВДАННЯ 
! Спроектувати на основі регістра зсуву ЦПП згідно з варіантом 

завдання 8 (див. Додатки). 
 

СТИСЛІ ТЕОРЕТИЧНІ ВІДОМОСТІ 
Означення і класифікацію регістрів, принцип побудови та схемну 

реалізацію паралельних регістрів і регістрів зсуву розглянуто в [2], основні 
їх типи зведено в табл. 8.1, 8.2 (у кінці розділу).  Тут наведемо методику 
проектування ЦПП на основі регістрів зсуву.  

 
1 Генератори цифрових кодів і розподільники  
Крім зберігання інформації і виконання арифметичних операцій 

регістри застосовуються в цифрових системах радіотехніки та зв’язку, об-
числювальної техніки, автоматики тощо для діагностування і корекції по-
хибок цифрових пристроїв, у колах їх керування і синхронізації, мікропро-
грамного керування вузлами шляхом розподілу перемикальних сигналів у 
певну кількість каналів і т. ін.  

Для розв’язання подібних задач використовуються генератори ко-
дової послідовності (ГКП) та розподільники імпульсів і рівнів (РІР). Серед 
різного типу ГКП здобули поширення генератори псевдовипадкових чисел 
і генератори зі сталими кодами, в яких сполучення нулів та одиниць у роз-
рядах регістра залишається незмінним. На основі останнього типу ГКП бу-
дуються і РІР, які за видом сигналів поділяють на розподільники рівнів 
(РР), в яких активна величина потенціалу (лог. 1 або 0) діє протягом такту 
синхроімпульсів, та розподільники імпульсів (РІ), в яких активний сигнал 
триває протягом синхроімпульсу. Проте з точки зору схемотехніки роз-
подільники є комбіновані, бо РІ утворюють з РР.  

Згадані пристрої циклічної дії, що ґрунтуються на кодах зі сталим 
сполученням нулів і одиниць, можна побудувати на тригерах або на 
регістрах зсуву. Достатньо попередньо записане певне слово зсувати в 
кільцевому регістрі для отримання на його виходах періодично повторю-
ваної послідовності чисел, яка і правитиме за вихідні сигнали ГКП та РІР. 
Просування через розряди регістра періодично повторюваної по-
слідовності символів, наприклад, 000111000111... для стислості зручно по-
значити періодом у дужках: (000111). При цьому значення кодів N на ви-
ходах кільцевого регістра залежать від кількості його розрядів n. Так, про-
суванням праворуч наведеної послідовності символів через дворозрядний 
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регістр (n = 2) на його виходах утворюватимуться коди N = Q1Q0 = 00, 00, 
01, 11, 11, 10, які далі повторюються. Стисло це можна позначити в десят-
ковій системі кодів як  N = (000111) = 0, 0, 1, 3, 3, 2. Детерміновані коди 
послідовності мають бути різними, тому дворозрядний регістр є неприй-
нятний для її формування, адже серед кодів є однакові. Розрядність 
регістра збільшують, поки не впевнюються, що серед вихідних кодів немає 
однакових, таку величину n і беруть за мінімальну. Так, просуванням цієї ж 
послідовності через трирозрядний регістр утворюються коди N = Q2Q1Q0 = 
(000111) = 0, 1, 3, 7, 6, 4, які є різні, отже, мінімальна кількість розрядів 
становить n = 3. Кількість різних кодів, що періодично повторюються на 
виходах ЦПП, називається його модулем. Зі збільшенням розрядності 
змінюються значення кодів, але їх кількість залишається незмінною, мо-
дуль визначається лише кількістю символів послідовності. 

Замість попередньо записувати слово до кільцевого регістра, в ГКП 
і РІР формують послідовність символів запровадженням зворотного 
зв’язку між розрядами регістра. В ІС регістра зсуву приступним є лише 
вхід послідовного введення, тому зв’язок здійснюють між цим входом і 
виходами регістра за допомогою комбінаційних кіл. 

 
2 Проектування ГКП  
Вважатимемо заданою послідовність символів, яку легко визначити, 

виходячи з міркувань потрібних модуля, послідовності вихідних кодів, часо-
вих діаграм тощо. Для прикладу розглядатимемо послідовність символів з 
періодом (000111). Проектування можна виконати в такому порядку. 

1) Визначаємо модуль М = 6, що дорівнює кількості символів у по-
слідовності, та мінімальну кількість розрядів ГКП, яка становить n = 3, бо 
при  n = 2, як зазначено вище, деякі з вихідних кодів будуть однаковими.  

Для наочності будуємо робочий цикл перемикального графу ГКП. 
Під час зсуву числа з послідовності символів на один крок у бік старших 
розрядів значення початкового коду N = Q2Q1Q0 подвоюється (наприклад, 
001 → 010) і до молодшого розряду додається ще наступний символ xN по-
слідовності, тобто з надходженням чергового синхроімпульсу матимемо 
код  N+ = 2N + xN. Але якщо є одиниця в старшому розряді, у наступному 
такті зсуву вона зникає, тому її вагу 2n-1 перед подвоєнням треба відняти. 
Отже, наступний код можна визначити з виразу:  

N+ = 2N + xN, якщо N <  2n-1; N+ = 2(N  –  2n-1 ) + xN, якщо N ≥ 2n-1.     (8.1) 
Так, у прикладі при n = 3 перший код утворюється трьома нулями 

послідовності символів (000111), тобто N = Q2Q1Q0 = 0. Другий код 
N+=2⋅0+1=1, бо N < 4 і наступний символ послідовності xN = 1; так само 
третій код становить N+ = 2⋅1 + 1 = 3 і т.д. Після останнього символу з 
періоду послідовності переходимо до його початку. У підсумку визначаємо 
робочий цикл N = Q2Q1Q0 = (000111) = 0, 1, 3, 7, 6, 4, який відображаємо 
перемикальним графом (рис. 8.1,а). 

F Примітка: Робочий цикл можна визначити і безпосередньо з по-
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слідовності символів 000111000111... просуванням по ній трьох розрядів, 
але це не зручно для великих модулів і, як буде видно з подальшого, для 
побудови повного графу. 

 
Рисунок 8.1 – Проектування ГКП 

 

2) Мінімізуємо функцію збудження по входу послідовного введення 
SER, який для регістра прямого зсуву є входом молодшого розряду, отже, 
для регістра на D-тригерах функція має вигляд SER = Q0

+ . Тому діаграму 
термів (Вайча-Карно) можна побудувати і без таблиці відповідності (за ба-
гатьох розрядів така таблиця стає неозорою). Виходимо з того, що парні 
коди N = Q2Q1Q0 закінчуються на 0, а непарні – на 1, тому в клітинку діаг-
рами з номером N вписуємо значення Q0

+ = 0, якщо наступний код робочо-
го циклу є парний, і Q0

+ = 1, якщо непарний. Так, на діаграмі рис. 8.1,б но-
мери клітинок відповідають станам N = Q2Q1Q0, що є вершинами робочого 
циклу графу, тому до нульової клітинки N = 0 вписуємо 1, бо наступний 
код N+ = 1 є непарний; переходимо до вершини N = 1 і вписуємо до 
клітинки з цим номером також одиницю, бо наступний код  N+ = 3 теж є 
непарний і т. д. У підсумку заповнюємо шість клітинок відповідно до ро-
бочого циклу, а в двох порожніх клітинках функція має факультативні зна-
чення, бо у станах, що їм відповідають, за нормальної роботи пристрій не 
перебуває. Мінімізуючи звичайним чином, отримуємо функцію збудження  

2QSER = .                                                (8.2) 
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3) Перевіряємо функціонування пристрою, якщо випадково 
(внаслідок збою, дії завади або по ввімкненні джерела живлення) він опи-
ниться в хибному стані поза межами робочого циклу. Пристрій, що автома-
тично за кілька тактів повертається до робочого циклу, є самовідновний, 
інакше – несамовідновний. З метою перевірки на самовідновність будуємо 
повний перемикальний граф. Для цього беремо будь-який стан поза робочим 
циклом і за (1) визначаємо наступний стан, але значення  xN  підставляємо те-
пер з діаграми термів: для тих кодів, які згідно з виконаною мінімізацією 
входять до об’єднань одиниць, xN = 1, а для всіх інших xN = 0. Так, зі стану 
N=2 з надходженням синхроімпульсу ГКП перейде до стану N+=2⋅2+1=5, бо 
N< 4 і xN = 1, а зі стану N = 5 повернеться до N+=2(5–4)+0=2, тобто замкнеться 
хибний цикл (рис. 1,в) з модулем 2, отже, ГКП є несамовідновний. 

Такий ГКП, реалізований згідно з (2) на регістрі зсуву з перехресним 
зворотним зв’язком та інвертуванням біта старшого розряду, який нази-
вається також лічильником Джонсона (рис. 8.1,г), функціонує за часовими 
діаграмами на рис. 1,ґ. З метою випробування регістр керується сигналом 
MODE = LD/SHN (завантаження/зсув): при MODE = 0 він функціонує як 
регістр зсуву, а при MODE = 1 з надходженням синхроімпульсу до нього за-
вантажується в паралельному коді слово зі входів d[2..0], яке імітує збій з пе-
реходом до хибного стану. З діаграм видно, що в кожному розряді відповідно 
до тактів синхроімпульсів за нормальної роботи пристрою просувається по-
слідовність символів по три нулі і три одиниці поспіль (отже, безпосередньо з 
діаграми легко записати період послідовності символів). Зі зсувом у розрядах 
ці послідовності утворюють вихідні коди згідно з робочим циклом графу, але 
після збою послідовність порушується і пристрій не в змозі самостійно вийти 
з хибного циклу. 

4) Відновити нормальну роботу пристрою можна двома шляхами: а) 
коли регістр потраплятиме до хибного циклу, примусово встановити один 
зі станів робочого циклу (у прикладі можна обнулити) або б) скоригувати 
функцію збудження таким чином, щоб хибні цикли не утворювалися.  

У ГКП застосовують другий шлях, тому з метою надати властивість 
самовідновлення пристрою коригуємо функцію збудження. Для цього без 
зміни робочого циклу необхідно розірвати хибний цикл (або всі хибні цик-
ли, якщо їх декілька) зміною, принаймні, одного з переходів останнього. 
Якщо перевизначити п’яту клітинку одиницею (помічена зірочкою на   
рис. 8.2,а), дістанемо нову функцію збудження 

210210 QQQQQQSER =+= .                                      (8.3) 
За наявності інших варіантів розглядаємо їх і вибираємо функцію 

меншої складності (у прикладі варіант довизначення другої клітинки ну-
лем є рівноцінний, але в мішаному елементному базисі).  
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Рисунок 8.2– Проектування ГКП (розірвання хибного циклу) 
 

Враховуючи нові значення символів xN  після останньої мінімізації, 
будуємо так само скоригований повний перемикальний граф (рис. 8.2,б) і 
переконуємось, що при новій функції збудження ГКП є самовідновний,  
інакше добираємо інші варіанти перевизначення факультативних клітинок. 
Згідно з (3) коригуємо схему ГКП (рис. 8.2,в) і так само випробовуємо її 
шляхом переведення сигналом MODE до хибного стану (рис. 8.2,г). Як ба-
чимо, за два такти ГКП автоматично повертається до робочого циклу. У 
випадку необхідності скоротити самовідновлення до одного такту по-
трібно інакше довизначити факультативні значення функції (тут: всі кліти-
нки).  

 
3 Проектування розподільників  
ГКП, в яких період послідовності символів містить лише одну оди-

ницю, і є найпростішим типом розподільників рівнів. Записана до одного 
розряду одиниця циркулюватиме в кільцевому регістрі, утворюючи в кож-
ному такті активний рівень по черзі в каналах розподільника. Тому й мето-
дика проектування РР аналогічна методиці проектування ГКП. 
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Рисунок 8.3 – Проектування РР 

 
1) Задана кількість каналів РР n визначає і кількість розрядів регіст-

ра n та період послідовності з n символів, серед яких є одна одиниця, а ре-
шта нулі. Наприклад, для триканального РР період становитиме (001). Як-
що в каналах є паузи між тактами або, навпаки, активний рівень є в кількох 
тактах поспіль, період визначаємо за потрібними часовими діаграмами так 
само, як і в ГКП. Відтак будуємо робочий цикл перемикального графу за 
виразом (1) або безпосередньо з послідовності символів (рис. 8.3,а). 
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2) Користуючись цим графом, будуємо діаграму термів (рис. 8.3,б) і 
мінімізуємо функцію збудження для входу послідовного введення 

2QSER = .  
3) З метою перевірки на самовідновність будуємо повний переми-

кальний граф (рис. 8.3,в), який у прикладі крім робочого містить три хибні 
цикли: один за модулем 3, але з неправильним розподілом імпульсів, та 
два стани (0 і 7), з яких розподільник не зможе вийти самостійно у випадку 
потрапляння до них. Отже, пристрій є несамовідновний. 

4) Коригуємо функцію збудження (рис. 8.3,г) з метою надати вла-
стивості самовідновлення пристрою: 

1010 QQQQSER +== ,                                              (8.4) 
будуємо скоригований повний перемикальний граф (рис. 8.3,ґ), пе-

реконуємось, що при новій функції збудження пристрій є самовідновний та 
згідно з (4) складаємо схему РР (на рис. 8.3,д частина без урахування ви-
ходів уi). 

У кожному такті активний рівень лог.1 (у випадку інверсних сиг-
налів – лог. 0) діє тільки на одному з виходів Qi  (на рис. 8.3,е інтервал до 
появи сигналу MODE = 1), тому пропусканням синхроімпульсів через еле-
менти збігу І легко утворити розподільник імпульсів (на рис. 8.3,д,е частина 
по виходах уi). Аби синхроімпульси не потрапляли на краї сигналів Qi, їх 
можна затримати за допомогою додаткових логічних елементів (у прикладі 
– буфер LCELL). 

Штучним переведенням розподільника до хибного стану сигналом 
MODE (див. рис. 8.3,е) шляхом паралельного завантаження регістра пере-
конуємось, що за один або два такти після збою пристрій автоматично  по-
вертається до робочого циклу – так само, як на повному перемикальному 
графі. 

 
4 Перетворення ГКП у розподільники  
Перевагою розглянутого типу розподільників є простота і висока 

швидкодія, а недоліком – велика розрядність регістра і, крім того, для роз-
подільників імпульсів ще велика потрібна кількість двовходових елементів 
І, що може виявитися неприйнятним для побудови багатоканальних РІ та 
РР. Послабити цей недолік можна шляхом перетворення у розподільники 
ГКП з модулем, удвічі більшим за розрядність регістра. З огляду на те, що 
всі вихідні коди ГКП є різні, шляхом їх дешифрування дістанемо кількість 
каналів розподільника, яка дорівнює модулю ГКП. Розглянемо порядок за-
значеного перетворення.  

1) Вибираємо модуль М ГКП, що відповідає потрібній кількості 
каналів розподільника, отже, і кількості символів у періоді їх послідовності 
та за методикою п. 2 проектуємо ГКП. Наприклад, для шестиканального 
РР задаємося періодом (000111) і одержуємо ГКП як у п. 2 (відповідає 
схемі і часовим діаграмам відносно виходів Qi  на рис. 8.4,а,б).   



 110 

 
Рисунок 8.4 – Перетворення ГКП у розподільник 

 

2) На виходах ГКП утворюється двійковий код Q[2..0], а РР має за-
безпечити рівень лог. 1 протягом такту тільки в одному каналі, що 
відповідає унітарному кодові на його виходах. Отже, завдання полягає в 
перетворенні двійкового коду в унітарний. Таку операцію, як відомо, 
здійснює дешифратор. Відповідно до розрядності вихідного коду ГКП n = 
3 вибираємо двійковий дешифратор 3:8 (див. рис. 8.4,а без урахування 
стробового входу G1). 

3) Визначаємо канали РР згідно з черговістю з’явлення в них актив-
ного рівня. Повний дешифратор 3:8 має вісім виходів, кожний з яких ак-
тивізується відповідно до вхідного адресного коду, відображеного робо-
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чим циклом перемикального графу (див. рис. 8.4,а). Тому два виходи з но-
мерами хибних станів (2 і 5) не використовуються, а інші шість каналів у1... 
у6 нумеруємо в порядку активізації їх у часі згідно з переходами графу. У 
підсумку отримуємо РР (схема на рис. 4,а по виходах у1... у6), який функці-
онує за часовими діаграмами на інтервалі R/IN = 1 на рис. 8.4,б: на виходах 
у1... у6 по черзі протягом такту діє рівень лог. 1. 

4) З’єднанням каналів РР у1... у6  з елементами І та пропусканням 
через них синхроімпульсів можна отримати РІ так само, як на рис. 8.3,д. 
Проте доцільно скористатися стробованим дешифратором, який виконує 
функцію демультиплексора, якщо на стробовий вхід (G1 на рис. 8.4,а) по-
дати синхроімпульси. Комбінований розподільник утворюється з додатко-
вим елементом АБО: керувальним сигналом G1 = R/IN = 1 дешифратор стає 
перетворювачем до унітарного коду і пристрій функціонує як РР, а за рівня       
R/IN = 0 елемент АБО пропускає синхроімпульси на вхід G1 і демульти-
плексор комутує їх до каналів у1... у6, тому пристрій функціонує як РІ (див. 
рис. 8.4,б). Як і ГКП, перевірити розподільник на самовідновність можна 
за допомогою сигналу MODE.  

 
5 Особливості побудови реверсивних ГКП  і розподільників  
У випадку необхідності змінювати напрямок надходження кодів з 

виходів ГКП та сигналів у каналах розподільників природним є застосу-
вання реверсивних регістрів в основі побудови таких пристроїв. Розгляд 
почнемо з ГКП, бо на них ґрунтуються й розподільники та для наочності й 
стислості зупинимося на тому самому прикладі послідовності символів з 
періодом (000111), що й у п. 2. Основа проектування реверсивного ГКП 
така сама, як і односпрямованого, тому достатньо відзначити лише її особ-
ливості. 

1) Вважаючи ГКП односпрямованим, розрядність регістра n = 3 ви-
значаємо так само і за відсутністю трирозрядних вибираємо чотирирозряд-
ний реверсивний регістр (символ SHIFT REG. на рис. 8.5,а). Керувальним 
кодом S[1..0] = 1 утворюється регістр прямого зсуву (праворуч) зі входом 
послідовного введення SRSI, а кодом S[1..0] = 2 – у регістр зворотного зсу-
ву (ліворуч) зі входом послідовного введення SLSI.  

2) Визначаємо виходи регістра, на яких формується потрібна кодова 
послідовність. Виходимо з того, що для побудови односпрямованого ГКП 
на кільцевому регістрі з прямим зсувом необхідно, як і раніше, зворотний 
зв’язок здійснювати через вхід молодшого розряду SRSI, а виходами при-
строю є виходи трьох молодших розрядів Q[2..0] = (QC, QB, QA). Для зво-
ротного зсуву доступ є тільки до входу старшого розряду SLSI з виходом 
QD, отже, у трирозрядному регістрі необхідно використовувати виходи 
Q[2..0] = (QD, QC, QB). 
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Рисунок 8.5 – До особливостей побудови реверсивних ГКП  і роз-

подільників 
 
3) Формуємо вихідну шину ГКП Q[2..0], з якої знімається 

змінювана за напрямком кодова послідовність. Аби спрямувати пряму та 
зворотну послідовності до цієї шини, потрібно перемикати виходи 
регістра, що можна здійснити логічними елементами, але найдоцільніше 
скористатися мультиплексорами (в одному корпусі стандартних ІС мі-
ститься по чотири мультиплексори 2:1 зі спільним адресним входом SEL). 
У прикладі за адресний вхід може правити розряд S1, який перемикає до 
виходів Yi під час прямого зсуву рівнем S1 = 1 входи Аі, а під час зворотно-
го зсуву рівнем S1 = 0 – входи Ві. Після зазначених з’єднань входів мульти-
плексора схему (див. рис. 8.5,а) можна уявляти еквівалентним трирозряд-
ним регістром відносно виходів Q[2..0] та входів послідовного введення. 
Внаслідок цього для утворення реверсивного кільцевого регістра достат-
ньо з’єднати SRSI = Q2  та SLSI = Q0. 

4) Проектуємо односпрямований самовідновний ГКП за п. 2 і отри-
муємо схему з коригувальним ЦКП у колі зворотного зв’язку (див. 
рис. 8.2,в), який переносимо на нашу схему (елемент НЕ та два нижні еле-
менти І-НЕ). Цілком зрозуміло, що проектувати такий самий ГКП зворот-
ного напрямку немає сенсу, адже якщо перейменувати розряди, регістр 
зворотного зсуву перетворюється на регістр прямого зсуву. У нашому ви-
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падку достатньо поміняти місцями розряди Q2 і Q0 для коригувального 
ЦКП у регістрі зворотного зсуву (елемент НЕ і два верхні елементи І-НЕ). 
Природно, у регістрах більшої розрядності слід змінювати на протилежну 
всю нумерацію від старшого розряду до молодшого. 

 
Рисунок 8.6 

 
5) Через це робочі цикли перемикального графу (на рис. 8.5,а) при 

прямому (суцільні лінії) та зворотному (пунктирні лінії) зсуві перетворю-
ються один в одного, якщо коди станів в одному графі читати в прямому 
напрямку, а в іншому – у зворотному. Наприклад код 110 = 0012 при чи-
танні у зворотному напрямку перетворюється на 410 = 1002. Взаємо-
зворотними є і коди 3 та 6, тому перехід від хибних станів 2, 5 (через си-
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метричність читаються однаково в обох напрямках) відбувається в одному 
графі до стану 3, а в іншому – до стану 6 (зображено суцільною та пунк-
тирною лініями). 

6) Перемикання напрямку кодової послідовності сигналом  S[1..0] 
наведено на часових діаграмах рис. 8.5,б. Для випробування ГКП на само-
відновність сигналом  S[1..0] = 3 у паралельному коді до регістра запи-
сується відповідно до найгіршого хибного стану число 210 = 0102, яке при 
прямому зсуві слід подати до розрядів C, B, A, а при зворотному зсуві – до 
розрядів D, C, B. Відносно групи паралельного введення в останньому ви-
падку воно становитиме d[3..0] = (D, C, B, А) = 01002 = 410 (цей код відоб-
ражено на епюрі). 

7) Перетворення реверсивних ГКП у розподільники можна викона-
ти так само, як і односпрямованих ГКП (див. п. 4). Якщо згорнути схему 
реверсивного ГКП (див. рис. 8.5,а) до символу (gkp0 на рис. 8.6,а), то 
утворюється типова структура такого перетворення. При керувальному 
сигналі R/IN = 1 пристрій функціонує як реверсивний РР, а при R/IN = 0 – 
як реверсивний РІ. Часові діаграми (рис. 8.6,б) наведено для режиму РІ. 

8) Проектування простих реверсивних розподільників на основі 
ГКП з періодом послідовності символів, серед яких є лише одна одиниця, 
здійснюється за п. 3 з урахуванням особливостей, зазначених у п. 5.1 ... 5.6. 
Приклад односпрямованого розподільника, розглянутий у п. 3, для ревер-
сивного РІР ілюструється на рис. 7(самостійно доповніть його робочий 
цикл для утворення повного перемикального графу). Фрагменти випробу-
вання щодо самовідновності такого РІР наведено на рис. 8.7. 

 

 
Рисунок 8.7 – Фрагменти випробування РІР щодо самовідновності 
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КОНТРОЛЬНІ ЗАПИТАННЯ 
1 Тригери якого типу керування можна застосовувати в паралель-

них регістрах і регістрах зсуву? 
2 Побудуйте на тригерах: а) JK-, б) RS-, в) D-типу такий трирозряд-

ний регістр:    1) паралельний, 2) зсуву (послідовно-послідовний), 3) пара-
лельно-послідовний, 4) послідовно-паралельний, 5) реверсивний, 6) кіль-
цевий, 7) універсальний, 8) буферний з трьома станами виходу.   

3 Користуючись умовними графічними позначеннями, складіть з ІС  
4-розрядних регістрів схему 12-розрядного регістра: а) паралельного, б) 
зсуву.  

4 Перетворіть трирозрядний паралельний регістр у регістр зсуву. 
 
Таблиця 8.1 – Макрофункції послідовнісних пристроїв 
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Таблиця 8.2 – Мегафункції послідовнісних пристроїв 
Символ Основні параметри 

 

lpm_latch/lpm_ff – паралельні регістри 
зі статичним/динамічним керуванням;  
lpm_shiftreg – регістр зсуву 
(універсальний реверсивний регістр):   
LPM_WIDTH – розрядність вхідної 
data[] і вихідної q[] шин; 
LPM_AVALUE/LPM_SVALUE – кон-
станта для асинхронного/синхронного 
завантаження; 
LPM_FFTYPE – тип тригерів: DFF або 
TFF; 
LPM_DIRECTION – напрямок зсуву: 
ліворуч/праворуч ("LEFT"/"RIGHT"); 
асlr/sclr, aset/sset – входи асинхронно-
го/синхронного скидання до q+[] = 0...0 
та  передустановлення до q+[] = 1...1 або 
до q+[] = LPM_(A/S)VALUE; 
load – вхід синхронного паралельного 
завантаження q+[] = data[]; 
enable – дозвіл на проходження син-
хроімпульсів clock; 
shiftin, shiftout – вхід/вихід по-
слідовного введення/виведення. 

 

lpm_counter: 
LPM_WIDTH, LPM_AVALUE/LPM_S-
VALUE, асlr/sclr, aset/sset – те саме, що 
і в регістрів; 
LPM_MODULUS – модуль лічби; 
LPM_DIRECTION, updown – напря-
мок лічби: додавання (up) або відні-
мання (down); 
aload/sload – входи асинхронного/син-
хронного паралельного завантаження 
q+[] = data[]; 
clk_en та cnt_en – дозвіл на проходжен-
ня лічильних імпульсів clock та дозвіл 
лічби. 
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ЛАБОРАТОРНЕ ЗАВДАННЯ 
 

1 Дослідити основні типи регістрів.  
1.1 Дослідити паралельний регістр з трьома станами виходів на 

основі D-тригерів зі статичним керуванням: за принциповою електричною 
схемою та осцилограмами сигналів (файли 8par.bdf, .vwf) визначити умови 
режимів запису, зберігання та зчитування інформації, виміряти затримку 
перемикання. У звіті навести також умовне графічне позначення за ДСТУ 
такого регістра зі стислим поясненням принципу його дії та осцилограми 
сигналів. 

1.2 Дослідити регістр прямого зсуву (зсуву праворуч) на D-
тригерах з динамічним керуванням (схема 1) у режимах послідовного за-
пису, паралельного та послідовного зчитування (файли 8zsuw.bdf, .vwf) та 
розглянути особливості побудови і перемикання регістра зсуву ліворуч 
(зворотного зсуву) і реверсивного регістра (схеми 2, 3).  

1.3 Ознайомитися з різновидами регістрів бібліотеки бази даних 
(файл 8lіbr.bdf): макрофункціями (вибраними ІС серії 74) паралельних 
регістрів і регістрів зсуву та мегафункціями. У звіті навести функціональні 
прототипи (FUNCTION), таблиці відповідності та інші довідкові дані 
регістрів з кожної групи, пояснити призначення та особливості входів і 
виходів. 

2 Застосувати регістр зсуву в графічному редакторі для побудови 
заданого варіанту ХХ генератора кодової послідовності (ГКП) або роз-
подільника імпульсів/рівнів (РІР). 

2.1 Зібрати найпростіший (несамовідновний) пристрій на 
макрофункції регістра зсуву вибраного типу в графічному файлі 
8XXgkp(ri)1.bdf проекту 8XХgkp(ri)1, виконати компіляцію і моделювання 
та випробувати його на самовідновність за часовими діаграмами 
8XXgkp(ri)1.vwf. 

Приклади: 800gkp1.bdf, vwf (схема 1); 800ri1.bdf, vwf (схема 1). 
F Примітки: 
1) У наведених прикладах пристрій переводиться до станів поза ро-

бочим циклом шляхом паралельного завантаження коду зі входів di сигна-
лом MODE=1. 

2) Аби уникнути завад на краях імпульсів Qi, у розподільниках 
імпульсів/рівнів вибрано регістри з інверсним динамічним керуванням 
(інакше синхровхід слід зінвертувати під час настроювання макрофункції). У 
цьому випадку в елементах збігу синхроімпульси розташовуються всередині 
імпульсів з розрядних виходів, що добре видно на часових діаграмах. 

2.2 Скоригувати схему для утворення самовідновного пристрою, 
виконати п. 2.1 (можна в тому самому файли) та скласти повний переми-

кальний граф. 
2.3 Визначити швидкодію пристрою (максимальну частоту пе-

ремикання відносно синхровходу), користуючись звітним файлом компіляції: 
Compilation Report > Timing Analyzer > Timing Analyzer Summary. 

2.4 Визначити швидкодію пристрою (максимальну частоту 



 118 

перемикання відносно синхровходу) безпосередньо часовим аналізатором: 
піктограмою Timing Analyzer Tool (або з меню Tools > Timing Analyzer) 
викликати його вікно Timing Analyzer Tool, перейти на вкладку Re-gistered 
Performance (швидкодія ЦПП) та зчитати для критичного шляху (From, To) 
найгіршу швидкодію у формі періоду і частоти надходження 
синхроімпульсів (у разі потреби, натиснути кнопку Start).   

 
Приклади: 800gkp1.bdf, vwf (схема 2), 800ri1.bdf, vwf (схема 2); ре-

версивні пристрої: 800gkp0.bdf, vwf, 800ri2.bdf, vwf, 800ri3.bdf, vwf. 
2.5 Зберегти таблицю результатів часового аналізу в текстовому 

файлі: у вікні Timing Analyzer Tool натиснути кнопку Report – з’явиться вік-
но звіту Compilation Report з розділом Timing Analyzer Summary; клацнути 
правою кнопкою миші будь-де в полі таблиці звіту (або меню Tools) > Save 
Current Section As і в діалоговому вікні Save Current Report Section As вибра-
ти тип Timing Analysis Output File (*.tao) та натиснути кнопку збереження; 
продивитися зазначений файл: натиснути піктограму відкриття файла, про-
круткою встановити тип файлів Output Files, вибрати зі списку файл 
8XXgkp(ri)1 Timing Analyzer Summary та натиснути кнопку відкриття.     

Приклад: 800gkp(ri)1 Timing Analyzer Summary.tao. 
2.6 У проекті 8ХХgkp(ri)1 (схема 3) зібрати та дослідити само-

відновний пристрій на мегафункції регістра зсуву (можна в тому самому 
графічному файли).  

Приклад: 800gkp1.bdf, vwf (схема 3). 
2.7 У проекті 8ХХgkp(ri)1 (схема 4) зібрати та дослідити само-

відновний пристрій на автоматично створеному за допомогою менеджера 
MegaWizard Plug-In Manager різновиді мегафункції регістра зсуву 



 119 

8XXwiz_reg.bsf (можна в тому самому графічному файли).  
Приклад: 800wiz_reg.bsf, .tdf; 800gkp1.bdf, vwf (схема 4).  
3 Засвоїти застосування регістра зсуву в текстовому редакторі 

виконанням завдання за п. 2. 
3.1 Створити та дослідити пристрій на основі макро-

функції регістра вибраного типу в тестовому файлі (.tdf) проек-
ту 8XXreg_decl на кшталт самовідновної схеми на макрофункції з 
графічного файла, для чого (як взірець див. файл 800reg_decl.tdf):  

а) після заголовку TITLE вставити шаблон Function Prototype 
Statement (non-parameterized), в який ввести параметри прототипу 

регістра (можна безпосередньо із символу або скопіювати і вставити копію 
з довідки пакету MAX+PLUS II): 

FUNCTION 74295 (ld/shn, clk, ser, d[2..0])  
  RETURNS (q[2..0]);                            
 б) після оголошення портів у секції підпроекту вставити в секцію 

змінних (Variable Section) шаблон оголошення регістрів (Register Declara-
tion), де ввести умовне ім’я зразка та через двокрапку назву вибраного ти-
пу регістра: 

VARIABLE                                    %  Variable Section           % 
 rg : 74295;                        %  Register Declaration   % 
 в) до логічної секції (Logic Section) вставити шаблон підсекції бу-

левих рівнянь (Boolean Equation), за допомогою яких утворити з’єднання 
на зразок графічного файла: 

BEGIN                                                           %  Logic Section           % 
rg.ld/shn = MODE; rg.d[2..0] = d[2..0];  %  Boolean Equation     % 
rg.clk = C; rg.ser = (q0 !& !q1) !& q2;         
Q[2..0] = rg.q[2..0];  
END; 
г) виконати компіляцію і функціональне моделювання та пере-

вірити правильність функціонування пристрою за часовими діаграмами. 
Приклад: 800reg_decl.tdf, .vwf (на кшталт 800gkp1.bdf, схемa 2). 
3.2 Виконати п. 3.1 на мегафункції регістра у тестовому файлі (.tdf) 

проекту 8XXmega_gkp(ri) на кшталт схеми на мегафункції з графічного 
файла. Для цього включити до складу проекту мегафункцію регістра зсуву 
lpm_shiftreg із зазначенням її імені і параметрів в підсекції Instance 
Declaration (parametererized) секції змінних (Variable Section) та до логічної 
секції (Logic Section) вставити шаблон підсекції булевих рівнянь (Boolean 
Equation), за допомогою яких утворити з’єднання на зразок графічного 
файла. Скомпілювати і змоделювати проект та перевірити правильність 
функціонування пристрою за часовими діаграмами.  

Приклад: 800mega_gkp.tdf, .vwf (на кшталт 800gkp1.bdf, схемa 3). 
3.3 Виконати п. 3.1 на автоматично створеному за допомогою ме-

неджера MegaWizard Plug-In Manager різновиді мегафункції регістра у 
тестовому файлі (.tdf)  проекту 8XXwiz_gkp(ri) на кшталт аналогічної схе-
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ми з графічного файла. Для цього включити до складу проекту створений у      
п. 2.5 різновид мегафункцій регістра (Include Statement) без зазначення па-
раметрів у підсекції Instance Declaration (non-parametererized) секції 
змінних (Variable Section) та до логічної секції (Logic Section) вставити 
шаблон підсекції булевих рівнянь (Boolean Equation), за допомогою яких 
утворити з’єднання на зразок графічного файла. Скомпілювати і змоделю-
вати проект та перевірити правильність функціонування пристрою за часо-
вими діаграмами. 

Приклад: 800wiz_reg.tdf, 800wiz_gkp.tdf, .vwf (на кшталт схеми 4 
файла 800gkp1.bdf). 

4 Засвоїти основи побудови послідовнісного пристрою як 
скінченного автомата (State Machine) виконанням завдання за п. 2. 

4.1 За перемикальним графом (файл 8XXgkp(ri)1.bdf, 
рис. 8.5) створити пристрій з використанням оператора вибору 

Case Statement у тестовому файлі (.tdf) проекту 8XXsmcase_gkp(ri), для чо-
го після оголошення портів (див. 800smcase_gkp.tdf): 

а) у секцію змінних Variable Section вставити шаблон підсекції 
оголошення скінченного автомата State Machine Declaration, в який 

ввести символічну назву скінченного автомата, наприклад, gkp або ri, після 
якої залишити двокрапку і ключове слово Machine; відтак після ключових 
слів OF BITS у круглих дужках ввести через кому або у вигляді масиву 
символічну назву розрядів автомата, наприклад, (q2, q1, q0) або (q[2..0]); 
нарешті, після ключових слів WITH STATES у круглих дужках ввести через 
кому символічні назви станів автомата і через знак рівності їх значення в 
одній із систем числення, наприклад, (s0 = 0, s1 = H”1”, s2 = B”011”, …); у 
кінці залишити крапку з комою: 

VARIABLE                                            % Variable Section                  % 
 gkp :  MACHINE                        %  State Machine Declaration  % 
 OF BITS (q[2..0]) 
 WITH STATES (s0 = 0,  s1 = 1,  s2 = 3,  s3 = 7,  s4 = 6,  s5 = 4, 
                     il1 = 2,  il2 = 5); 
F Примітки: 
1) У підсекції State Machine Declaration речення OF BITS залежно 

від розв’язуваного завдання є необов’язковим, тобто компілятор сам може 
призначити кількість розрядів n пристрою за критерієм мінімальної схеми 
(інколи схема є простішою за більшої величини n через спрощення 
міжрозрядних зв’язків). 

2) У реченні WITH STATES можна подати список символічних назв 
станів без зазначення їх кодів, якщо важливою є лише кількість станів, на-
приклад, (s0, s1, s2, ...). 

3) З усіх 2n можливих станів дозволеними є ті, що подані в списку 
символічними назвами. Для усунення недозволених станів їх потрібно та-
кож перелічити в списку, наприклад, il1, il2 (від illegal). 

б) до логічної секції Logic Section вставити шаблон булевих рівнянь 
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Boolean equations, до якого ввести булеві рівняння керування, що зв’язують 
порти (входи та виходи) автомата із зовнішніми портами пристрою. 

BEGIN 
gkp.clk = C;  Q[] = gkp.q[]; 
END; 
F Примітка: Скінченний автомат State Machine має лише три вхідні 

порти: CLK (синхровхід з динамічним керуванням), RESET (скидання) і 
ENA (дозвіл на проходження синхроімпульсів, тобто на перемикання) та 
вихідні порти, оголошені перед ключовим словом OUTPUT секції SUB-
DESIGN. Булеві рівняння керування Boolean equations логічної секції скла-
даються згідно із синтаксисом: <symbolic name>.clk, <symbolic name>.reset, 
<symbolic name>.ena, <symbolic name>.qi, де <symbolic name> - назва, ого-
лошена в підсекції State Machine Declaration. У прикладі рівняння gkp.clk = 
C приєднує зовнішній порт „С” до синхровходу автомата, а рівняння Q[] = 
gkp.q[] приєднує його виходи до зовнішніх портів „Q1”, „Q2”, „Q3”. Отже, 
інші зовнішні сигнали не можна вважати портами автомата, їх треба 
зв’язувати з переходами автомата іншими логічними рівняннями або 
гілками умовних операторів чи таблиці, як, наприклад, у наступному про-
екті 800smtabl_gkp. 

в) після рівнянь до логічної секції вставити шаблон умовного опе-
ратора Case Statement (див. Лаб. робота №5, п. 1.4), до якого ввести пере-
ходи між станами автомата, так само, як у перемикальному графі: 

BEGIN                               
 gkp.clk = C; Q[] = gkp.q[]; 
 CASE gkp IS                                       %  Case Statement          % 
  WHEN s0 => gkp = s1;             %   0 => 1                         % 
  WHEN s1 => gkp = s2;              %  1 => 3                %  
                  WHEN s2 => gkp = s3;              %  3 => 7                          % 
  WHEN s3 => gkp = s4;              %  7 => 6                          % 
  WHEN s4 => gkp = s5;              %  6 => 4                          % 
  WHEN OTHERS => gkp = s0;  %  4 => 0, 2 => 0,  5 => 0 % 
 END CASE; 
END; 
г) по компіляції і функціональному моделюванню перевірити ре-

зультати проектування за часовими діаграмами 8XXsmcase_gkp(ri).vwf. 
Приклад: 800smcase_gkp.tdf, vwf; перемикальний граф 5, 

800gkp1.bdf.  
F Примітка. Замість оператора вибору Case так само можна вико-

ристовувати умовний оператор IF THEN. 
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4.2 За перемикальним графом 6 у файлі 8XXgkp(ri)1.bdf  створити 

пристрій з використанням таблиці відповідності в тестовому файлі (.tdf) 
проекту 8XXsmtabl_gkp(ri), для чого виконати п. 4.1, де у п. 4.1,в до 
логічної секції вставити шаблон таблиці відповідності Truth Table State-
ment (див. Лаб. робота №5, п. 1.2), до якого ввести переходи між станами 
автомата, так само, як у перемикальному графі. 

TITLE "ГКП - State Machine - перемикальна таблиця"; 
SUBDESIGN 800smtabl_gkp 
( 
 C, R, LD :  INPUT; 
 Q[2..0] :  OUTPUT; 
) 
VARIABLE                                             % Variable Section         % 
 gkp : MACHINE                          % State Machine Declaration  % 
 OF BITS (q[2..0]) 
 WITH STATES ( 
  s0 = 0, s1 = 1, s2 = 3, s3 = 7, s4 = 6, s5 = 4, il1 = 2, il2 = 5); 
BEGIN                                                       %  Logic Section                 %  
 gkp.clk = C; gkp.reset = R;                %  Boolean equations         %  
 Q[] = gkp.q[]; 
   TABLE                                               %  Truth Table Statement   % 
 LD, gkp  => gkp;          
 ------------------------ 
          0,  s0    => s1;   1,  s0    => il1;   0,  s1    => s2;   1,  s1    => s1; 
 0,  s2    => s3;   1,  s2    => s2;   0,  s3    => s4;    1,  s3    => s3;          
 0,  s4    => s5;   1,  s4    => s4;   0,  s5    => s0;    1,  s5    => s5;          
 0,  il1   => il2;   1,  il1   => il1;   0,  il2   => s2;    1,  il2   => il2;         
   END TABLE; 
END; 
Приклад: 800smtabl_gkp.tdf, vwf; перемикальний граф 6, 800gkp1.bdf. 
5 Створити проект лабораторного макету на рівні блок-схеми 

для експериментального дослідження ГКП (РІР) на основі регістра 
зсуву  згідно з варіантом завдання 8 (див. структурну схему і як взірець 
файл 800GENERATOR_KP.bdf – рис. Д6 у додатках).  

Схема власне ГКП складається з регістра зсуву і ЦКП. Виходи при-
строю через дешифратор семисегментного коду з’єднано із цифровим 
індикатором для індикації кодів у десятковій системі і через дешифратор – 
для відображення розрядів на світлодіодах (у прикладі утворено дві 
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гірлянди по колу). Синхросигнал утворюється антидеренчливим пристроєм 
одноразовим натисненням по черзі ключів на входах RN, SN. Для переве-
дення ГКП до стану поза основним циклом з метою перевірки його на са-
мовідновність від вхідних ключів у паралельному коді записується слово 
sw1[] (натисненням ключа на вході mode, одноразовим натисненням по 
черзі ключів на входах RN, SN і відтисненням ключа на вході mode). 

 
5.1 В окремому проекті 8XXGENERATOR_KP(RIR) відтворити 

ГКП (РІР) за п. 2.2 (шляхом копіювання частини файлів) на мікросхемі ро-
дини MAX7000S, типу EPM7128SL84-7. Включити до складу проекту 
файл дешифратора 7-сегментного коду ../7lab/dc7seg.bdf та створений в ок-
ремому файлі і згорнутий до символу дешифратор. Імпортувати призна-
чення виводів мікросхеми з файлу ../4lab/MAX_pin та скоригувати їх. Ви-
конати компіляцію і функціональне моделювання з метою переконатися в 
правильності проектування.  

Приклад: 800GENERATOR_KP.bdf, vwf; 800dc.bdf, .bsf. 
5.2 Створити програмувальний CDF-файл, перевірити режим і схе-

му програмування, переконатися, що чотири джампери на платі TDI, TDO, 
DEVICE, BOARD встановлено в режим програмування однієї мікросхеми 
та виконати її програмування. 

Приклад: 800GENERATOR_KP.сdf. 
5.3 Розробити методику та виконати експериментальні дослідження 

пристрою на запрограмованій ІС. Порівняти результати експерименталь-
них досліджень з даними проектних файлів, зробити висновки. 
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9 ЛАБОРАТОРНА РОБОТА №9. ЛІЧИЛЬНИKИ 
 

Мета роботи: дослідження типових лічильників; застосування лі-
чильників у проектах; засвоєння методів створення недвійкових лічильни-
ків і подільників частоти. 

 

ДОМАШНЄ ЗАВДАННЯ 
! Спроектувати згідно з варіантом завдання 9 (див. Додатки): а) 

недвійковий лічильник шляхом перетворення двійкового лічильника, б) 
недвійковий лічильник на тригерах зі зворотними зв’язками.  

 

СТИСЛІ ТЕОРЕТИЧНІ ВІДОМОСТІ 
Означення, класифікацію і параметри лічильників, схемну ре-

алізацію двійкових лічильників з послідовним, паралельним і груповим 
переносом, а також принцип побудови реверсивних лічильників викладено 
в [2]. Тут розглянемо проектування недвійкових лічильників.  

 

1 Перетворення двійкових лічильників у недвійкові  
Якщо в n-розрядному двійковому лічильнику з модулем 2n виклю-

чити Мн = 2n – М надлишкових станів, то він перетвориться в недвійковий з 
модулем  М < 2n. Тому потрібна кількість розрядів n двійкового лічильника 
для утворення недвійкового з модулем  М обчислюється в САПР як 

n = Ceil (log2M),                                                (9.1) 
де Ceil (ceiling – стеля) – найближче ціле число, що не менше виразу в 
дужках, наприклад, Ceil (log25) = 3. Або простіше вручну розрядність мож-
на визначити з умови 

2n-1 <  М < 2n,                                                  (9.2) 
наприклад, недвійковий лічильник з модулем М = 5, виходячи з 22 < 5 < 23, 
можна утворити з трирозрядного двійкового лічильника, якщо усунути   
Мн = 2n – М = 23 – 5 = 3 надлишкові стани. 

Існує кілька методів перетворення двійкових лічильників у недвійкові 
залежно від способу усунення надлишкових станів. Лічильник з природним 
порядком лічби утворюється виключенням старших надлишкових станів N = 
M, … , 2n – 1 шляхом примусового скидання двійкового лічильника. Прин-
цип такого перетворення розглянемо спочатку на ІС жорсткої структури, ко-
ли приступними є лише її зовнішні виводи, зокрема, вхід скидання 
двійкового лічильника R (рис. 9.1,а). З надходженням лічильних імпульсів С 
вихідний код зростає в межах N = 0, 1, ..., М і перетворюється в дешифраторі 
в унітарний код. Коли на виході, номер якого збігається з модулем лічби М, 
з’являється активний рівень RM, лічильник скидається до нуля і далі цикл 
лічби повторюється. Стан N = М, в якому лічильник перебуває короткочасно, 
не використовується, тому кількість фіксованих станів N = 0, 1, ..., М – 1 ста-
новить потрібний модуль лічби М.  

Методику проектування розглянемо на прикладі перетворення 
двійкового лічильника в декадний з модулем М = 10. 
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Рисунок 9.1 – Перетворення двійкових лічильників у недвійкові 

 

1) За співвідношеннями (9.1, 9.2) визначаємо потрібну кількість 
розрядів n = 4 і вибираємо ІС лічильника зі входом скидання. 

2) Для наочності зазначаємо в перемикальній таблиці (рис. 9.1,б), 
що коли лічильник переходить до стану N = М = 10, виникає сигнал ски-
дання RM = 1, яким він повертається до нульового стану, тому старші коди 
N = 11 ... 15 не використовуються. 

3) Мінімізуємо звичайним чином за діаграмою термів шукану функ-
цію RM = Q1Q3, згідно з якою дешифрування виконує елемент І (рис. 9.1,в). 

Проте якщо сигнал RM подати безпосередньо на вхід скидання лічиль-
ника R, певні його розряди можуть скинутися раніше інших, внаслідок чого 
на виході елемента І встановиться пасивний рівень, коли лічильник не встиг-
не повністю обнулитися. У випадку можливості такої небезпеки слід розши-
рити сигнал RM затримкою на виході елемента І, наприклад, за допомогою 
додаткового тригера (див. рис. 9.1,в). Вихідним кодом N = Q[3..0] =   = 1010 = 
А16 встановлюється сигнал RM = 1 (рис. 9.1,г), позитивним перепадом якого 
тригер перемикається до стану Q = 1 і запам’ятовує його до надходження но-
вого імпульсу С. За цей час лічильник надійно обнуляється, а за позитивним 
перепадом наступного імпульсу С тригер скидається до стану Q = 0, віднов-
люється пасивний рівень на вході R лічильника, тому за негативним перепа-
дом імпульсу С починається новий цикл лічби. 

2 Програмовані недвійкові лічильники  
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Програмований лічильник за методом примусового скидання 
двійкового лічильника можна побудувати заміною дешифратора в узагаль-
неній схемі перетворення (див. рис. 9.1,а) на цифровий компаратор (рис. 
9.2,а). Коли, під час лічби вихідний код N сягає потрібного модуля M, сиг-
налом RM лічильник обнуляється, а з надходженням наступних імпульсів 
на вхід C цикл лічби повторюється.  

 
Рисунок 9.2 – Програмовані недвійкові лічильники 

 

Особливості проектування програмованого лічильника такого ти-
пу розглянемо на прикладі змінюваного модуля лічби M = 5 і M = 7. За 
максимальним модулем M = 7 вибираємо розрядність лічильника n =3, а за 
кількістю модифікацій модуля – розрядність керувального коду. У при-
кладі достатньо обмежитися однорозрядним керувальним кодом m: за його 
значення m = 0 програмуємо модуль на величину M = 5, а за значення m = 1 
– на величину M = 7. Якщо кількість модифікацій модуля не перевищує 
чотирьох, вибираємо дворозрядний керувальний код m1m0, якщо восьми – 
трирозрядний код m2m1m0 і т. д. 

Аналогічно рис. 9.1,б складаємо перемикальну таблицю (рис. 9.2,б), 
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в якій зазначаємо, що лічильник скидається сигналом RM = 1, коли він опи-
няється в проміжних станах Q2Q1Q0 = 5 при m = 0 та Q2Q1Q0 = 7 при m = 1. 
Також позначаємо десяткові значення наборів змінних і = mQ2Q1Q0, за 
якими будуємо діаграму термів (рис. 9.2,в), відтак мінімізуємо функцію, 
застосовуючи для спрощення редукцію 

210120 \ QQmQQmQQRM == ,                                       (9.3) 
та складаємо схему (рис. 9.2,г). Затримка комбінаційної частини зазвичай 
достатня для надійного обнуління лічильника (рис. 9.2,д), але, у разі по-
треби, імпульси скидання розширюють, наприклад, на кшталт рис. 9.1,в. 

На основі трирозрядного двійкового лічильника можна створити 
програмований лічильник з модулем лічби M = 2 ... 8 із застосуванням ке-
рувального коду m2m1m0 шляхом узагальнення (9.3): 

221100 QmQmQmRM = ,                                           (9.4) 
отже, аналогічно і для лічильника довільної розрядності. 

Слід враховувати, що під час примусового скидання виникають 
проміжні стани лічильника, тому вихідний код можна знімати по за-
кінченні пе рехідного процесу його усталення. Цей недолік усувають в 
програмованих ІС шляхом модифікації структури лічильника. Принцип 
такої модифікації розглянемо на прикладі перетворення двійкового 
лічильника за основною схемою на D-тригерах (див. [2], рис. 9.3,б) у 
лічильник з програмованим модулем лічби М = 2 ... 8.  

З цією метою на входах Dі тригерів (рис. 9.3,а) увімкнемо додаткові 
елементи І та за допомогою елемента І-НЕ сформуємо керувальний сигнал 
DM. Під час лічби залишається рівень DM = 1, який не впливає на функції 
збудження тригерів, а коли вихідний код набуває значення М – 1, цей 
рівень змінюється на DM = 0, тому з надходженням чергового імпульсу 
лічильник скидається до нульового стану. Для програмування на по-
трібний модуль лічби достатньо з’єднати зі входами елемента І-НЕ виходи 
розрядів відповідно до коду М – 1. Так, лічильник з модулем М = 5 дістан-
емо реалізацією числа М – 1 = 410 = 1002 = 012 QQQ  (див. рис. 9.3,а). Пара-
лельний лічильник з довільним модулем такого типу перемикається, як і 
двійковий, без проміжних станів під час зміни вихідного коду (рис. 9.3,б). 

Перевагою лічильників з керованим скиданням є природний поря-
док лічби, тобто їх можна використовувати за прямим призначенням – для 
підраховування кількості імпульсів. Проте коли порядок лічби не має зна-
чення, наприклад, у подільниках частоти, застосовують також способи пе-
ретворення двійкових лічильників у недвійкові шляхом усунення про-
міжних або молодших станів. В останньому випадку по досягненні макси-
мального коду (всі розряди в одиничному стані) здійснюють примусове на-
раховування коду на кількість надлишкових станів зі входів передустанов-
лення лічильника. Це спрощує дешифрування за ознакою негативного пе-
репаду на виході старшого розряду.  
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Рисунок 9.3 – Перетворення двійкового лічильника за основною схемою на 

D-тригерах у лічильник з програмованим модулем лічби М=2...8 
 

3 Лічильники зі зворотними зв’язками   
Двійкові лічильники утворюються за допомогою прямих міжрозряд-

них зв’язків – з виходів попередніх на входи наступних розрядів. Запро-
вадженням зворотних зв’язків – з виходів наступних розрядів на входи 
попередніх – можна шляхом блокування перенесень усунути будь-які 
надлишкові стани, отже, дістати лічильники з довільним модулем і поряд-
ком лічби. Якщо будувати в такий спосіб лічильники з послідовним або 
комбінованим переносом між окремими розрядами, потрібно визначати 
функції збудження як інформаційних, так і синхровходів тригерів, а в па-
ралельних лічильників синхровхід всіх розрядів є спільний, тому достат-
ньо знайти функції збудження лише інформаційних входів.  

Методику проектування розглянемо на прикладі побудови пара-
лельного лічильника з модулем М = 5 і природним порядком лічби, який 
має перемикатися за часовими діаграмами на рис. 9.4. 

 
Рисунок 9.4 – Часові діаграми паралельного лічильника з модулем М=5 і 

природним порядком лічби 
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1) За потрібною кількістю розрядів n = 3 у перемикальній таблиці   
(рис. 9.5,а) заповнюємо колонки початкового Qі та наступного по надхо-
дженні лічильного імпульсу Qі

+ станів тригерів з урахуванням того, що ко-
ди N = 5 ... 7 є надлишкові.  

2) Вибираємо тип тригерів (для прикладу розглянемо варіанти лічи-
льника на JK-, D- i TE-тригерах) та заповнюємо стовпці таблиці для функ-
цій збудження на їх інформаційних входах. Так, JK-тригерові старшого 
розряду колонкам  Q2Q2

+ лівої частини таблиці відповідають колонки J2K2 
її правої частини. Тому для переходів Q2Q2

+ = 00, 01, 10 вносимо значення 
J2K2 = 0Х, 1Х, Х1, відтак аналогічно заповнюємо колонки для всіх інших 
розрядів згідно з таблицею переходів JK-тригера. Для розрядів на D-три- 
герах вносимо значення Dі = Qі

+, а для ТЕ-тригерів занотовуємо Еі = 0, як-
що тригер не перемикається та Еі = 1, якщо перемикається. 

3) Безпосередньо з таблиці довизначенням Х = 1 маємо К2 = К0 = 1, 
а інші функції збудження мінімізуємо за діаграмами термів (на рис. 9.5,б 
порожнім клітинкам відповідають факультативні значення Х): 
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4) З’єднуючи синхровходи тригерів зі спільним лічильним входом 

С, а інші входи – згідно з функціями збудження, отримуємо варіанти реалі-
зації лічильника на JK-, D- i TE-тригерах (рис. 5,в,г,ґ відповідно). Такі 
лічильники є синхронні, отже, перемикаються без проміжних станів 
вихідного коду (див. рис. 9.4). 

Найпростіший щодо реалізації варіант визначається елементною ба-
зою. Так, лічильники на JK-тригерах з дубльованими входами потребують 
мінімуму додаткових елементів у міжрозрядних зв’язках  (при викори- 
станні  інверсного  виходу і  подвійних входів у старшому розряді схема на 
рис. 9.5,в не містить таких елементів) і можуть виявитися зручними для 
побудови на ІС жорсткої структури. На програмованих ІС економічнішими 
є схеми на D- і RSC-тригерах з динамічним керуванням. Крім того, для 
низки застосувань доцільною є побудова лічильників з довільним модулем 
і порядком лічби за схемами з послідовним і комбінованим переносом.  

 
Проектування реверсивних лічильників. Особливості проектуван-

ня розглянемо на прикладі побудови реверсивного паралельного лічиль-
ника з модулем М = 5 і природним порядком лічби на JK-тригерах. Пере-
микальну таблицю доповнюємо стовпцем модифікації схеми (рис. 9.6,а): 
при m = 0 лічильник працює в режимі додавання, а при m = 1 – в  режимі 
віднімання, а також стовпцем десяткового коду набору змінних i = 
mQ2Q1Q0. В іншому методика проектування аналогічна. 
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Рисунок 9.5 

Безпосередньо з таблиці маємо К2 = К0 = 1, а інші функції збудження 
дістанемо з діаграм термів (на рис. 9.6,б порожнім клітинкам відповідають 
факультативні значення Х), застосовуючи прийоми їх сумісної мінімізації: 
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Цим рівнянням відповідає схема лічильника (рис. 9.6,в), напрямок 
лічби якого керується сигналом u/d = m (рис. 9.6,г).   
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Рисунок 9.6 

 
4 Подільники частоти  
Загальна схема безвентильного подільника частоти. Будь-які 

лічильники можуть використовуватися як подільники частоти, коефіцієнт 
поділу якої на виході лічильника дорівнює його модулю лічби. Проте до-
даткові елементи (вентилі) у міжрозрядних зв’язках або потреба дубльова-
них входів у тригерів ускладнюють лічильники з довільним модулем і 
природним порядком лічби. З огляду на те, що в подільниках частоти по-
рядок лічби не має значення, без його дотримання схему гранично спро-
щують. 
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Рисунок 9.7 

 
Безвентильні лічильники на JK-тригерах без дубльованих входів бу-

дуються шляхом збільшення модуля лічби на одиницю. Для цього 
лічильник з довільним модулем М0 охоплюють зворотним зв’язком за до-
помогою двох тригерів (варіанти схеми на тригерах з інверсним і прямим 
динамічним керуванням подано на рис. 9.7,а,б). При цьому перший тригер 
збільшує модуль вдвічі, а останній додає одиницю (через це для стислості 
його називають „одиничним”), тому в цілому модуль такого лічильника 
становить М = 2М0 + 1. Наприклад, охоплюючи таким зв’язком чотирироз-
рядний двійковий лічильник, дістанемо модуль  М = 33 (рис. 9.7,в).  

Так само утворюються лічильники з будь-яким непарним модулем, 
а при М0 = 1 дістанемо модуль М = 3 безпосереднім з’єднанням першого і 
одиничного тригерів (виокремлена частина на рис. 9.7,г). Для отримання 
парного модуля лічби досить послідовно ввімкнути лічильний тригер на 
вході або на виході. В останньому випадку (див. рис. 9.7,г) вихідні імпуль-
си Q матимуть форму меандру. 

Проектування. Побудову і аналіз функціонування безвентильного 
лічильника розглянемо на прикладі подільника частоти з модулем лічби 
(коефіцієнтом поділу) М = 11.  

1) Розкладаємо модуль на числа степеня 2 та додаткові одиниці: М =   
= 11 = 10 + 1 = 2 * 5 + 1 = 2 * (4 + 1) + 1 = 2 * (22 + 1) + 1. Підраховуємо по-
трібну кількість розрядів n = n2 + n1 як суму степенів два n2 та додаткових 
одиниць n1, яка в прикладі становить n = 3 + 2 = 5, тобто потрібно на один 
тригер більше мінімальної їх кількості за (4). Якщо є варіанти розкладу числа 
М, вибираємо такий, що потребує меншої кількості розрядів (наприклад, мо-
дуль М = 39 можна розкласти двома варіантами з розрядністю n = 7 та n = 8). 
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Рисунок 9.8 

 

2) Поділяємо розклад на блоки у вигляді (2 * М0 + 1), наприклад, М 
=     = 11 = [2 * (2 * 2 + 1) + 1] та реалізуємо ці блоки за типовою схемою 
(див. рис. 7,а,б) з використанням лічильних тригерів або лічильників для 
степенів числа 2 і одиничних тригерів для одиниць (рис. 9.8,а,б).  

3) Аналіз спроектованого подільника частоти розглянемо докладно, 
бо він є типовий для будь-якого ЦПП взагалі. 

Зазвичай функціонування пристрою зображають перемикальним 
графом. Для його побудови зручно скористатися перемикальною таблицею 
(табл. 1), до якої доцільно внести початковий стан N, наприклад, у шістна-
дцятковій системі числення, його двійковий код Q4 … Q0 відповідно до 
номерів тригерів, функції збудження всіх розрядів CiJiKi, включаючи син-
хросигнали Ci (бо лічильник не є паралельний), відтак стани Qi

+, до яких 
перемкнуться тригери по надходженні чергового лічильного імпульсу, і, 
нарешті, шістнадцятковий код N+ нового стану лічильника. Задля на-
очності позначимо над функціями збудження черговість перемикання роз-
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рядів, а під ними – значення цих функцій, які зчитуємо безпосередньо зі 
схеми (зупинимося для прикладу на схемі рис. 9.8,б). 

 

Таблиця 9.1 

 
 

З лічильного входу С імпульси потрапляють безпосередньо до першо-
го і останнього тригерів, першочерговість перемикання яких позначаємо 
цифрою 1, перепад цих імпульсів на їх синхровходах – у вигляді С4 =   = С0 = 
dС та зчитуємо зі схеми сигнали J4 = Q2, K4 = 1, J0 = 4Q , K0 = 1. 

Наслідком перемикання молодшого розряду є перепад dQ0, яким ке-
руються тригери з виходами Q1, Q3, тому черговість їх спрацьовування по-
значаємо цифрою 2, функції синхровходів – С3 = С1 = dQ0 та зчитуємо зі 
схеми сигнали на входах J і K. І, нарешті, в останню чергу (цифра 3) пере-
микається середній тригер перепадом С2 = dQ1. 

Відтак вносимо початковий код, наприклад, N = 00 і заповнюємо 
клітинки таблиці з функціями першої черги, позначаючи активний перепад  
dС = 1 (або стрілкою догори, бо в нас активними є позитивні перепади), а 
вихідні стани тригерів Qi беремо з лівої частини таблиці: J4 = Q2 = 0,          
J0 = 4Q = 1. За цими функціями збудження визначаємо наступний стан двох 
тригерів по надходженні лічильного імпульсу і вносимо його до правої ча-
стини таблиці: Q4

+ = 0, Q0
+ = 1. Позитивний перепад сигналу Q0 → Q0

+ =   
= 0 → 1 позначаємо для тригерів другої черги як dQ0 = 1, так само заното-
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вуємо їх функції збудження та наступні стани Q3
+ = 0, Q1

+ = 1. У третю 
чергу позитивним перепадом dQ1 = 1 перемикається до протилежного ста-
ну середній тригер (бо J2 = K2 = 1), тому занотовуємо Q2

+ = 1. 
Далі, за початковий беремо новий стан 07 і в другому рядку таблиці 

визначаємо так само переходи тригерів, але відсутність активного перепа-
ду на синхровходах для стислості позначаємо рискою (негативний перепад 
dQ0 не спричиняє перемикання ланцюжка тригерів другої, отже, і третьої 
черги), тому немає сенсу занотовувати значення на входах J та K. 

Продовжуємо таблицю, доки не замкнеться робочий цикл лічиль-
ника (у прикладі він зі стану 01 повертається до початкового стану 00) і 
зображаємо його на перемикальному графі, наприклад, грубими лініями як 
на рис. 9.8,в (у вершинах графа стани подано, як і в перемикальній таблиці 
шістнадцятковим кодом). 

Для побудови повного перемикального графа вносимо до таблиці 
стан поза робочим циклом, наприклад, 02 і так само визначаємо переходи 
тригерів, доки не переберемо всі можливі 2n станів та переносимо їх на 
граф (тонкі лінії на рис. 9.8,в). Відсутність хибних циклів перемикального 
графа свідчить про самовідновність лічильників за схемами на рис. 9.8,а,б 
та за узагальненими схемами на рис. 9.7,а,б. 

4) За перемикальним графом та таблицею будуємо часові діаграми 
вихідного сигналу подільника частоти Q та, у разі потреби, на всіх розряд-
них виходах (рис. 9.8,г). Як бачимо, частота на виході Q в 11 разів менша 
за вхідну, а повний час усталення вихідного коду становить tЛ = 3tТ 
внаслідок послідовного перемикання трьох черг тригерів. Проте за викори-
стання лічильника для поділу частоти швидкодія визначається лише часом 
перемикання тригера молодшого розряду.   

Таким чином, безвентильні подільники частоти відрізняються про-
стотою схеми, хоч і можуть містити кількість тригерів, більшу мінімальної, 
що визначається за (1).  

 
КОНТРОЛЬНІ ЗАПИТАННЯ 

1 Порівняйте лічильники з переносом різного типу за критеріями 
швидкодії і складності. Для яких застосувань послідовні лічильники мають 
перевагу перед паралельними? 

2 Зобразіть раціональну схему з’єднань символів макрофункції 7464 
із вхідними і вихідними портами для отримання лічильника з модулем: а) 
22, б) 24, в) 25, г) 27, д) 28, е) 210, є) 211, ж) 215. 

3 Спроектуйте лічильник з модулем 2778 і природним порядком лі-
чби (для вимірювача фазових зсувів) на основі: а) макрофункцій двійкових 
лічильників, б) макрофункцій декадних лічильників, в) мегафункції лічи-
льника.  
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ЛАБОРАТОРНЕ ЗАВДАННЯ 
 

1 Дослідити основні типи лічильників.  
1.1 Дослідити двійковий підсумовувальний лічильник з по-

слідовним переносом (послідовний лічильник)  на основі Т-тригерів: за 
принциповою електричною схемою і осцилограмами сигналів (схема 1, 
файли 9dwij.bdf, .vwf) з’ясувати принцип побудови і міжрозрядні зв’язки 
такого лічильника та визначити затримку його перемикання. У звіті навес-
ти схему, умовне графічне позначення лічильника за ДСТУ, перемикальну 
таблицю, осцилограми сигналів, відомості щодо швидкодії. 

1.2 Дослідити двійковий підсумовувальний лічильник з паралель-
ним переносом (паралельний лічильник) на основі ТЕ-тригерів за п. 1.1 
(схема 2, файли 9dwij.bdf, .vwf). Розглянути особливості побудови і пере-
микання базової схеми на D-тригерах (схема 3, файли 9dwij.bdf, .vwf) та 
застосування її для побудови формувача адреси шляхом розгортання коду 
в часі з антидеренчливим пристроєм на вході (файли 9addr.bdf, .vwf). У 
звіті навести схеми, осцилограми сигналів, відомості щодо швидкодії.   

1.3 Розглянути особливості побудови і перемикання двійкового 
лічильника в режимі віднімання (схема 4, файли 9dwij.bdf, .vwf) та 
дослідити двійкові реверсивні лічильники з подаванням вхідних імпульсів 
до однієї точки (схема 5, файли 9dwij.bdf, .vwf) і двох точок схеми (схема 
6, файли 9dwij.bdf, .vwf). У звіті навести схему реверсивного лічильника на 
D-триге-рах, осцилограми сигналів, стисле пояснення принципу його дії. 

1.4 Дослідити недвійковий лічильник, побудований шляхом пере-
творення двійкового (двійковий лічильник репрезентовано файлами 
9m16.bdf, .bsf, .vwf) скиданням його надлишкових станів за допомогою 
дешифратора (репрезентовано файлами 9dc.bdf, .bsf) на прикладі декадно-
го лічильника (схема 1, файли 9nedw.bdf, .vwf). Розглянути особливості 
побудови і перемикання лічильника, в якому за дешифратор править еле-
мент І (схема 2, файли 9nedw. bdf, .vwf), декадного лічильника на стан-
дартній макрофункції – ІС серії 74 (схема 3, файли 9nedw.bdf, .vwf) та ре-
версивного декадного лічильника на мегафункції (схема 4, файли 
9nedw.bdf, .vwf). У звіті навести схеми 1 або 2 та 4, осцилограми сигналів 
таких лічильників, стисле пояснення принципу їх дії. 

1.5 Ознайомитися з різновидами двійкових лічильників бібліотеки 
бази даних (файл 9lіbr.bdf): 1) макрофункціями (дібраними ІС серії 74) 
двійкових лічильників (Binary) та 2) двійкових реверсивних лічильників 
(Binary Up/Down), з різновидами недвійкових лічильників: 3) макро-
функціями (дібраними ІС серії 74) декадних лічильників (Decade), 4) де-
кадних реверсивних лічильників (Decade Up/Down), з іншими різновидами 
лічильників і подільників частоти і 5) програмованими цифровими тайме-
рами та 6) з універсальною мегафункцією лічильника. У звіті навести при-
наймні по одому символу з груп 1...6, пояснити призначення та особли-
вості входів і виходів, а також параметри мегафункції. 
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2 Спроектувати недвійковий лічильник із заданим модулем М 
(згідно з варіантом завдання 9,а) і природним порядком лічби шляхом 
перетворення двійкового лічильника. 

2.1 Побудувати лічильник на основі макрофункції вибраного типу 
за графічного (.bdf) введення проекту 9XXper_gr, виконати компіляцію та 
функціональне моделювання (.vwf). 

Приклад: програмований лічильник з природним порядком лічби і 
модулем М = 5, 7 на макрофункції 74293 у файлах 900per_gr.bdf, .vwf. 

2.2 В автоматичному режимі визначити швидкодію спроектованого 
послідовнісного пристрою: 

а) у разі потреби, послідовністю наведених піктограм 
відкрити аналізований проект (переконатися, що його дирек-

торію і назву відображено в рядку заголовка головного вікна) та задля на-
очності відкрити файл верхнього рівня проекту (у нашому випадку це є 
графічний файл); 

б) піктограмою Timing Analyzer Tool (або з меню Tools > 
Timing Analyzer Tool) відкрити вікно часового аналізатора, перейти 

на вкладку визначення швидкодії послідовнісних пристроїв Registered Per-
formance і зчитати для критичного шляху (From, To) найгіршу швидкодію 
у формі періоду і частоти надходження синхроімпульсів.  

 
в) зберегти таблицю результатів часового аналізу в текстовому 

файлі: у вікні Timing Analyzer Tool натиснути кнопку Report – з’явиться ві-
кно звіту Compilation Report з розділом Timing Analyzer Summary; клацну-
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ти правою кнопкою миші будь-де в полі таблиці звіту (або меню Tools) > 
Save Current Report Section As і в діалоговому вікні Save Current Report Sec-
tion As вибрати тип файла Timing Analyzer Output File (*.tao) та натиснути 
кнопку збереження; 

г) продивитися зазначений файл: натиснути піктограму відкриття 
файла, прокруткою встановити тип файлів Output Files, вибрати зі списку 
файл 9XXper_gr Timing Analyzer Summary та натиснути кнопку відкриття.     

Приклад: 900per_gr Timing Analyzer Summary.tao. 
2.3 Виконати п. 2.1 за текстового (.tdf) введення проекту 

9XXper_tx. 
 Приклад: програмований лічильник з природним порядком лічби і 

модулем М = 5, 7 на макрофункції 74293 у файлах 900per_tx.tdf, .vwf. 
F Примітка: У текстовому файлі (підсекція Boolean Equation) імена 

виводів зразка макрофункції мають точно відповідати його 
функціональному прототипові, який можна записати безпосередньо з 
графічного символу або скопіювати з довідки Help САПР MAX+PLUS II, 
наприклад,  

AHDL Function Prototype 
FUNCTION 74293 (clka, clkb, clra, clrb) 
                 RETURNS (qd, qc, qb, qa); 

і далі використовувати в рівняннях (з позначенням імені зразка з крапкою): 
ct.clra, ct.clrb, ct.clka, ct.clkb, ct.(qd, qc, qb, qa). 

3 Спроектувати паралельний лічильник зі зворотними 
зв’язками із заданими модулем М і порядком лічби (згідно з варіантом 
завдання 9,б) та дослідити його, користуючись часовими діаграмами.  

3.1 Побудувати лічильник на тригерах заданого типу за графічного 
(.bdf) введення проекту 9XXzz_gr, виконати компіляцію та функціональне 
моделювання (.vwf). 

Приклади: лічильник з природним порядком лічби і модулем 5 на 
тригерах типу JK (схема 1), D (схема 2), TЕ (схема 3) та реверсивний 
лічильник на JK-тригерах (схема 4) у файлах 900zz_gr.bdf, .vwf. 

3.2 Виконати п. 3.1 на мегафункції лічильника в тому самому про-
екті (примірник мегафункції можна ввести і одночасно настроїти з 
діалогового вікна Symbol: кнопкою MegaWizard Plug-In Manager викликати 
однойменне вікно, на сторінці 2а ліворуч вибрати категорію arithmetic > 
мегафункцію LPM_COUNTER і праворуч після риски ввести ім’я, наприк-
лад, СТ5; на сторінці 3 ввести ширину шини в бітах, наприклад, 3 і 
ввімкнути перемикач напрямку лічби, наприклад, нижній для створення 
входу ‘updown’: 1 – додавання, 0 – віднімання; на сторінці 4 ввімкнути пе-
ремикач Modulus і ввести модуль лічби, наприклад, 5). На завершення 
включити створений різновид мегафункції СТ5.tdf до проекту.  

Приклад: реверсивний лічильник з природним порядком лічби і 
модулем 5 на мегафункції (схема 5) у файлах 900zz_gr. bdf, .vwf. 

3.3 Виконати п. 3.2 за текстового (.tdf) введення проекту 9XXzz_tx. 
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Для цього доцільно скористатися створеним у п. 3.2 за допомогою менед-
жера MegaWizard Plug-In Manager різновидом мегафункції лічильника, на-
приклад, СТ5. Файл включення (у прикладі CT5.inc) вставляється операто-
ром Include Statement перед секцією підпроекту Subdesign Section. 

Приклад: реверсивний лічильник з природним порядком лічби і 
модулем 5 на зразку мегафункції CT5.inc у файлах 900zz_ tx.tdf, .vwf. 

F Примітки: 
1) Зауваження щодо відповідності імен стосується і мегафункції. 

Наприклад, з файла включення автоматично створеного її зразка CT5.inc 
(відкривається з типу файлів Other Sourсe Files) зчитуємо прототип  

FUNCTION CT5.inc (clock, updown) 
                     RETURNS (q[2..0]); 

і використовуємо в рівняннях імена виводів ct.clock, ct.updown, ct.q[]. 
Імена виводів можна взяти також із символьного файла CT5.bsf (відкри-
вається з типу файлів Graphic Files або Other Sourсe Files). 

2) У разі потреби, зразок мегафункції можна створити безпо-
середньо менеджером MegaWizard Plug-In Manager, який 

викликається з меню Tools >  MegaWizard Plug-In Manager.  
 
4 Створити проект лабораторного макету для експерименталь-

ного дослідження лічильника на прикладі заданого варіанту недвійково-
го лічильника за п. 2 або 3 за вибором (див. як взірець файл 900LICHYL-
NYK.bdf – рис. Д7 у додатках).  

Для цього вставити зазначений лічильник до графічного файлу, 
який доповнити іншими компонентами, потрібними для індикації вихідно-
го коду і модулю лічби (у прикладі модуль лічби індукується світлодіода-
ми VD1, VD2). Імпортувати призначення виводів мікросхеми з файлу 
../4lab/MAX_pin.qsf та скоригувати їх. Виконати компіляцію і функціона-
льне моделювання з метою переконатися в правильності проектування. 
Створити програмувальний CDF-файл і виконати програмування мікро-
схеми. Розробити методику та виконати експериментальні дослідження 
пристрою на запрограмованій ІС. Порівняти результати експерименталь-
них досліджень з даними проектних файлів, зробити висновки.    

Приклад: програмований лічильник М = 5, 7 – файли 900LICHYL-
NYK.bdf, .vwf, .сdf.  
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10 ЛАБОРАТОРНА РОБОТА №10. 
ПРОГРАМОВАНІ МІКРОСХЕМИ 

 
Мета роботи: використання мікросхем різних типів на прикладі 

побудови подільників частоти; програмовані логічні матриці, архітектура 
ПЛІС, інтерфейс JTAG, схеми програмування і конфігурування; редактор 
фізичного розміщення; конфігурування мікросхеми.  

 
ДОМАШНЄ ЗАВДАННЯ 

! Спроектувати згідно з варіантом завдання 10 (див. Додатки) без-
вентильний подільник частоти на JK-тригерах.   

 
СТИСЛІ ТЕОРЕТИЧНІ ВІДОМОСТІ 

У [2] викладено загальні відомості про сучасні  ПЛІС (їх кла-
сифікацію за способами програмування структури, програмовані елементи 
ПЛІС, принцип побудови програмованих логічних матриць), елементи 
структури (макрокомірка, блок керування вводом/виводом), а також 
відомості щодо програмування і конфігурування (режими програмування і 
конфігурування, інтерфейс JTAG, схеми програмування і конфігурування). 
Тут розглянемо стисло питання архітектури ПЛІС і наведемо для прикладу 
відомості про дві родини ПЛІС фірми Altera з довідки САПР Quartus II.  

1 Архітектура ПЛІС  
1.1 План розміщення ПЛІС.  
ПЛІС, що крім багатьох програмованих логічних матриць (ПЛМ) 

містить регістри, буфери, розгалужену систему програмованих з’єднань 
тощо, структурована на окремі частини. У загальному вигляді ці частини 
зображаються в САПР на плані її розміщення (Floorplan) як подано на рис. 
1,а. Компілятор автоматично призначає елементи схеми, необхідні для ре-
алізації проекту, виконує потрібні з’єднання і вносить всю цю інформацію 
до об’єктного файлу (після цього проектувальник має змогу скоригувати 
призначення вручну і знов перекомпілювати проект). Призначення (As-
signments) для мікросхеми на плані розміщення містяться в лотку AoD 
(Anywhere on Device) і відображаються при натисканні на нього.  

Найбільшою функціональною частиною ПЛІС є логічний блок ЛБ 
(Logic Array Block, LAB), в якому згруповано набір логічних ресурсів та-
ким чином, що будь-який сигнал є приступний для кожного елемента на-
бору. На плані ЛБ позначено літерами А, В біля лотків, в яких відобража-
ються призначення відповідного блоку. ІС можуть вміщувати до 32 ЛБ.  

Наступною за ієрархією складовою частиною є логічна комірка ЛК 
(Logic Cell, LCELL, LC), яка в технічній документації для ПЛІС з елек-
тричним стиранням (EЕPROM-based) називається макрокоміркою МК 
(Macrocell, MC). Призначені (задіяні) комірки на плані забарвлюються, а 
вільні залишаються білими.   
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Рисунок 10.1 

 
Так само і виводи (контакти, штирки – Pin) мікросхеми на плані 

(див. рис. 10.1,а) і на цоколівці (на рис. 10.1,б подано її фрагмент), що є 
призначені, забарвлено, а вільні – білі. Основна їх частина належить до 
входів/виходів користувача (User I/O Pins), позначається на вільних виво-
дах у дужках як (І/О), а на призначених виводах – їх іменами відповідно до 
проектного файлу. Інші виводи є спеціалізовані (Dedicated). Перш за все це 
GND – земля та VCC або VCCINT і VCCIO – напруги живлення; ці виводи, 
як і незадіяні (N.C. – No Connect), якщо вони є, наводяться лише на цо-
колівці (виводи GND у схемі не можна залишати вільними, навіть якщо їх 
декілька). Наступна група спеціалізованих виводів, призначена для фізич-
ного програмування (TDI, TDO, TCK, TMS), є неприступною для користу-
вача. І, нарешті, остання група спеціалізованих виводів для так званих гло-
бальних сигналів, до яких належать спільні для всіх ЛБ сигнали, зобра-
жається на плані окремо від них (у нас – ліворуч). Типовими є такі гло-
бальні сигнали: GCLK – Global Clock (спільний синхровхід), GCLRn – 
Global Clear (спільний сигнал скидання, зазвичай інверсний), Global OE – 
дозвіл виходу для компонентів з трьома станами, Ded. Input (від Dedicated 
– спеціалізований) – глобальний вхід за призначенням користувача. 

Будь-який вивід ІС, розташований на плані біля комірки, може бути 
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запрограмований як вхід або вихід пристрою (у разі потреби, як двоспря-
мований вхід/вихід). Якщо певний контакт стає виходом (на плані позна-
чається стрілкою, що виходить з ЛБ), він закріплюється за суміжною з ним 
коміркою, яка стає кінцевою і остаточно формує для нього сигнал (такі 
комірки забарвлено блакитним кольором). Якщо ж контакт стає входом 
(позначається стрілкою, що входить до ЛБ), він не закріплюється за пев-
ною МК, а зв’язується з будь-якими комірками через програмовані матриці 
з’єднань. Так само МК, призначені як проміжні (забарвлені жовтим кольо-
ром), що беруть участь у формуванні проміжної логіки, обмінюються 
вхідними і вихідними даними з виводами і з іншими комірками через про-
грамовані матриці з’єднань. Деякі МК, що не мають суміжних виводів (у 
нашій ПЛІС дві таких МК) не можуть бути запрограмовані як кінцеві.  

1.2 Структура ПЛІС з електричним стиранням (EPLD).  
Зв’язки між компонентами ПЛІС відображаються на її плані графі-

чно (кольоровими лініями) або логічними рівняннями (у спеціальному вік-
ні на частині екрана). Проте наочніше такі зв’язки можна показати на 
структурній схемі як дещо спрощено подано на рис. 10.2 для типової ПЛІС 
із електричним стиранням (типу EЕPROM-based EPLD) найменшої склад-
ності (ширина шин і кількість елементів, позначених цифрами, у ПЛІС різ-
ного типу можуть відрізнятися). Структура складнішої ПЛІС така сама: 
програмована матриця з’єднань ПМЗ є спільною і продовжується вниз, а 
обабіч ярусами розташовуються логічні блоки ЛБ, кожний зі своїм блоком 
керування вводом/виводом БКВВ. Показані знизу інтерфейсні кола і сиг-
нали діють у режимі програмування.   

 
Рисунок 10.2 – Зв’язки між компонентами ПЛІС 

 

Основні зв’язки між структурними складниками ПЛІС здійснюються 
через ПМЗ, до якої в робочому режимі надходять глобальні сигнали зі спеці-
алізованих входів безпосередньо (показано вгорі; у деяких ПЛІС може бути 
два синхровходи для організації двотактних схем), інформаційні сигнали з 
контактних площинок КП входів/виходів загального користування через 
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БКВВ (показано обабіч нижніми шинами розрядністю 6...12 – за кількістю 
КП, що обслуговуються даним ЛБ) та сигнали з виходів макрокомірок ЛБ 
(показано 16-розрядними шинами – за кількістю МК у кожному ЛБ). 

Усі сигнали ПМЗ стають приступними для макрокомірок кожного 
ЛБ: потрібні з них програмуванням ПМЗ вводяться до блоків 36-
розрядними шинами. Крім того, з метою підвищення швидкодії ЛБ можуть 
одержувати сигнали колами швидкого введення безпосередньо з глобаль-
них входів і з контактних площинок через БКВВ (шини розрядністю 
6...12). У логічних блоках відбувається обробка інформації і її остаточні 
результати виводяться на КП через БКВВ (шини 6...12), а проміжні резуль-
тати надходять до ПМЗ (шини 16) для передачі до інших блоків, в яких за-
вершується обробка. 

Блоки керування вводом/виводом БКВВ програмуються на введен-
ня інформації (КП стають входами) або на її виведення (КП стають вихо-
дами). Під дією шести глобальних сигналів дозволу виходу, що надходять 
з ПМЗ (шина 6 ОЕ), досягається гнучкість керування блоком. 

1.3 Особливості архітектури ПЛІС із тригерною пам’яттю 
конфігурації.  

З розвитком технології і зростанням ступеня інтеграції з’явилися ІС 
комбінованого типу, що сполучають в себе властивості CPLD зі схемо-
технікою запам’ятовувальних пристроїв. Прикладом є популярна ПЛІС 
родини FLEX 10K фірми Altera (FLEX – Flexible Logic Element MatriX – 
гнучка матриця логічних елементів), план розміщення якої (Floorplan) по-
дано на рис. 10.3. Як і для ПЛІС типу CPLD (див. рис. 10.1,а), зв’язки між 
компонентами такої ПЛІС так само можна відображати на її плані 
графічно або логічними рівняннями. 

Призначення (Assignments) для компонентів містяться в лотках, по-
яснення яких винесено на плані вгорі. Крім логічних блоків ЛБ (Logic Ar-
ray Block, LAB) до складу ІС входять також вбудовані блоки пам’яті ВБП 
(Embedded Array Block, EAB). Логічні блоки розташовано по рядках (Row) 
і колонках (Col), тому позначаються двокоординатною системою відліку, 
наприклад, відмічений внизу на плані блок має ім’я „В11”, а блок над ним 
– ім’я „А11”. ІС містить лише один стовпець блоків пам’яті (розташований 
всередині між стовпцями ЛБ), тому вони іменуються назвою рядка, на-
приклад, позначений внизу на плані блок має ім’я „ЕАВ_В”, а блок над 
ним – ім’я „ЕАВ_А”. 

Наступною за ієрархією структурних одиниць є логічна комірка ЛК 
(Logic Cell, LC), яка в технічній документації для ПЛІС із тригерною 
пам’яттю конфігурації (SRAM-based) називається логічним елементом ЛЕ 
(Logic Element, LЕ). Такий „елемент” подібно до макрокомірки має логічну 
частину і програмований тригер, що є розрядом регістра, але відрізняється 
тим, що логічна функція реалізується програмуванням її таблиці відповід-
ності в запам’ятовувальному пристрої (табличний спосіб реалізації). Крім 
того, ЛЕ містить коло переносу (для підвищення швидкодії схем типу лі-
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чильників і суматорів) та коло каскадування (для гнучкості формування 
функцій багатьох змінних кількома комірками). Кожний ЛБ розглядувано-
го типу ПЛІС містить 8 логічних комірок, які позначаються своїм номером 
у блоці та його координатами, наприклад, відмічена внизу на плані ЛК має 
ім’я „LC7_В2”. 

 

 
Рисунок 10.3 – План розміщення (Floorplan) ПЛІС FLEX 10K фірми Altera  

 
Виводи (контакти, Pin) мікросхеми, які так само поділяються на 

спеціалізовані і виводи користувача (глобальні входи, у разі потреби, мо-
жуть використовуватися як звичайні), розташовано на плані по периметру 
з усіх боків. При цьому будь-який вивід користувача (але не глобальні 
входи) може бути запрограмований як вхід, вихід або двоспрямований 
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вхід/вихід пристрою за допомогою комірок вводу-виводу КВВ (I/O Cell) 
біля кожного з них. Аналогічно блоку керування вводом-виводом БВВ у 
КВВ здійснюються функції підвищення навантажувальної здатності, пере-
микання напрямку передачі інформації, регулювання режимів буфера 
(швидкість перемикання, емуляція схеми з відкритим колектором). Крім 
того, КВВ містить вхідний і вихідний регістри для тимчасового зберігання 
даних та складну систему перемикання сигналів між шинами (більше де-
сятка програмованих мультиплексорів та інших елементів). 

 

 

Рисунок 10.4 – Дворівнева система зв’язків блоків за допомогою глобаль-
ної програмованої матриці з’єднань ГПМЗ, поділеній на рядки і стовпці 

 
Двокоординатна система позначень блоків відповідає дворівневій 

системі зв’язків між ними за допомогою глобальної програмованої матриці  
з’єднань ГПМЗ, поділеній на рядки і стовпці (рис. 4), з якими з’єднуються 
комірки вводу-виводу КВВ по всьому периметру ПЛІС. Через рядки і сто-
впці ГПМЗ, між якими розташовані ЛБ і ВБП, здійснюється обмін даними, 
а обмін між комірками організовано через локальну програмовану матри-
цю ЛПМЗ. 

 
2 Довідкові відомості 
Родини мікросхем подано в довідці пакету Help > Devices & Adapt-

ers. ПЛІС однієї родини однотипні і відрізняються кількістю ЛБ. Так, ро-
дини МАХ7000 (рис. 10.5,а) найменшої складності містять два ЛБ, а 
найбільшої складності – 32 ЛБ.  
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Рисунок 10.5 - Довідкові відомості родин мікросхем 

 

Кожний ЛБ розглядуваного типу ПЛІС складається з 16 макрокомі-
рок, а їх загальна кількість у мікросхемі визначає її назву. Найпростіші 
мікросхеми типу ЕРМ7032(АЕ, В, S) містять у двох логічних блоках 32 
макрокомірки, а найскладніші ЕРМ7512(АЕ, В) – 512 МК у складі 32-х ЛБ.  

Натисканням у списку ІС на родину потрібного типу легко вийти на 
файл довідки з даними про типи корпусів (Package), кількість макроко-
мірок (Macrocells) і приступних для користувача виводів (I/O) та інші дані 
(на рис. 10.5,б подано фрагмент даних для ІС типу EPM7128S родини 
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MAX7000S). Докладну інформацію про цоколівку виводів тощо можна от-
римати в п. 3 лабораторного завдання або на Altera website (у попередніх 
версіях Quartus II така інформація міститься в довідці).  

У назвах ПЛІС родин типу FLEX (рис. 10.5,в) складність позна-
чається в тисячах еквівалентних вентилів. Так у родині FLEX 10K 
мікросхема EPF10K10 найменшої складності має логічну ємність 10 тис. 
еквівалентних вентилів (72 ЛБ, 576 ЛК, 3 ВБП обсягом 2048 біт кожний), а 
ІС цієї родини EPF10K250 найбільшої складності має логічну ємність 250 
тис. еквівалентних вентилів (1520 ЛБ, 12160 ЛК, 20 ВБП).  

Такі ПЛІС придатні для побудови складних пристроїв обробки 
інформації. У довідці для ІС такого типу (на рис. 10.5,в подано фрагмент 
даних для ІС типу EPF10K70 родини FLEX 10K) макрокомірки називають-
ся «логічними елементами» (Logic Elements) та подаються також відомості 
щодо вбудованих блоків пам’яті (EABs) і типи конфігураційних мікросхем 
(Configuration Device), призначених для зберігання інформації про 
конфігурацію ІС, яка по ввімкнені джерела живлення автоматично заван-
тажується до ПЛІС. 

 

КОНТРОЛЬНІ ЗАПИТАННЯ 
1 Спроектуйте подільник частоти на 60 на основі: а) макрофункцій 

двійкових лічильників, б) макрофункцій декадних лічильників, в) макро-
функцій подільників частоти, г) макрофункцій JK-тригерів (безвентиль-
ний), д) макрофункцій цифрових таймерів, е) мегафункції лічильника. 

2 Чим відрізняються сучасні програмовані ПЛІС від мікропроцес-
орних ІС, робота яких основана на виконанні програми? Порівняйте мож-
ливості таких ІС щодо складності виконуваних функцій і швидкодії. 

3 Схарактеризуйте режими реконфігурування структури ПЛІС типу 
EPLD з електричним стиранням. Які елементи пам’яті конфігурації засто-
совуються для таких ПЛІС? Що розуміється в САПР під термінами „про-
грамування” і „конфігурування”? 

4 Зобразіть схему ПЛМ для реалізації одного з варіантів функції 
завдання 2 (див. додаток до Лаб. роботи №2). 

5 Поясніть архітектуру ПЛІС типу EPLD: призначення сигналів і 
складників та їх взаємодію. 

6 Поясніть поняття інтерфейсу JTAG і схеми програмування однієї 
ПЛІС та їх ланцюжка. 
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ЛАБОРАТОРНЕ ЗАВДАННЯ 
 

1 Спроектувати подільник частоти із заданими коефіцієнтом 
поділу – модулем М (згідно з варіантом завдання 10).  

1.1 Побудувати безвентильний подільник частоти з використанням     
JK-тригерів за графічного (.bdf) введення проекту 10XXpod, виконати 
компіляцію і моделювання (.vwf), визначити його швидкодію та скласти 
перемикальний граф.  

Приклади: подільник частоти з коефіцієнтом поділу 5 на основі лі-
чильника 74293 (схема 1) і з коефіцієнтом поділу 11 на JK-тригерах (схема 
2)  у файлах 1000pod.bdf, vwf. 

F Примітка: Інверсні асинхронні входи передустановлення SN[4..0] і 
скидання RN (схема 2) призначені для випробування лічильника на само-
відновність і побудови повного перемикального графа. Для цього інверсним 
кодом, наприклад, SN[4..0] = 0016 (як подано на часових діаграмах) можна 
асинхронно записати до всіх розрядів лічильника одиниці і по моделюванні 
імітатором простежити шлях повернення до робочого циклу: 31 → 14 → 21 
→ ...; відтак записати з метою наочності інший стан поза робочим циклом в 
іншому місці (або в цьому ж місці і знов змоделювати) та простежити шлях і 
так само повторити цю процедуру для потрібної кількості станів.    

1.2 Створити подільник частоти за текстового (.tdf) введення про-
екту 10XXpod_sm як скінченний автомат (State Machine) за власним вибо-
ром оператора логічної секції для позначення його переходів (див. Лаб. ро-
бота №8, п.4) на кшталт файла 10XXpod.bdf та дослідити його. Користую-
чись часовими діаграмами (.vwf), визначити тип пристрою, утворений ав-
томатичним синтезатором як подільник частоти.  

Приклад: подільник частоти із коефіцієнтом поділу М = 11 – файли 
1000pod_sm.tdf, vwf. 

2 Створити проект 10ХХPODIL_MAX лабораторного макету 
для експериментального дослідження ЦПП на мікросхемі MAX7000S 
на прикладі заданого варіанту подільника частоти за п. 1.1. (див. як взірець 
файл 1000PODIL_MAX.bdf – рис. Д8 у додатках).  

Для цього створити символ подільника за п. 1.1 (як приклад див. фай-
ли 1000pod11.bdf, bsf), вставити його до графічного файла, який доповнити 
перетворювачем двійкового коду в ДДК і дешифраторами 7-сегментного ко-
ду, потрібними для індикації вихідного коду, а також іншими компонентами 
(у прикладі кількість тактів вхідного сигналу в періоді вихідного сигналу, 
тобто коефіцієнт поділу можна простежити за допомогою світлодіода VD1). 
Імпортувати призначення виводів мікросхеми з файлу ../4lab/MAX_pin та 
скоригувати їх. Виконати компіляцію і функціональне моделювання з метою 
переконатися в правильності проектування. Створити програмувальний CDF-
файл і виконати програмування мікросхеми. Розробити методику та виконати 
експериментальні дослідження пристрою на запрограмованій ІС. Порівняти 
результати експериментальних досліджень з даними проектних файлів, зро-
бити висновки.    
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Приклад: подільник частоти із коефіцієнтом поділу М = 11 – файли 
1000PODIL_MAX.bdf, .vwf, .сdf. 

3 Ознайомитися з основними функціями редактора фізичного 
розміщення Floorplan Editor.    

3.1 У разі потреби, активізувати належний проект 
10XXPODIL_MAX (ввести його назву до рядка заголовку головного вікна), 

піктограмою горизонтальної панелі Pin Planner (або з меню Assign-
ments > Pin Planner) відкрити вікно із цоколівкою виводів і розгор-
нути його, зачинивши вікна зі списками. Налаштувати 
інструментальну палітру (меню Tools > Customize Pin Planner): 

встановити великі облямовані кнопки та вилучити зайві інструменти, зок-
рема, які є на горизонтальній панелі. Натиснути інструмент вертикальної 
палітри Pin Legend та ознайомитися з позначенням виводів і розташуван-
ням їх на цоколівці мікросхеми. Аби з’ясувати призначення виводу, досить 
підвести до нього покажчик і зчитати дані в рамці, що з’являється. З меню 
View > All Pins List відкрити вікно зі списком виводів, виділити вивід на 
цоколівці та зчитати дані в цьому вікні чи, навпаки, виділити вивід у вікні і 
продивитися його розташування на цоколівці. Так само з меню View > 
Groups List відкрити вікно зі списком груп і аналогічним чином з’ясувати 
зв'язок між списком і цоколівкою.  
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F Примітки: 
1) У зазначеному вікні All Pins можна також відредагувати призна-

чення виводів: клацнути будь-де в рядку потрібного виводу правою кнопкою 
миші і вибрати в контекстному меню Node Properties для зміни номера виво-
ду або Pin Properties для зміни імені виводу. Відтак в однойменному 
діалоговому вікні (Node Properties або Pin Properties) в графі Location або 
Node name прокруткою встановити або надрукувати відповідно номер виводу 
чи його ім’я. Призначити або відредагувати номер виводу можна і безпосе-
редньо подвійним клацанням у стовпці Location і прокруткою списку но-
мерів. Так само можна відредагувати призначення виводів і у вікні Groups. 

2) У зазначених діалогових вікнах (Node Properties або Pin 
Properties) у графі I/O standard прокруткою можна вибрати також стандарт 
входу/виходу. За умовчанням (default) для родин MAX7000S та FLEX10K 
встановлено ТТL I/O standard – звичайний стандарт ТТЛ з напругою жив-
лення 5 В (зокрема, через це зазначені родини є популярні серед масових 
користувачів). Проте для всіх родин ІС, що підтримуються пакетом Quartus 
II, можуть використовуватися також низьковольтні (LV) стандарти напру-
ги   3,3 В стосовно вхідних/вихідних сигналів (VCCIO) і напруги 3,3 В/2,5 
В стосовно вхідних/вихідних буферів. Такі стандарти для елементної бази 
ТТЛ (TTL) і КМОНТЛ (CMOS) позначаються в САПР відповідно LVTTL 
I/O standard та LVCMOS I/O standard. 

3.2 Піктограмою Timing Closure Floorplan (або 
з меню Assignments > Timing Closure Floorplan) 

відкрити вікно редактора фізичного розміщення Floorplan Editor і розгор-
нути його. Налаштувати інструментальну палітру (меню Tools > Customize 
Timing Closure Floorplan): встановити великі облямовані кнопки та вилучи-
ти зайві інструменти, зокрема, які є на горизонтальній панелі. Натиснути 
інструменти вертикальної палітри Show User Assignment (показ призначень 
користувача), Show Fitter Placements (показ розміщень трасувальника) і 
View Color Legend (перегляд кольорових позначень) та ознайомитися з ви-
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глядом внутрішньої структури ПЛІС, логічними блоками (LAB), їх 
комірками (LC) і умовними позначеннями елементів.  

F Примітки:  
1) Для перегляду логічних зв’язків між елементами (між ло-

гічними комірками або комірками і зовнішніми виводами) слід ви-
ділити один або декілька елементів (клацнути при утримуваній кла-
віші Ctrl), натиснути інструмент палітри Show Node Fan-In (показа-

ти вхідні зв’язки кіл), або Show Node Fan-Out (показати вихідні зв’язки кіл) 
і спостерігати логічні зв’язки у вигляді кольорових ліній. 

2) Для перегляду кількості з’єднань між виділеними 
елементами або затримок між ними слід натиснути інструмент 

Show Connection Count або Show Routing Delays. 
3) Для перегляду логічних рівнянь і їх зв’язок з виділеними еле-

ментами плану мікросхеми слід натиснути інструмент View Equations.  
4) На плані мікросхеми можна також відредагувати розміщення ви-

водів і інших призначень, після чого перекомпілювати проект. 
 

4 Створити проект 10ХХPODIL_ FLEX лабораторного макету 
для експериментального дослідження ЦПП на мікросхемі FLEX10К на 
прикладі заданого варіанту подільника частоти за п. 1.1. (див. як взірець 
файл 1000PODIL_FLEX.bdf – рис. Д9 у додатках).  

4.1 Вставити до графічного файлу 10ХХPODIL_ FLEX.bdf копію 
лабораторного макету 10ХХPODIL_МАX.bdf, вилучити світлодіоди, ско-
ригувати імена вхідних портів sw[] (якщо якійсь вивід відокремлено від 
групи, його слід іменувати без квадратних дужок, наприклад, замість sw[8] 
позначити sw8), відповідно до цих портів скоригувати також трасувальні 
таблиці блоку подільника частоти та ввести до складу проекту всі потрібні 
файли. Розвести виводи мікросхеми на друкованій платі відповідно до 
файлу ../10lab/ROZWED_FLEX.bdf або імпортувати їх призначення з фай-
лу ../10lab/FLEX_pin.bdf і скоригувати відповідно до портів проекту.  

4.2 Виконати компіляцію і функціональне моделювання.  
4.3 Створити програмувальний CDF-файл і виконати програмуван-

ня мікросхеми. Виконати фізичне конфігурування мікросхеми (джампери 
встановити згідно з файлом ../10lab/ FLEX_pin.bdf).  

4.4 Розробити методику та виконати експериментальні дослідження 
пристрою. Порівняти результати експериментальних досліджень з даними 
проектних файлів, зробити висновки.  

Приклад: подільник частоти із коефіцієнтом поділу М = 11 – файли 
1000PODIL_FLEX.bdf, vwf. 

 

5 Переглянути особливості фізичного розміщення мікросхеми 
на плані Floorplan Editor.   

5.1 Аналогічно п. 3.1 ознайомитися із цоколівкою виводів, кори-
стуючись інструментами регулювання масштабу. 
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5.2 Аналогічно п. 3.2 ознайомитися з виглядом внутрішньої струк-

тури ПЛІС (на фрагменті подано затримки зв’язків комірки LC2 логічного 
блоку C36). 
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Рисунок Д3 

ДОДАТКИ 
 

ВАРІАНТИ ЗАВДАННЯ 1 
Наведіть для кожної схеми (а...ї) заданого рисунку значення кон-

станти або умовне позначення еквівалентного логічного елемента, якщо 
елемент A виконує таку логічну функцію (далі наводиться варіант – рису-
нок – функція): 1) Д1 – АБО,  2) Д1 – І,   3) Д1 – Виключне АБО,  4) Д1 – 
Заборона,   5) Д1 –  АБО-НЕ,  6) Д1 – І-НЕ,  7) Д1 – Виключне  АБО-НЕ, 8) 
Д1 – Імплікація, 9) Д2 – АБО, 10) Д2 – І,  11) Д2 – Виключне АБО, 12) Д2 – 
Заборона, 13) Д2 –  АБО-НЕ, 14) Д2 – І-НЕ, 15) Д2 – Виключне  АБО-НЕ,  
16) Д2 – Імплікація.  

 
Рисунок Д1 

 
Рисунок Д2 

 
Приклад. Дано: .21 xxA ⊕=  

Підставляючи змінні до 
схеми, маємо 

,2321

321321

Mxxx

xxxxxxy

=⊕⊕=

=⊕⊕=⊕⊕=  

де М2 – суматор за модулем два (рис. Д3). 
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ВАРІАНТИ ЗАВДАННЯ 2 
Для заданої згідно з варіантом логічної функції y: а) побудувати 

таблицю відповідності і діаграму термів (Вайча-Карно); б)  навести доско-
налі (ДДНФ або ДКНФ) та мінімальні (МДНФ і МКНФ) форми; в) пере-
творити мінімальні форми до базисів І-НЕ, АБО-НЕ, І-АБО-НЕ; г) 
мінімізувати схему в базисі І-НЕ, АБО-НЕ чи мішаному, який забезпечує 
меншу складність;  ґ)  навести схеми за п. в, г.     

1) ( ) ( )213\1 xxxy →⊕= ;   

2) ( )[ ]132\1 xxxy →⊕= ;  

3) ( ) ( )123123 \\ xxxxxxy +⊕→= ;  
4) ( ) ( )[ ]32321\1 xxxxxy ⊕→→= ;  

5) ( )[ ]31342\1 xxxxxy ⊕→+= ;  
6) ( ) ( )[ ]32341 \\1 xxxxxy ⊕→= ;  

7) ( ) ( )[ ]321423321 \\1 xxxxxxxxxy ⊕→++= ;  

8) ( ) ( ) ( )32421321 \ xxxxxxxxy ⊕+→+= ;  

9) ( ) ( )215454312 \ xxxxxxxxxy ⊕→++= ;   
10) ( )[ ]53434321\1 xxxxxxxxy +→⊕++= . 

 
ВАРІАНТИ ЗАВДАННЯ 3 

а) Спроектувати на основі двійкового дешифратора перетворювач 
(дешифратор) до семисегментного коду для індикації шістнадцяткових цифр: 

1) A, b, C, d; 2) A, b, C, d, E; 3) A, b, C, d, E, F; 4) A, C, E; 5) C, d, E, 
F;  6) b, C, d, E, F;  7)A, C, E, F; 8) A, E, F; 9) A, C, d, E, F; 10) C, d, E, F. 

б) Розробити схему передачі даних заданої розрядності на основі 
шифратора і дешифратора (як взірець див. рис. Д1). 

Варіант* 1 2 3 4 5 6 7 8 9 10 
Розрядність, n 9 8 7 6 11 5 12 15 13 14 

*) При n > 10 виключити дослідження DC 7-seg. або (та) ЦКП. 
 

ВАРІАНТИ ЗАВДАННЯ 4 
а) Спроектувати ЦКП для реалізації логічної функції, заданої згідно 

з варіантом завдання 2 (до лабораторної роботи №2), на мультиплексорах 
різної розрядності та вибрати оптимальний варіант. 

б) Розробити схему передачі даних заданої розрядності на основі 
мультиплексора і демультиплексора (як взірець див. рис. Д1). 

Варіант* 1 2 3 4 5 6 7 8 9 10 
Розрядність, n 5 4 7 6 11 10 12 9 13 14 

*) При n > 8 доповнити формувач адреси виходом a[3]. 
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ВАРІАНТИ ЗАВДАННЯ 5 
1) Записати апаратною мовою AHDL логічну функцію завдання 2 з 

Лаб. роботи №2 (первісний вираз, але без операндів заборони і імплікації), 
розбити її на частини з метою введення логічних рівнянь за допомогою 
оператора Node; приклад див. на стор. 6. 

2) Відновити графічний файл двійкового дешифратора згідно із за-
вданням 3 (за п. 2.1 Лаб. роботи №3) і скласти його таблицю відповідності 
з метою введення оператора цієї таблиці.  

3) Відновити символ демультиплексора згідно із завданням 4 (за п. 
5.1 Лаб. роботи №4) і скласти його таблицю відповідності з метою введен-
ня умовного оператора. 

4) Відновити графічний файл для реалізації мультиплексора розря-
дністю за власним вибором згідно із завданням 4 (за п. 2.1 Лаб. роботи №4) 
і скласти його таблицю відповідності з метою введення оператора вибору. 

5) Відновити графічний файл, що реалізує спеціальний дешифратор 
7-сегментного коду для відображення заданих шістнадцяткових цифр на 
основі макрофункції двійкового дешифратора (за п. 2.3 Лаб. роботи №3) з 
метою включення до проекту макрофункції і створення текстового файлу. 

6) Відновити графічний файл, що реалізує спеціальний дешифратор 
7-сегментного коду для відображення заданих шістнадцяткових цифр на 
основі символу двійкового дешифратора (за п. 2.5 Лаб. роботи №3), з ме-
тою включення до проекту символу і створення текстового файлу. 

7) Відновити графічний файл, що реалізує задану логічну функцію на 
основі створеного різновиду мегафункції (за п. 4.1 ... 4.3 Лаб. роботи №4), з 
метою включення до проекту мегафункції і створення текстового файлу. 

 
ВАРІАНТИ ЗАВДАННЯ 6 

Побудувати пороговий елемент на суматорах і компараторах: 
1) 2 з 5, 2) 3 з 6, 3) 3 з 7, 4) 4 з 8, 5) 3 з 5, 6) 4 з 6, 7) 3 з 8, 8) 4 з 9, 9) 

4 з 5, 10) 5 з 8, 11) 6 з 9, 12) 7 з 10. 
 

ВАРІАНТИ ЗАВДАННЯ 7 
Розробити лінію передачі даних заданої розрядності з фіксацією ви-

хідного коду на тригерах (як взірець див. рис. Д1). 
Варіант* 1 2 3 4 5 6 7 8 9 10 
Розрядність, n 5 4 8 6 11 10 12 9 13 14 

*) При n > 8 доповнити формувач адреси виходом a[3]. 
 

ВАРІАНТИ ЗАВДАННЯ 8 
Спроектувати на основі регістра зсуву ЦПП (далі наводиться тип 

пристрою – варіант – дані у вигляді періоду кодової послідовності М або 
модулю N): 

ГКП реверсивний – 1) N = (0000101); 5) М = 5; 9) N = (00101); 
РІР  – 2) N = (01111); 6) М = 7; 10) М = 9; 
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ГКП– 3) М = 7; 7) N = (01011);  11) N = (0001101);    
РІР реверсивний – 4) М = 5; 8) N = (00011); 12) М = 6. 

 
ВАРІАНТИ ЗАВДАННЯ 9 

Спроектувати згідно з варіантом:  
а) недвійковий лічильник із заданим модулем М і природним по-

рядком лічби шляхом перетворення двійкового лічильника (далі наводить-
ся варіант – модуль): 1) М =3, 4, 5 – програмований; 2) М = 15; 3) М = 6, 7, 
8 – програмований; 4) М = 14; 5) М = 5, 10 – програмований; 6) М = 13;           
7) М = 9, 10 – програмований; 8) М = 12; 9) М = 10, 15 – програмований; 
10) М = 11;                                

б) недвійковий лічильник із заданим модулем М і природним по-
рядком лічби на тригерах зі зворотними зв’язками (далі наводиться варіант 
– модуль – тип тригерів): 1) М = 11 – D; 2) М = 7 – JK – реверсивний; 3) М 
= 5 – RSC;  4) М = 7 – D – реверсивний; 5) М = 9 – TE;  6) М = 6 – RSC – 
реверсивний;  7) М =10 – JK; 8) М = 6 – TE – реверсивний;  9) М = 9 – JK;         
10) М = 5 – D – реверсивний. 

 
ВАРІАНТИ ЗАВДАННЯ 10 

Спроектувати згідно з варіантом безвентильний подільник частоти 
на JK-тригерах (далі наводиться  варіант – модуль): 1) М = 6; 2) М = 7; 3) 
М= 9; 4) М = 10; 5) М = 14; 6) М = 12; 7) М = 18; 8) М = 20; 9) М = 15;   10) 
М = 17. 

Приклад: див. Лаб. робота №9, п. 4.2.  
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